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Kata Sambutan 

Peran guru profesional dalam proses pembelajaran sangat penting sebagai kunci 

keberhasilan belajar siswa. Guru Profesional adalah guru yang kompeten 

membangun proses pembelajaran yang baik sehingga dapat menghasilkan 

pendidikan yang berkualitas. Hal tersebut menjadikan guru sebagai komponen 

yang menjadi fokus perhatian pemerintah pusat maupun pemerintah daerah dalam 

peningkatan mutu pendidikan terutama menyangkut kompetensi guru. 

Pengembangan profesionalitas guru melalui program Guru Pembelajar (GP) 

merupakan upaya peningkatan kompetensi untuk semua guru. Sejalan dengan hal 

tersebut, pemetaan kompetensi guru telah dilakukan melalui uji kompetensi guru 

(UKG) untuk kompetensi pedagogik dan profesional pada akhir tahun 2015. Hasil 

UKG menunjukkan peta kekuatan dan kelemahan kompetensi guru dalam 

penguasaan pengetahuan. Peta kompetensi guru tersebut dikelompokkan menjadi 

10 (sepuluh) kelompok kompetensi. Tindak lanjut pelaksanaan UKG diwujudkan 

dalam bentuk pelatihan paska UKG melalui program Guru Pembelajar. Tujuannya 

untuk meningkatkan kompetensi guru sebagai agen perubahan dan sumber 

belajar utama bagi peserta didik. Program Guru Pembelajar dilaksanakan melalui 

pola tatap muka, daring (online), dan campuran (blended) tatap muka dengan 

online. 

Pusat Pengembangan dan Pemberdayaan Pendidik dan Tenaga Kependidikan 

(PPPPTK), Lembaga Pengembangan dan Pemberdayaan Pendidik dan Tenaga 

Kependidikan Kelautan Perikanan Teknologi Informasi dan Komunikasi (LP3TK 

KPTK), dan Lembaga Pengembangan dan Pemberdayaan Kepala Sekolah 

(LP2KS) merupakan Unit Pelaksana Teknis di lingkungan Direktorat Jenderal Guru 

dan Tenaga Kependidikan yang bertanggung jawab dalam mengembangkan 

perangkat dan melaksanakan peningkatan kompetensi guru sesuai bidangnya. 

Adapun perangkat pembelajaran yang dikembangkan tersebut adalah modul untuk 

program Guru Pembelajar (GP) tatap muka dan GP online untuk semua mata 

pelajaran dan kelompok kompetensi. Dengan modul ini diharapkan program GP 

memberikan sumbangan yang sangat besar dalam peningkatan kualitas 

kompetensi guru. 

Mari kita sukseskan program GP ini untuk mewujudkan Guru Mulia Karena Karya. 

 

Jakarta,    Februari 2016 

Direktur Jenderal Guru dan Tenaga Kependidikan, 

 

 

Sumarna Surapranata, Ph.D. 

NIP.19590801 198503 1002 
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Kata Pengantar 

 

Puji dan syukur kami panjatkan kehadirat Allah SWT atas selesainya penyusunan 

Modul Guru Pembelajar Paket Keahlian Administrasi Perkantoran Sekolah 

Menengah Kejuruan (SMK) dalam rangka Pelatihan Guru Pasca Uji  Kompetensi 

Guru (UKG). Modul ini merupakan bahan pembelajaran wajib, yang digunakan 

dalam pelatihan Guru Pasca UKG bagi Guru SMK. Di samping sebagai bahan 

pelatihan, modul ini juga berfungsi sebagai referensi utama bagi Guru SMK dalam 

menjalankan tugas di sekolahnya masing-masing. 

Modul Guru Pembelajar Paket Keahlian Administrasi Perkantoran SMK ini terdiri 

atas 2 materi pokok, yaitu : materi profesional dan materi pedagogik. Masing-

masing materi dilengkapi dengan tujuan, indikator pencapaian kompetensi, uraian 

materi, aktivitas pembelajaran, latihan dan kasus, rangkuman, umpan balik dan 

tindak lanjut, kunci jawaban serta evaluasi pembelajaran.   

Pada kesempatan ini saya sampaikan ucapan terima kasih dan penghargaan atas 

partisipasi aktif kepada penulis, editor, reviewer dan pihak-pihak yang terlibat di 

dalam penyusunan  modul ini. Semoga keberadaan  modul ini dapat membantu 

para narasumber, instruktur dan guru pembelajar dalam melaksanakan Pelatihan 

Guru Pasca UKG bagi Guru SMK.   

 

Jakarta,   Februari 2016 

Kepala PPPPTK Bisnis dan Pariwisata, 

 

 

Dra. Hj. Djuariati Azhari, M.Pd. 

 NIP.195908171987032001 
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Bagian I : 
Kompetensi Profesional 

 

Kompetensi profesional adalah kemampuan pendidik mengelola 

pembelajaran dengan baik. Pendidik akan dapat mengelola 

pembelajaran apabila menguasai substansi materi, mengelola kelas 

dengan baik, memahami berbagai strategi dan metode pembelajaran, 

sekaligus menggunakan media dan sumber belajar yang ada. 
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Pendahuluan 

 

A. Latar Belakang 

ekerjaan kantor adalah suatu kegiatan kesekretariatan dan 

administrative, yang berkaitan dengan kegiatan 

mengumpulkan/menghimpun, mencatat, mengolah, menggandakan, 

dan menyimpan. Saat ini dengan berkembangnya teknologi informasi, 

kegiatan kesekretariatan dan administrative dapat dipermudah dengan 

perangkat komputer yang disebut dengan Otomasi Perkantoran (Office 

Automation/OA).  

1. Otomasi Perkantoran 

Asal mula Otomasi Perkantoran di awal 1960-an, ketika IBM menciptakan 

word-processing untuk menjelaskan mesin TIK listriknya. Bukti nyata, pada 

tahun 1964-an, ketika IBM memasarkan mesin yang disebut Magnetic 

Tape/Selectric Typewriter (MT/ST) yaitu mesin ketik yang dapat mengetik 

kata-kata yang telah direkam dalam pita magnetic secara otomatis. 

Kata “Otomasi” memiliki pengertian penggunaan mesin untuk menjalankan 

tugas fisik yang biasa dilakukan oleh manusia. Otomasi kantor biasanya 

dikenal dengan istilah Office Automation atau OA. 

Otomasi kantor menurut O’Brien (1996) system informasi berbasis 

telekomunikasi yang mengumpulkan, memproses, menyimpan dan 

mendistribusikan pesan-pesan, dokumen-dokumen dan komunikasi 

elektronik lainnya diantara individual, grup-grup kerja dan organisasi 

Waluyo menjelaskan bahwa era Otomasi Perkantoran dimulai bersamaan 

dengan berkembangnya teknologi informasi, penggunaan perangkat 

komputer untuk keperluan perkantoran. 

Otomasi kantor terdiri atas semua sistem elektronik formal dan informal 

terutama yang berkaitan dengan komunikasi informasi kepada dan dari 

P 
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orang yang berada di dalam maupun di luar perusahaan. Berikut konsep 

dari otomasi kantor: 

1. Proses yang terjadi di perkantoran seperti halnya proses manufaktur 

selalu mengarah ke otomatisasi. 

2. Otomasi kantor berevolusi dari aplikasi-aplikasi yang terpisah tanpa 

rencana menuju aplikasi yang terencana dan terpadu. 

3. Otomasi kantor memudahkan penerimaan dan pengiriman informasi. 

4. Otomasi kantor memberikan keuntungan lebih besar melalui 

pengambilan keputusan yang lebih baik 

5. Otomasi kantor sebagai pelengkap bagi metode komunikasi tradisional 

bukan sebagai pengganti. 

 

2. Aplikasi otomasi kantor  

Berikut adalah beberapa aplikasi otomasi kantor yang sering digunakan : 

1. Microsoft Word  

2. Microsoft Excel  

3. Microsoft Power Point 

4. Microsoft Publisher 

5. Surat elektronik/e-mail 

6. Blog 

7. Web 

8. Konferensi Audio (Audio Conference) 

B. Tujuan 

Tujuan disusunnya modul diklat Pengembangan Kompetensi Guru (PKG)  

paket keahlian administrasi perkantoran dengan judul Otomasi Perkantoran 

adalah agar GP dapat : Mengoperasikan Microsoft Word, Excel, Power Point, 

Publisher, E-mail, Blog, Web, dan Tele Conference 
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C. Peta Kompetensi 

 

 

D. Ruang Lingkup 

Dalam modul Otomasi Perkantoran ini berisi : 

1. Cara mengoperasikan Microsoft Word  

2. Cara mengoperasikan Microsoft Excel 

3. Cara mengoperasikan Microsoft PowerPoint 

4. Cara mengoperasikan Microsoft Publisher 

5. Cara menggunakan surat elektronik/e-mail 

Mengelola  
Pekerjaan Kantor  

 

Mengelola  
Otomatisasi 
Perkantoran 

 

 

Mengelola  
Arsip  

 

Mengelola  
Komunikasi Kantor & 

SM Indonesia 
 

Melakukan SM  
Inggris & 
Laporan 

 

Melakukan  
Karya Tulis Ilmiah 

 

TINGGI 

Mengelola  
Administrasi  

Sarpras 

 

Mengelola  
Humas & Protokol 

 

Mengelola  

Administrasi  
Kepegawaian 

 

Mengelola  
Administrasi  

Keuangan 
 

MENENGAH 

LANJUTAN 
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6. Cara mengelola blog 

7. Cara mengelola web 

8. Cara mengoperasikan tele conference 

 

E. Saran Cara Penggunaan Modul 

1. Petunjuk Untuk Peserta Diklat 

a. Bacalah bahan ajar dengan seksama, terutama bagian instruksi. 

b. Pahami tujuan Anda mempelajari bahan ajar, sasaran, tingkat 

penguasaan yang diharapkan serta waktu yang ditargetkan. 

c. Kerjakanlah tugas dan latihan yang terdapat di dalamnya dengan jujur 

tanpa melihat kunci jawaban. 

d. Laporkan kemajuan kepada instruktur sebelum Anda melanjutkan ke 

bahan ajar selanjutnya. 

e. Usahakan menyelesaikan setiap bahan ajar lebih cepat dari waktu 

yang ditetapkan 

f. Jika ada bagian yang belum Anda pahami, cobalah terlebih dahulu 

diskusikan dengan teman sebelum Anda bertanya pada instruktur.  

g. Tingkat pemahaman minimal sebesar 75%, jika tingkat penguasaan 

kurang dari 75%, pelajari materi/bagian-bagian yang belum dikuasai, 

atau mintalah saran–saran dari instruktur.  

2. Petunjuk Untuk Instruktur 

a. Instruktur harus menguasai isi bahan ajar. 

b. Instruktur harus mempunyai catatan posisi dan kemajuan setiap 

peserta diklat. 

c. Instruktur hendaknya dapat meningkatkan motivasi peserta diklat. 

d. Sebelum memberikan verifikasi keberhasilan peserta diklat, instruktur  

harus mengevaluasi keberhasilan peserta. 
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Kompetensi 
Profesional 

Kegiatan Pembelajaran 1:  

Mengoperasikan Microsoft Word 

 

A. Tujuan 

Setelah mempelajari kegiatan belajar satu dengan judul Mengoperasikan 

Microsoft Word, peserta diklat diharapkan: 

1. Dapat mempraktikkan mengetik 10 Jari dengan jelas 

2. Dapat menyebutkan pengertian Ms. Word dengan baik 

3. Dapat mengenal tampilan layar kerja Ms. Word dengan jelas 

4. Dapat membuat dan mengelola dokumen dengan cermat 

5. Dapat memformat teks, paragraf dan sections sesuai dengan kebutuhan 

6. Dapat membuat table sesuai dengan kebutuhan 

7. Dapat memasukan (Insert) dan memformat objek sesuai dengan 

kebutuhan 

8. Dapat mencetak dokumen 

 

B. Indikator Pencapaian Kompetensi 

1. Mengoperasikan Microsoft Word 

1. Mempraktikkan mengetik 10 Jari 

2. Menyebutkan pengertian Ms. Word  

3. Mengidentifikasi tampilan layar kerja Ms. Word  

4. Melatih cara membuat dan mengelola dokumen  

5. Melatih cara memformat teks, paragraf dan sections  

6. Melatih cara membuat table  

7. Melatih cara meng-insert dan memformat objek  

8. Melatih cara mencetak dokumen 
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C. Uraian Materi 

1. Mengoperasikan Microsoft Word 

1.1 Mengetik 10 Jari 

Kantor adalah sebuah wadah atau tempat mengurus suatu 

pekerjaan/ tempat bekerja.  Menurut  George  R.  Terry, presentase 

pekerjaan kantor untuk menunjang tugas utama perusahaan adalah : 

1.  Typing     :  24,6% 

2.  Calculating   :  19,5% 

3.  Checking   :  12,3% 

4.  Filling     :  10,2% 

5.  Telephoning   :   8,8% 

6.  Duplicating   :   6,4% 

7.  Mailing     :   5,5% 

8.  Other     :  12,7% 

Total     :  100% 

Dari uraian di atas dapat kita ketahui bahwa presentase pekerjaan kantor 

yang utama adalah pekerjaan yang berkaitan dengan mengetik (Typing). 

Dengan mengetik 10 jari, pekerjaan mengetik akan menjadi cepat selesai 

dan bisa menghemat waktu. 

Untuk dapat mengetik menggunakan 10 jari, hal yang harus dilakukan 

adalah menghafalkan posisi jari pada keyboard. Anda juga harus 

memahami posisi tangan ketika berada di atas keyboard. Dalam metode 

mengetik 10 jari, kedua tangan memiliki peranan dan “daerah kekuasaan” 

yang berbeda. 

 

Gambar 1. Fungsi Jari Pada Keyboard 

 
  

 

http://2.bp.blogspot.com/-KdAuCY0v1zY/VJrshRNO5jI/AAAAAAAAAdw/tr9-oUF0bfI/s1600/keyboard1.png
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1.2 Pengertian Ms. Word 

Menurut Wikipedia, Microsoft Word adalah perangkat lunak 

pengolah kata, sedangkan secara umum, Microsoft Word adalah 

sebuah program aplikasi pengolah data berupa huruf/kata yang biasa 

digunakan untuk membuat laporan, membuat dokumen, dan lain lain. 

 

1.3 Fungsi Microsoft Word 

Fungsi dan Kegunaan Microsoft Word antara lain:  

1. Untuk membuat dokumen dengan cepat  

2. Untuk menyimpan dokumen dan format yang beragam  

3. Untuk membuat tulisan dalam berbagai variasi  

4. Untuk membuat label surat 

 

1.4 Manfaat Microsoft word 

Adapun manfaat microsoft word adalah : 

a. Memudahkan dalam menyelesaikan pekerjaan 

b. Menghemat Waktu dalam Pekerjaan 

c. Menghemat Kertas dan Biaya. 

1.5 Pengenalan tampilan layar kerja MS Word 

a. Shortcut/hotkey 

Shortcut/hotkey adalah kombinasi dari beberapa tombol yang 

ditekan secara bersamaan mampu bereaksi secara spesifikasi 

pada komputer atau lebih mudahnya tombol cepat untuk sebuah 

perintah pada sistem kerja di komputer. Dengan menggunakan 

tombol shortcut/hotkey kita bisa mengoperasikan komputer 

melalui keyboard saja tanpa bantuan mouse sedikitpun. 

 

Berikut adalah shortcut/hotkey 

Kombinasi 
Tombol 

Kegunaan/Fungsi 

Ctrl + A Memblok keseluruhan teks (all) 

Ctrl + B Mempertebal teks (bold) 

Ctrl + C Meng-copy teks (copy) 

Ctrl + D Membuka menu kotak dialog font 

Ctrl + E Membuat teks rata tengah (equator) 
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Kombinasi 
Tombol 

Kegunaan/Fungsi 

Ctrl + F Membuka menu find and replace pada tab find 

Ctrl + G Membuka menu find and replace pada tab go to 

Ctrl + H Membuka menu find and replace pada tab replace 

Ctrl + I Membuat teks menjadi miring (italic) 

Ctrl + J Fungsi perataan teks kanan & kiri (Justify) 

Ctrl + K Membuka kotak dialog Insert Hyperlink 

Ctrl + L Fungsi perataan teks kiri (left) 

Ctrl + M 
fungsi menggeser First Line Indent dan Left Tab pada 
mistar dokumen 

Ctrl + N Membuka/membuat dokumen baru (new) 

Ctrl + O Membuka kotak dialog open 

Ctrl + P Membuka kotak dialog print 

Ctrl + Q Menghilangkan nomor urut 

Ctrl + R Membuat teks menjadi rata kanan 

Ctrl + S Menyimpan dokumen (save) 

Ctrl + T Menggeser left tab pada mistar dokumen 

Ctrl + U Membuat garis bawah pada teks (underline) 

Ctrl + V 
Menampilkan teks yang telah di-copy/cut sebelumnya 
(paste) 

Ctrl + W Menyimpan dan langsung menutup Ms.Office 

Ctrl + X Memotong teks yang terseleksi (cut) 

Ctrl + Y Mengulang kembali aktifitas yang lalu (redo) 

Ctrl + Z Membatalkan aktifitas terakhir (undo) 

Tabel 1. Shortcut 

b. Tampilan layar kerja MS Word 

1. Ikon Kontrol Menu (Control Menu Icon) digunakan untuk 

mengontrol jendela yang sedang aktif. Letaknya dipojok kiri 

paling atas sebelah baris judul. 

2. Baris Judul (Title Bar), Adalah informasi berisi nama file dan 

nama program yang aktif dalam Microsoft Word 

3. Tombol Ukuran (Sizzing Button), Digunakan untuk menentukan 

besar tampilan layar jendela word. Letaknya disebelah ujung 

kanan pada baris judul. Macam-macam tombol ukuran : 

a. Minimize Button : Untuk memperkecil ukuran jendela 

word 

b. Maximize Button : Untuk memperbesar ukuran jendela 

word 

c. Restore Button  : Untuk mengembalikan jendela ke 

ukuran semula 
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d. Close/Exit Button  : Untuk menutup jendela dan mengakhiri 

program word 

4. Baris Toolbar (Tool bar), Adalah kumpulan perintah dalam 

bentuk ikon-ikon yang berisi alat untuk mempermudah 

menyelesaikan dokumen. Fungsi utama Toolbar adalah 

mempercepat akses ke sejumlah perintah yang sering dipakai. 

Untuk menggunakan Toolbar, klik salah satu icon yang 

mewakili perintah yang kita inginkan. Untuk menonaktifkannya, 

tekan ikon tersebut sekali lagi. Secara default, toolbar di Ms. 

Word ada dua yaitu Toolbar Standar dan Formating. 

a. Toolbar Standar, Berisikan beberapa ikon untuk 

mengerjakan operasi standar, seperti menyimpan, 

membuka, mencetak dokumen, dan sebagainya. Biasanya, 

akan lebih cepat dengan mengklik sebuah tombol pada 

toolbar dari pada memilih perintah pada suatu menu. 

Toolbar Standar dapat ditampilkan atau disembunyikan 

dengan mengklik View > Toolbar > Standar. 

b. Toolbar Formating, Berisikan ikon untuk memformat obyek-

obyek pada dokumen. Obyek tersebut bisa berupa gambar, 

tabel, atau text dan sebagainya. Toolbar formatting bisa juga 

digunakan untuk memilih berbagai jenis huruf dan 

ukurannya. Toolbar formatting dapat ditampilkan atau 

disembunyikan dengan memilih View > Toolbar > 

Formating. 

5. Rulers, Adalah mistar tabulasi yang terdapat pada bagian atas 

atau samping kiri dokumen. Mistar atau ruler ini berguna 

sebagai indikator lebar dan tinggi halaman dokumen berikut 

margin-nya. Untuk Ruler horizontal, berfungsi juga sebagai alat 

pengaturan tabulasi dan indentasi. Ruler ini bisa ditampilkan 

dan juga bisa dihilangkan. Caranya, Klik View + Ruler. 

6. Area Pengetikan, Adalah tempat untuk mengetik atau membuat 

dokumen.  

7. Kursor, Berbentuk garis vertikal yang berkedip-kedip.  
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8. Task Pane, Merupakan jendela yang ditampilkan di sebelah 

kanan dokumen dan membantu ketika mengedit dokumen.  

9. Scroll Bar, Adalah papan navigasi untuk menggulung layar 

dokumen, baik secara vertikal maupun horizontal. Bisa juga 

menggeser lembar dokumen ke ke kiri atau ke kanan. Scroll bar 

yang digunakan untuk menggulung secara vertikal dikenal 

dengan nama Vertical Scroll bar dan untuk menggeser ke kiri 

atau ke kanan, disebut Horizontal Scrool bar. Cara 

menampilkan atau menyembunyikan Scrool Bar pada Ms. 

Office 2013, Klik File > Option > Advanced > Beri tanda 

centang pada Show Horizontal Scroll bar ataupun Show 

Vertical Scroll bar > Klik OK 

10. Status Bar, Adalah baris informasi pada posisi paling bawah 

dokumen. Status bar ini memberikan informasi mengenai 

jumlah halaman, halaman yang aktif dan sebagainya 

Untuk lebih jelasnya coba perhatikan gambar dibawah ini. 

11. Title bar, berisi nama file yang sedang dikerjakan, serta tombol 

menampilkan, atau menyembunyikan jendela program, dan 

menutup program, yaitu tombol Minimize, Maximize/Restore, 

dan Close. Menu bar berisi serangkaian perintah yang 

didalamnya terdapat sub-sub perintah sesuai kategorinya.  

Untuk mengatur jenis tampilan dokumen, pilih salah satu sub 

menu di dalam menu View. Beberapa tampilan tata letak yaitu: 

 Normal: memberikan tampilan sesuai format yang 

diterapkan pada teks. 

 Print Layout: memberikan tampilan sesuai hasil yang akan 

diterima pada saat dicetak. 

 Web Layout: memberikan tampilan sesuai hasil yang 

ditampilkan di dalam jendela browser. 

 Outline: memberikan tampilan sesuai heading di dalam 

dokumen dan tingkatan di dalam struktur dokumen. 
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Membuat, menyimpan, menutup, dan membuka dokumen, 

Untuk membuat dokumen baru, dapat dilakukan dengan cara 

berikut: 

 Klik menu File > New sehingga muncul jendela Task Pane 

yang menampilkan bagian New Document. 

 Setelah itu, pilihlah Blank Document untuk membuat                           

dokumen. (Dapat juga memilih salah satu dokumen 

template untuk membuat dokumen baru berdasarkan 

template yang telah disediakan.) 

 Di dalam Tool Bar juga terdapat tombol New Blank 

Document yang befungsi untuk membuat dokumen baru 

tanpa melalui jendela Task Pane. 

Sebelum memulai dokumen, sebaiknya atur properti terlebih 

dahulu. Pengaturan properti mempengaruhi hasil cetakan. 

Pengaturan properti dapat dilakukan dengan menggunakan 

perintah File > Page Setup sehingga muncul kotak dialog Page 

Setup. Kotak dialog ini terdiri dari tiga bagian, yaitu Margins, 

Paper, dan Layout. 

Margins: untuk menentukan batas atas (Top), kiri (Left), kanan 

(Right), dan bawah (Bottom) dokumen, dan ada juga orientasi 

kertas. 

Paper Size: untuk menentukan ukuran kertas yang akan 

digunakan dengan memilih opsinya pada menu drop-down. 

Jika menginginkan ukuran kertas sendiri, dapat diisi nilainya 

secara langsung pada kotak Width dan Height secara default, 

satuan yang digunakan pada ruler maupun margin adalah inchi. 

Untuk mengubahnya ke centimeter, klik menu File > Options 

sehingga muncul kotak dialog Option). Pilih Advanced. Pada 

bagian Measurements Units, gantilah satuan ke Centimeters. 
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Gambar 2. Kotak Dialog Option 

1.6 Membuat dan mengelola dokumen 

a. Membuat dokumen, Untuk membuat file baru pada microsoft office 

2013 sama dengan micrososft office versi sebelumnya yaitu 

microsoft office 2010 akan tetapi terdapat tampilan dan beberapa 

fitur yang berbeda. Berikut cara membuat file baru pada Microsoft 

Office 2013. 

1. Klik menu File 

2. Setelah itu akan muncul tampilan seperti berikut 

 

 

3. Klik menu New untuk membuat dokumen baru kemudian pilih 

Blank Document atau Template yang telah disediakan 

 

Gambar 3. Template Pada Ms Word 
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4. Pilih Blank Document untuk membuat dokumen baru tanpa 

menggunakan tamplate, maka akan muncul lembar kerja seperti 

berikut : 

 

Gambar 4 Lembar Kerja 

b. Menyimpan dokumen, Menyimpan dokumen bisa 

menggungunakan save atau save as. Menyimpan dokumen, 

dengan memperhatikan Save atau Save as. Sebenarnya sama saja, 

yang membedakannya adalah apabila Save as, kita bisa mengganti 

nama dokumen yang akan disimpan. 

Menyimpan file/dokumen dengan Save As 

1. Klik menu File kemudian pilih menu Save As 

2. Pilih Computer lalu klik Browse menentukan tempat untuk 

menyimpan File 

 

3. Maka akan muncul kotak dialog seperti berikut ini 

 

Pada kotak dialog ini Anda harus menentukan tempat yang 

tepat untuk menyimpan file/dokumen yang telah Anda buat 
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kemudian mengisi File Name lalu klik tombol Save untuk 

menyimpan. 

 

c. Membuka File 

Klik File kemudian pilih menu Open 

 

Keterangan gambar 

1. Recent Document digunakan untuk membuka dokumen/file yang 

sudah pernah dibuka sebelumnya sehingga memudahkan Anda 

dalam membuka dokumen/file yang Anda butuhkan. 

2. Daftar dokumen yang pernah Anda buka jumlah tergantung 

berapa banyak dokumen yang pernah dibuka dalam rentan 

waktu atau periode tertentu. 

3. Computer digunakan untuk mengakses dokumen yang ada di 

drive atau tempat penyimpanan dokumen seperti Data (D), Local 

disk (C) dan lain-lain, sesuai dengan Anda menyimpan dokumen 

yang Anda butuhkan seperti gambar di bawah ini 

 

 

Gambar 5. Kotak Dokumen yang Berada di Komputer  



 

 
 
 

16 Modul Paket Keahlian Administrasi Perkantoran - Sekolah Menengah Kejuruan (SMK) 

 

Keterangan gambar 

1. Current Folder: cara cepat untuk mengakses folder yang 

sekarang ini sedang Anda gunakan untuk menyimpan file yang 

Anda miliki. 

2. Recent Folders: daftar folder yang sudah Anda akses dalam 

rentan waktu atau periode tertentu untuk mempercepat Anda 

mengakses folder yang sebelumnya pernah Anda buka. 

3. Browse: fasilitas untuk mencari folder atau dokumen yang 

pernah Anda simpan secara lebih terperinci, atau file/folder yang 

belum pernah Anda buka sebelumnya, seperti gambar berikut ini 

 

Gambar 6 File/Folder yang Dimiliki 

d. Menutup dokumen 

1. Menutup dokumen dengan mengklik tombol Close di Title Bar 

2. Menutup dokumen dengan mengklik File kemudian Klik Close 

 

Gambar 7. Menutup Dokumen Pada Perintah File 

2.1 Memformat teks, paragraf dan sections 

a. Mengatur Jenis huruf (Font), Pada saat menyelesaikan pekerjaan 

pada Microsoft Word ada aturan untuk mengaturan jenis huruf yang 

digunakan, ukuran huruf yang digunakan dan warna dari huruf 
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tersebut. Berikut cara mengatur jenis, ukuran dan warna huruf (font) 

pada Microsoft Word. 

Mengatur jenis huruf pada Microsoft Word 

1. Sebelum mengetik tulisan, setting terlebih dahulu jenis font yang 

akan digunakan, atau jika sudah terlanjur mengetik kata atau 

kalimat, maka yang harus dilakukan adalah dengan memblok 

tulisan terlebih dahulu. 

a. Klik menu Home 

b. Pilih jenis font yang diinginkan 

c. Kemudian lihat hasilnya 

 

b. Mengatur Warna huruf (Font) 

1. Blok tulisan terlebih dahulu 

2. Pilih Tanda A pada kolom font kemudian pilih warna font yang 

diinginkan 

3. Kemudian lihat hasilnya 

c. Menambah Style Efek Huruf, Microsoft Word 2013 menyediakan 

beragam efek untuk mengubah atau menambah huruf dari bentuk 

aslinya. Style huruf tebal, huruf miring atau tebal dan miring 

sekaligus dapat dilakukan dengan sangat mudah bahkan dari versi 

sebelumnya ada penambahan seperti huruf bercoret, huruf 

berpangkat atau membuat huruf besar semua atau kecil semua 

telah tersedia pada Ribbon. 

Untuk membuat tulisan tebal, miring, tebal dan miring serta bergaris 

bawah, pilihlah tulisan yang hendak diubah, lalu pada menu Home 

kita dapat memilih fasilitas yang ada, klik tombol B untuk tulisan 

tebal, I untuk tulisan miring, U untuk tulisan bergaris bawah dan 

tombol B dan I untuk tulisan tebal miring. 

Berikut tombol shortcuts pada keyboard untuk mempercepat 

penggunaan Style huruf antara lain: 

a. Tekan Ctrl + B untuk tulisan tebal, 

b.  Tekan Ctrl + I untuk tulisan miring, 

c. Tekan Ctrl + U untuk tulisan bergaris bawah,  
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d. Tekan Ctrl + B dan I untuk tulisan tebal miring. 

e. Tekan Ctrl + Shift + D untuk membuat garis bawah ganda,  

f. Tekan Ctrl + Shift + W untuk membuat garis bawah perkata. 

g. Tekan Shift + F3 untuk change case, mengganti huruf kecil 

semua ke besar semua atau sebaliknya, atau awal kata yang 

besar saja. 

h. Tekan Ctrl + = untuk membuat huruf Subscript, misal H2O 

i. Tekan Ctrl + Shift + = untuk membuat huruf Superscript misal 

M2 

 

Untuk lebih lengkapnya dapat di klik pada tanda segitiga kecil yang 

berada pada sudut kanan bawah Font atau dengan menekan Ctrl 

+ D. Efek yang ditimbulkan dari mencek list bagian ini adalah 

sebagai berikut : 

a. Strikethrough, untuk membuat teks dicoret satu kali pada 

bagian tengah teks contoh Aplha 

b. Double strikethrough, untuk membuat teks dicoret dua kali 

pada bagian tengah teks contoh Alpha 

c. Superscript, untuk membuat teks atau angka berpangkat 

(eksponen) contoh 3 M3. 

d. Subscript, untuk membuat huruf indek, contohnya H2O,  

e. Small Caps, efek teks menjadi huruf besar semua tetapi huruf 

kedua dan seterusnya mengecil ukurannya. (Ctrl + Shift + K) 

contoh MICROSOFT WORD 

f. ALL CAPS, efek teks menjadi huruf capital. (Ctrl + Shift A) 

contoh MICROSOFT WORD 

g. Hiden, teks yang diketik atau ditulis akan menghilang. 

d. Mengatur paragraf 

1. Bullets And Numbering, Bullets adalah penanda yang 

berhubungan dengan symbol sedangkan numbering adalah 

penanda yang berhubungan dengan angka. 

a. Cara memilih Bullet dari Library: 
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1. Klik paragraf yang akan dijadikan sebagai daftar 

pertama dalam Bulleted List. 

2. Pada tab Home, di grup Paragraph, klik tanda panah 

kebawah pada tombol Bullets. 

3. Jika Anda suka dengan salah satu model Bullet, klik 

untuk mengaplikasikannya. Jika tidak, lanjutkan ke 

langkah nomor 4. 

4. Jika Anda ingin menggunakan simbol dari font, Clip Art, 

atau gambar sebagai Bullet, di bawah galeri klik Define 

New Bullet. 

5. Pada kotak dialog New Bullet, klik Symbol jika Anda 

ingin menggunakan simbol dari font. 

6. Pada kotak dialog Symbol, pilih font yang ada di dalam 

daftar drop-down Font, klik simbol yang Anda inginkan, 

lalu klik Insert. 

e. Cara memilih Numbering dari Library 

1. Klik paragraf yang akan dijadikan sebagai daftar pertama dalam 

Numbered List. 

2. Pada tab Home, di grup Paragraph, klik tanda-panah-kebawah 

tombol Numbering. 

3. Jika Anda suka dengan format Numbering yang ada dalam galeri, 

klik untuk mengaplikasikannya. Jika tidak, lanjutkan ke langkah 

nomor 4. 

4. Klik Define New Number Format 

5. Pada kotak dialog Define New Number Format, di daftar drop-

down Number Style, pilih model penomoran yang Anda inginkan. 

6. Jika Anda ingin mengubah format karakternya, klik tombol Font 

dan pilih format yang Anda inginkan. Format ini tidak 

berpengaruh pada teks di dalam dokumen, hanya Numbered List 

saja 
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7. Jika Anda ingin memasukkan teks statis (teks yang tidak 

berubah-ubah) sebelum atau sesudah nomor/huruf daftar item, 

atau jika Anda ingin menggunakan tanda-baca yang berbeda, 

edit teks yang ada pada kotak Number Format. 

8. Klik OK. 

 

f. Perataan Teks, Microsoft Word memberikan fasilitas Alignment 

dalam kotak Dialoq Paragraph yang berfungsi untuk mengatur 

posisi teks atau perataan teks, fasilitas ini dimaksudkan agar 

dokumen yang kita kelola menjadi lebih rapi dan baik. Dalam 

Microsoft Word 2013 fasilitas alignment/perataan teks ini dilengkapi 

dengan 4 jenis, yaitu teks rata kanan, rata tengah, rata kiri dan rata 

kiri dan kanan. Pengaturan perataan teks bisa dilakukan dengan 

menggunakan beberapa cara, yaitu dengan ikon yang sudah 

ditampilkan, Dialog Paragraph dan tombol kombinasi. 

1. Dengan menggunakan ikon, fasilitas aligment bisa dilakukan 

dengan memilih menu Home, pada group paragraph pilih dan klik 

ikon yang bertuliskan Align Text Left, Center, Align Text Right 

dan atau Justify. Berikut gambarnya yang di lingkar merah 

2. Dengan menggunakan Dialog Paragraph, yaitu dengan 

membuka dialog paragraph sebagai mana cara berikut: Pada 

group paragraph klik tanda panah kecil sebelah kanan, maka di 

tampilkan dialog paragraph sebagaimana gambar berikut 

 

Gambar 8. Tombol Membuka Dialog Paragraph 

3. Dengan tombol kombinasi adalah 

 Ctrl + L = meratakan teks Kiri 

Align Left : apabila Anda menggunakan toolbar ini, maka text 

atau paragraf yang Anda pilih akan menjadi rata kiri. 
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 Ctrl + E = meratakan teks Tengah 

Align Center : apabila Anda menggunakan toolbar ini, maka 

text atau paragraf yang Anda pilih akan menjadi rata tengah. 

Fungsi ini umumnya dipakai untuk tulisan atau text yang berisi 

judul text. 

 Ctrl + R = meratakan teks Kanan 

Align Right : apabila Anda menggunakan toolbar ini, maka text 

atau paragraf yang Anda pilih akan menjadi rata kanan. 

 Ctrl + J = meratakan teks Kiri dan Kanan 

Justify : apabila Anda menggunakan toolbar ini, maka text 

atau paragraf yang Anda pilih akan menjadi rata kanan dan 

rata kiri [sama rata]  

Kita akan bahas satu persatu icon perataan microsoft word itu 

yang biasa juga dipakai dalam perataan pembuatan tabel : 

1. Align Top Left (Rata Kiri Atas) , Teks dibuat rata kiri 

secara horisontal dan rata atas secara vertical 

2. Align Top Center (Rata Tengah Atas) , Teks rata tengah 

secara horisontal dan rata atas secara vertical 

3. Align Top Right (Rata Kanan Atas) , Teks rata kanan 

secara horisontal dan rata atas secara vertical 

4. Align Center (Rata Tengah) , Teks rata tengah baik 

secara horisontal maupun vertical 

5. Align Left (Rata Kiri) , Teks rata kiri baik secara 

horisontal maupun vertical 

6. Align Right (Rata Tengah) , Teks rata kanan baik secara 

horisontal maupun vertical 

7. Align Bottom Left (Rata Kiri Bawah) , Teks dibuat rata 

kiri secara horisontal dan bawah atas secara vertical 

8. Align Bottom Center (Rata Tengah Bawah) , Teks rata 

tengah secara horisontal dan rata bawah secara vertical 

9. Align Bottom Right (Rata Kanan Bawah) , Teks rata 

kanan secara horisontal dan rata bawah secara vertical 

  

http://3.bp.blogspot.com/-Uzelx_g_hh0/UM0zFbIm7LI/AAAAAAAAAd4/qVSBSXcb7PE/s1600/1.gif
http://4.bp.blogspot.com/-dI4DToQnX6s/UM009rhdbpI/AAAAAAAAAeQ/pZoxDlOKgpI/s1600/2.gif
http://1.bp.blogspot.com/-DqZ-UxoPQeY/UM04FNJ-SdI/AAAAAAAAAe0/cAEk4R5_sYg/s1600/3.gif
http://1.bp.blogspot.com/-6_IszLw0yDA/UM04TGMsiAI/AAAAAAAAAe8/hf7aIjT3U7M/s1600/5.gif
http://1.bp.blogspot.com/-1KJDJ-N4xeI/UM08Lzmr_HI/AAAAAAAAAfg/yQc16aE4LyA/s1600/4.gif
http://1.bp.blogspot.com/-vVQgzbvxru0/UM049zN5AXI/AAAAAAAAAfM/idrKXzRvIOw/s1600/6.gif
http://3.bp.blogspot.com/-yiFug5uMN2s/UM09m3OTmAI/AAAAAAAAAf4/AcVEvkk3B0w/s1600/7.gif
http://2.bp.blogspot.com/-DOD042OAP1M/UM0-Pc8Q-mI/AAAAAAAAAgI/4m79pZ5LXIw/s1600/8.gif
http://2.bp.blogspot.com/-DOD042OAP1M/UM0-Pc8Q-mI/AAAAAAAAAgI/4m79pZ5LXIw/s1600/8.gif
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g. Pengaturan Arah Teks (text direction) tabel microsoft word 

Untuk mengatur arah teks atau memiringkan teks di tabel microsoft 

word Anda bisa menggunakan icon text direction. Setiap Anda klik 

icon itu satu kali maka teks akan diputar 90 derajat searah jarum 

jam. 

h. Jarak Baris, Jarak spasi yang dimaksud disini adalah jarak antar 

baris dalam suatu tulisan atau paragraph. Jarak antar baris di dalam 

paragraf atau jarak antar paragraf itu sendiri adalah faktor yang 

penting dalam mengelola dokumen. Jika jarak antar baris terlalu 

rapat atau terlalu lebar, akan membuat tidak nyaman dalam 

membaca.  

Semakin besar spasinya, maka jarak antara baris tulisan di atas dan 

di bawahnya akan menjadi lebih besar. Oleh karena itu agar 

dokumen yang dibuat dapat terlihat rapih dan mudah dibaca, ketika 

kita mengetik dokumen harus diperhatikan jarak barisnya. Berikut 

adalah cara mengatur jarak baris atau spasi 

1. Klik menu Page Layout 

2. Atur spasi dan paragraph pada sub menu paragraph 

3. Aturan jika ingin pengaturan lebih lanjut klik tanda panah 

kebawah pada menu paragraph 

i. Indentasi, Pengaturan indentasi atau penggeseran paragraf baik 

ke kiri maupun ke kanan dapat dilakukan dengan berbagai cara. 

Masing-masing cara mempunyai fungsi sesuai dengan tujuan dan 

variasi pekerjaan yang dilakukan. 

Cara-cara tersebut adalah: 

1. Melalui grup Paragraph pada ribbon Home 

Anda dapat langsung menekan tombol Decrease Indent dan 

Increase Indent yang terdapat pada grup Paragraph (ribon 

home) untuk menggeser paragraf ke kanan atau ke kiri. 

2. Melalui grup Paragraph pada ribon Page Layout, Cara 

sebelumnya, pengaturan indentasi tidak dapat diatur 

ukurannya. Namun melalui grup Paragraph yang terdapat pada 

Page Layout, Anda dapat mengatur sendiri 
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3. Melalui Kotak Dialog Paragraph, Jika ingin melakukan 

pengaturan paragraf lebih lanjut, caranya dengan mengklik 

anak panah (tooltip) pada grup paragraph untuk memunculkan 

kotak dialog Paragraph. 

Sehingga akan muncul kotak dialog Paragraph seperti berikut 

 

Gambar 9. Dialog Paragraph 

Keterangan: 

Left, jarak indentasi dari margin kiri,  

Right, jarak indentasi dari margin kanan 

Special, indentasi khusus sesuai dengan pengaturan yang kita 

lakukan sendiri, terdiri dari None (meniadakan indentasi 

khusus), First Line (indentasi kiri hanya untuk paragraf 

pertama saja) dan Hanging (untuk membuat indentasi 

gantung) 

4. Melalui Ruler, Selanjutnya Anda juga dapat melakukan 

pengaturan secara manual melalui ruler. Tentu saja rulernya 

harus diaktifkan terlebih dahulu yang dapat dilihat pada ribbon 

View. 

Selanjutnya seleksi paragraf yang ingin diubah indentasinya, 

lalu geser indentasi sesuai yang diinginkan menggunakan 

pointer mouse, seperti gambar berikut: 

 

Gambar 10. Identasi pada Ruler 
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j. Mengatur Page Breaks dan Sections Breaks 

 

Gambar 11. Breaks 

Page Break bisa diartikan mengakiri halaman tertentu kemudian 

memulai halaman berikutnya tetapi masih dalam satu section 

(ketika Anda memulai dokumen di Microsoft Word, seluruh 

dokumen terdiri dari satu bagian yang disebut section). Sedangkan 

Section Break dapat diartikan bahwa Anda mengakhiri suatu bagian 

(section) kemudian memulai section baru, dalam satu dokumen. Ini 

dilakukan karena Anda menginginkan format berbeda pada tiap 

bagian-nya. 

a. Page 

Page Break digunakan untuk memulai halaman 

berikutnya pada satu section. Digunakan untuk 

berpindah ke halaman berikutnya sebelum halaman 

habis tanpa harus menekan enter. 

Contoh Penggunaan Page Break 

Letakkan kursor pada posisi terakir halaman pertama, kemudian 

pilih Page Layout, dan pilih menu Break, kemudian menu 

Page, maka hasilnya akan seperti gambar berikut : 
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Gambar 12 Page Break 

Dengan menggunakan Page break, maka jika terjadi perubahan 

baris pada halaman pertama tidak akan mempengaruhi baris 

pada halaman berikutnya. 

 

b. Column  

 

Column digunakan untuk ke kolom berikutnya dalam satu 

halaman. Column Break digunakan jika halaman Anda terdiri dari 

2 kolom, letakkan kursor pada bagian terakhir tulisan di kolom 

pertama, kemudian pilih menu Page Layout, Break, kemudian 

pilih menu Column.  

Alasan penggunaan column break adalah untuk berpindah dari 

satu kolom ke kolom lain tanpa harus menunggu satu kolom 

penuh. Selain itu jika pada kolom pertama terjadi perubahan 

baris, hal ini tidak mempengaruhi baris pada kolom kedua 

c. Text Wrapping 

 

Text Wrapping digunakan untuk menurunkan Text di 

belakang Object sehingga secara otomatis text akan berpindah 

ke bawah object dan tidak melanjutkan dibelakangnya. 

Letakkan kursor di belakang gambar atau shape, kemudian pilih 

menu Text Wrapping dari Page Layout, kemudian Break. 
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Berikut perbandingaan antara mengunakan Text Wrapping 

Break, dan tidak menggunakan Text Wrapping Break. 

  

Gambar 13. Text Wrapping 

Terlihat bahwa tanpa text wrapping break, teks akan melanjutkan 

dibelakang gambar. Sedangkan dengan Text wrapping break, 

teks akan mulai dari depan dibawah gambar, mirip dengan 

menekan tombol Enter. 

2.2 Membuat Table 

a. Membuat Table 

1. Klik menu INSERT lalu klik tool add a table 

2. Buat table sesuai dengan banyak kolom dan baris.  

b. Memodifikasi Table 

Merge Cells 

1. Blok sel dari tabel yang akan di Merge 

2. Pilih Menu Layout 

3. Klik Merge Cells 

2.3 Insert Dan Format Objek 

a. Insert, Secara umum perintah yang terdapat di Ribbon Insert terdiri 

dari 7 Group perintah yang memiliki kesamaan fungsi. Beberapa 

Group yang terdapat di Ribbon ini yaitu : (1) Pages, (2) Tables, (3) 

Illustrations, (4) Links, (5) Header & Footer, ( 6) Text, dan (7) 

Symbols. 

1. Fungsi Ikon di Group Pages 

http://4.bp.blogspot.com/-ppfPLlZAa9g/UsEvslLTmdI/AAAAAAAAAl4/wVpzPKDbOdk/s1600/Text+Wrapping+Break.jpg
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a. Cover Page : Untuk menyisipkan dan memilih jenis halaman 

sampul 

b. Blank Page : Untuk menyisipkan halaman kosong baru pada 

dokumen 

c. Page Break : Memisah halaman dalam suatu dokumen 

2. Fungsi Ikon di Group Table 

 

a. Insert Table : Untuk menyisipkan tabel melalui Insert Table. 

b. Draw Table : Untuk menyisipkan tabel dengan menggambar 

di halaman dokumen. 

c. Convert Text to Table : Untuk menjadikan teks terpilih 

berada di tabel. 

d. Excel Spreadsheet : Untuk menyisipkan tabel dalam bentuk 

excel. 

e. Quick Tables : Untuk menyisipkan tabel instan yang telah 

disediakan oleh Microsoft Word 2013 

3. Fungsi Ikon di Group Illustration 

 

a. Picture : Untuk menyisipkan gambar yang di simpan di 

komputer. 

b. Clip Art : Untuk menyisipkan gambar ilustrasi dari library 

program. 

c. Shapes : Untuk menyisipkan gambar autoshapes. 
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d. SmartArt : Untuk menyisipkan gambar dalam bentuk 

organization. 

e. Chart : Untuk menyisipkan diagram. 

f. Screenshot : Menyisipkan objek dari layar komputer. 

 

4. Fungsi Ikon di Group Links 

 

a. Hyperlink : Menautkan objek / teks terpilih dengan file lain 

nya. 

b. Bookmark : Untuk membuat penanda buku. 

c. Cross-reference : Untuk membuat referensi antar file 

5. Fungsi Ikon di Group Header & Footer 

 

a. Header : Untuk mengatur kepala halaman suatu dokumen. 

b. Footer : Untuk mengatur kaki halaman suatu dokumen. 

c. Page Number :  Untuk melakukan setting terhadap nomor 

halaman. 

6. Fungsi Ikon di Group Text 

 

a. Text Box : Untuk menyisipkan kotak yang dapat diisi dengan 

text 

b. Quick Parts : Untuk mengatur teks secara otomatis. 
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c. WordArt : Untuk menyisipkan teks bergaya seni. 

d. Drop Cap : Untuk menyisipkan huruf kapital besar di awal 

teks/paragraf. 

e. Signature Line : Untuk menyisipkan tanda tangan digital. 

f. Date & Time : Untuk menyisipkan tanggal dan waktu terkini. 

g. Object : Untuk menyisipkan objek berekstensi OLE. 

7. Fungsi Ikon di Group Symbols 

 

a. Equation : Untuk menyisipkan rumus dalam matematika 

b. Symbol : Untuk menyisipkan karakter khusus 

 

b. Format shapes, biasa digunakan untuk memasukkan ataupun 

menyisipkan gambar-gambar bangunan seperti Garis (Lines), tanda 

panah (Block Arrow), Flowchart, Callouts dan juga Stars and 

banners. Perhatikan gambar di bawah ini :  

c. Smartart, Smartart mempunyai fungsinya untuk menyisipkan 

ataupun menampilkan diagram ataupun bagan pada lebar kerja 

Anda (document). Seperti diagram Process, Cycle, Hierachy, 

Relationship, Matrix, Pyramid. Perhatikan tampilan Smartart 

Graphic di bawah ini:  

 

Gambar 14. SmartArt 
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2.4 Pencetakan 

a. Page setup, Ketika akan membuat suatu dokumen seperti makalah, 

surat, laporan dan lain-lain, tentu ada beberapa aturan standar yang 

harus dipenuhi. Misalnya ukuran kertas yang biasanya 

menggunakan A4 dan margin dokumen dengan top: 3 cm, right: 3 

cm, bottom : 3 cm dan left : 4 cm. Untuk mengatur kedua properties 

caranya cukup mudah, berikut langkah-langkahnya. 

 

Mengatur margin dokumen 

Klik pada Ribbon Page Layout > Margin dan pilih Custom Margin 

Setelah keluar pop-up Page Setup dilanjutkan dengan mengatur 

Margin top, right, bottom dan left sesuai dengan kebutuhan 

  

Mengatur ukuran kertas 

Masih pada jendela Page Setup, klik pada tab Paper dan pilih 

ukuran kertas (paper size) yang akan digunakan. 

b. Print, Setelah membuat dokumen, kita perlu mencetak hasil 

pekerjaan kita tersebut di kertas baik itu hanya sekedar draft atau 

rancangan maupun dokumen final yang sudah selesai.  

Perhatikan langkah berikut :  

1. Klik menu File  

2. Sorot item Print, maka akan muncul :  

Pada gambar di atas nampak pada item Print terdapat beberapa 

pengaturan sebelum mencetak dokumen, seperti pengaturan 

printer (jika ingin mengubah konfigurasi printer), setting halaman, 

serta print preview dari dokumen yang akan dicetak.  

3. Anda dapat menggunakan tombol CTRL+P, ENTER untuk 

menampilkan item Print. 
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D. Aktivitas Pembelajaran 

a. Peserta diklat membaca modul untuk pembelajaran satu yaitu mengenai 

Microsoft Word dan memahaminya  

b. Peserta diklat menanyakan hal-hal yang tidak dimengerti kepada instruktur 

c. Peserta diklat mempraktekan: 

1) Membuat dan mengelola dokumen 

2) Memformat teks, paragraf dan sections 

3) Membuat table 

4) Insert dan format objek 

5) Cara mencetak dokumen 

 

E. Latihan/Kasus/Tugas 

1. Latihan 

1) Sebutkanlah pengertian dari Ms. Word? 

2) Sebutkan bagian-bagian dari layar kerja pada Ms. Word 2013? 

 

3) Sebutkanlah langkah-langkah membuat, menyimpan, menutup dan 

membuka dokumen? 

4) Lihatlah keterangan dibawah ini : 

a. Font apakah yang dipakai untuk teks berikut? 

 

 

b. Bagaimanakah cara agar paragraf tersebut tampil seperti berikut? 

icrosoft Word pertama kali dirilis pada 25 Oktober 1983 

oleh IBM PC . Pada masa itu, dunia pengolah kata 

dikuasai oleh WordPerfect dan Wordstar. Microsoft 

Word mempunyai konsep "What You See Is What You Get" (Apa 

yang kamu lihat adalah apa yang kamu dapatkan).  

  

M 

Belajar Microsoft Word 2013 
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c. Jelaskan fungsi dari gambar berikut ini!  

 

5) Sebutkan langkah-langkah dalam membuat table berikut ini? 

Bulan 

Jumlah Barang Dagangan Yang 

terjual 

Sarung Baju Koko 

Januari 240 140 

Februari 240 275 

Maret 275 189 

 

6) Buatlah objek dan tahap-tahap pembuatan gambar berikut! 

 

7) Sebutkanlah tahap-tahapan dalam mencetak dokumen? 

 

2. Tugas 

A. Tugas Microsoft Word 

a. Pengolahan Dokumen :  

 Lay out naskah sesuai dengan contoh (file tersedia dalam 

lampiran 1) 

 Simpan dengan nama file Praktik Word diikuti Nama Anda pada 

folder Anda masing-masing.  

b. Manipulasi Dokumen :  

 Sesuaikan jenis huruf dan jarak spasi menjadi 1½ baris pada teks 

paragraf pertama. 

 Beri garis antara kolom dan jarak antara kolom adalah 1 cm dan 

aturlah lebar kolom menjadi 7 cm 

 Huruf P pada kata Pokok paragraf pertama di tempat untuk dua 

baris 

  

Congratulations 
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c. Manipulasi Tabel : 

 Berikan format tabel seperti contoh soal (border, shading, lebar 

kolom, tinggi baris, penggabungan kolom, perataan teks) 

 Lakukan perhitungan dengan formula sebagai berikut 

1. Kolom Tarif Lama dari perhitungan penurunan 15% dari Tarif 

Baru 

2. Kolom Rata-rata dari perhitungan rata-rata Periode Pulsa 

d. Aturlah Format Dokumen untuk semua bentuk diatas dengan 

ketentuan sebagai berikut : 

 Margin Kanan dan Kiri 3 cm, margin atas dan bawah 2,5 cm 

 Ukuran kertas A4 

 Jenis Huruf Times New Roman dan Arial 

 Ukuran huruf untuk Judul 16pt; teks 12 pt 

 Jarak spasi 1½ dan 1 baris 

 Efek pencetakan sesuai naskah (tebal, miring, dan garis bawah) 

 Header dan Footer sesuai teks dan posisi yang terdapat di 

masing-masing bentuk. 

 

  



 

 
 
 

34 Modul Paket Keahlian Administrasi Perkantoran - Sekolah Menengah Kejuruan (SMK) 

 

TARIF LOKAL HARI LIBUR DAN HARI RAYA 

TARIF TERSEBUT Belum Termasuk PPn 10% 
 
 
 

ZONA SEMUA 

KOTA DILUAR 

JAKARTA DAN 

BANDUNG 

WAKTU 

TARIF 

PERIODE 

PULSA 
LAMA 

BARU 

(15% dr trf 

lama) 

0 – 20 Km 

00:00 – 09:00 ………... 200 190 

09:00 – 15:00 ………... 350 120 

15:00 – 24:00 ………... 250 190 

20 – 30 Km 

00:00 – 09:00 ………... 200 120 

09:00 – 15:00 ………... 350 90 

15:00 – 24:00 ………... 250 120 

 30Km 

00:00 – 09:00 ………... 200 190 

09:00 – 15:00 ………... 350 120 

15:00 – 24:00 ………... 250 190 

Rata2 ……….. 

Tarif Lama adalah penurunan 15% dari Tarif Baru 
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F. Rangkuman 

Microsoft Word adalah perangkat lunak pengolah kata andalan Microsoft. 

Sedangkan secara umum, Microsoft Word adalah sebuah program aplikasi 

pengolah data berupa huruf/kata yang biasa digunakan untuk membuat 

laporan, membuat dokumen, dan lain lain. Fungsi dan Kegunaan Microsoft 

Word antara lain:  

1. Untuk Membuat dokumen dengan cepat  

2. Untuk Membuat dokumen yang bisa dicetak  

3. Untuk Menyimpan dokumen dalam ukuran yang kecil dan format yang 

beragam  

4. Untuk Membuat tulisan dalam berbagai variasi  

5. Untuk Membuat label surat 

Manfaat dari microsoft word adalah 

1. Memudahkan dalam menyelesaikan pekerjaan 

2. Menghemat Waktu dalam Pekerjaan 

3. Menghemat Kertas dan Biaya 

Shortcut/hotkey adalah kombinasi dari beberapa tombol yang akan ditekan 

secara bersamaan mampu bereaksi secara spesifikasi pada komputer atau 

lebih mudahnya tombol cepat untuk sebuah perintah pada sistem kerja di 

komputer. 

Tampilan layar kerja MS Word 

1. Ikon Kontrol Menu (Control Menu Ikon) 

2. Baris Judul (Title Bar) 

3. Tombol Ukuran (Sizzing Button) 

4. Baris Toolbar (Tool bar) 

5. Rulers 

6. Area Pengetikan 

7. Kursor 

8. Task Pane 

9. Scroll Bar 

10. Status Bar 

11. Title bar 
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Untuk membuat dokumen dimulai dengan Klik menu FILE lalu Klik menu 

NEW untuk membuat dokumen baru kemudian pilih BLANK DOCUMENT 

atau TEMPLATE yang telah disediakan. Setelah selesai membuat 

dokumen maka menyimpan dokumen bisa menggungunakan save atau 

save as sedangkan  Menutup dokumen dengan mengklik FILE kemudian 

Klik CLOSE. 

G. Umpan Balik dan Tindak Lanjut 

Mengoperasikan Microsoft Word, merupakan aplikasi pengolahan kata yang 

sangat berguna dalam membuat dokumen, laporan, makalah dll. Oleh karena 

itu setelah mempelajari materi ini diharapkan peserta diklat dapat menguasi 

Microsoft Word, sehingga dapat diimplementasikan dengan pelajaran-

pelajaran lain, seperti koresponden, arsip, membuat notula, membuat laporan 

dll. 

H. Kunci Jawaban 

1. Menurut Wikipedia, Microsoft Word adalah sebuah program aplikasi 

pengolah data berupa huruf/kata yang biasa digunakan untuk membuat 

laporan, membuat dokumen, dan lain lain 

2. 1. Layar Kerja 

2. Quick Acces  

3. Title Bar 

4. Tool Bar 

5. Menu Bar  

6. Tombol Ukuran 

Jendela 

7. Lambang Tab 

8. Tombol Dialog 

9. Rules Bar 

10. Scroll Bar 

11. Zoom 

12. Pengatur Halaman Tampilan 

Kerja  

13. Status Bar 

3. Langkah-langkah membuat, menyimpan, menutup dan membuka 

dokumen 

- Membuat dokumen: 

1. Klik menu File 

2. Klik menu New untuk membuat dokumen baru kemudian pilih Blank 

Document atau Template yang telah disediakan 
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3. Pilih Blank Document untuk membuat dokumen baru tanpa 

menggunakan tamplat. 

- Menyimpan dokumen: 

1. Klik menu File kemudian pilih menu Save As 

2. Pilih Computer lalu klik Browse menentukan tempat untuk 

menyimpan File 

3. Pada kotak dialog Anda harus mengisi File Name lalu klik tombol 

Save untuk menyimpan. 

- Membuka dokumen: 

Klik File kemudian pilih menu Open 

- Menutup dokumen: 

1. Menutup dokumen dengan mengklik tombol Close di Title Bar 

2. Menutup dokumen dengan mengklik File kemudian Klik Close 

4. a. Font teks tersebut adalah Goudy Stout 

b. cara membuat paragraf berikut adalah Klik Insert > Drop Cap > 

Dropped 

c. fungsi column break untuk ke kolom berikutnya dalam satu halaman 

5. Langkah-langkah membuat table: 

- Klik menu Insert 

- Buat table 3 x 5 

- Style table adalah Grid table dark 5, accent 5 

6. Langkah-langkah membuat objek yaitu klik menu Insert > Shapes > pilih 

horizontal scroll. Draw objek kemudian klik kanan dan pilih Add Text 

7. Cara mencetak dokumen yaitu; 

- Klik menu File 

- Pilih Print 

- Klik Print 
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Kompetensi 
Profesional 

 

Kegiatan Pembelajaran 2:  

Mengoperasikan Microsoft Excel 

 

 

A. Tujuan 

Setelah mempelajari kegiatan belajar dua ini, peserta diklat  diharapkan : 

1. Memahami pengertian MS Excel dengan baik 

2. Dapat mengenal tampilan layar kerja MS Excel dengan jelas 

3. Dapat membuat dan mengatur workbooks dan worksheets  dengan 

penuh tanggung jawab 

4. Dapat memformat worksheets sesuai dengan baik 

5. Dapat mengatur sel dan range sesuai kebutuhan dengan baik 

6. Dapat mengatur table sesuai kebutuhan dengan penuh tanggung jawab 

7. Dapat menerapkan formula dan fungsi dengan cermat 

8. Dapat membuat grafik dengan baik 

9. Dapat mencetak dokumen dengan berbagai printer dengan teliti 

B. Indikator Pencapaian Kompetensi 

Setelah mempelajari kegiatan belajar dua dengan judul Mengoperasikan 

microsoft excel, peserta diklat  diharapkan dapat : 

1. Menyebutkan pengertian MS Excel  

2. Mengidentifikasi tampilan layar kerja MS Excel dengan jelas 

3. Mengoprasikan workbooks dan worksheets  sesuai dengan kebutuhan 

4. Menerapkan format pada worksheets sesuai dengan kebutuhan 

5. Menjalankan cara mengatur sel dan range sesuai dengan kebutuhan 

6. Mengnoprasikan table sesuai dengan kebutuhan 

7. Menerapkan formula dan fungsi  

8. Melatih membuat grafik 

9. Melakukan cara mencetak dokumen 
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C. Uraian Materi 

1. Pengertian 

Microsoft Excel adalah  General Purpose Electronic Spreadsheet  yang 

dapat digunakan untuk mengorganisir, menghitung, menganalisa  data-

data  dan mempresentasikannya ke dalam bentuk grafik atau diagram. 

Fungsi dari Microsoft Excel adalah untuk melakukan operasi perhitungan 

serta dapat mempresentasikan data kedalam bentuk tabel. Kemudahan 

lain yang diperoleh dari program ini adalah terintegrasinya program 

Microsoft Excel dengan program aplikasi windows yang lain. Saat 

membuka Microsoft Excel maka sebuah buku kerja (Workbook) siap 

digunakan yang didalamnya terdapat beberapa lembar kerja (worksheet). 

 

2. Pengenalan Tampilan Layar Kerja Microsoft Excel 

Lembar kerja dalam Microsoft Excel 2013 dalam satu sheet terdiri dari 

16384 kolom (columns)  dan 1048576 baris  (rows). Kolom ditampilkan 

dalam tanda huruf A, B, C dan berakhir pada kolom XFD. Sedangkan baris 

dilambangkan dalam bentuk angka 1, 2, 3 dan berakhir pada 1048576.  

Perpotongan antara baris dan kolom disebut sel (cell), misal, pada 

perpotongan kolom B dengan baris ke 5 disebut B5. 

Pengenalan Pointer Pada Microsoft Excel 

 

 

Tabel 2. Pointer pada Ms Excel 
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Berikut adalah lingkungan kerja pada excel 

 

Gambar 15. Layar Kerja Ms Excel 

Komponen-komponen penting dari lingkungan kerja excel adalah : 

 Tab: merupakan pengganti menu bar. Tab menampung berbagi group 

yang dikelompokan berdasarkan kedekatan fungsinya 

 Group: merupakan pengganti toolbar dan terletak di bawah tab. Group 

berisi command button yang berfungsi seperti ikon-ikon toolbar 

 Command button: tombol-tombol di dalam group, berfungsi untuk 

melakukan aksi tertentu di excel. 

 Area kerja: lokasi workbook beserta tempat dilakukannya pengolahan 

data. Area  kerja bisa menampung workbook dengan jumlah lebih dari 

satu karena menggunakan prinsip MDI (Multipie Document Interface) 

 Scrollbar: dipergunakan untuk menggeser posisi tampilan spreadsheet 

di area kerja. Ada dua jenis scrollbar, pertama adalah scrollbar vertikal 

yang terletak di sebelah kanan area kerja dan yang kedua adalah 

scrollbar horizontal yang terletak di bawah area kerja. 

 Kotak teks formula dan kotak nama: area ini terletak di bawah group. 

Formula bar digunakan untuk menuliskan formula yang bermanfaat 

melakukan perhitungan di sel-sel di excel. Adapun kotak nama 

digunakan untuk menuliskan nomor sel  yang terpilih. 

 Quick Access Toolbar: bagian yang terletak di sebelah kanan. 

 

Gambar Quick Access Toolbar 
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 Column/Kolom : kolom adalah bagian dari spreadsheet  yang membujur  

dari atas ke bawah atau dengan kata lain posisinya adalah vertikal. Di 

excel, kolom diberi nama dengan huruf A. B, C dan seterusnya. 

 Row/Baris: adalah bagian dari spreadsheet yang membujur dari kiri ke 

kanan atau dengan kata lain terletak dalam posisi horizontal. Di excel, 

baris diberi nama dengan nomor seperti 1,2,3, dan seterusnya. 

 Sel :  adalah kotak terkecil di spreadsheet, merupakan titik pertemuan 

antara kolom dengan baris. Di excel, sel ditulis dengan kooedinat (kolom, 

baris) misalnya A1, B3, C39, dan seterusnya. 

 Control box: tombol-tombol yang berfungsi mengatur perilaku jendela. 

Dapat melakukan perbesaran Maxmize/Restore, Minimize, ataupun 

Close. 

 Title bar: menampilkan nama workbook yang sedang terbuka. Apabila 

workbook belum pernah disimpan, tulisan yang ditampilkan adalah 

“Book+Nomor” seperti “Book1”, “Book2”, dan seterusnya. 

3. Membuat dan Mengatur Workbooks dan Worksheets 

3.1. Membuka Workbooks 

Klik tombol Start pada keyboard, kemudian arahkan pada pilihan All 

Programs, Setelah beberapa saat, maka akan muncul tampilan dasar 

Microsoft excel 

Lalu klik blank workbook untuk memulai menjalankan aplikasi Microsoft 

office 

3.2. Membuat workbook 

1. Klik tab File.  

2. Klik New.  

3. Klik Blank Workbook 

3.3. Menyimpan Workbooks 

Kehilangan pekerjaan Excel yang telah dilakukan berjam-jam karena 

lupa menyimpannya adalah sebuah pekerjaan yang sia-sia. Ketika 

menutup Workbook, Excel akan memeriksa apakah ada perubahan 

pada file tersebut semenjak terakhir kali  menyimpannya.  

Jika ada perubahan, akan ada permintaan untuk menyimpan 

Workbook sebelum menutupnya. Jika ingin menyimpan Workbook 
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menjadi banyak versi/format, bisa dengan membuat kopian file 

tersebut dengan cara menyimpannya dengan menggunakan nama 

yang berbeda. 

Cara menyimpan woorkbook: 

 Klik tombol Save yang ada di Quick Access Toolbar 

 Cara menyimpan Workbook dengan nama baru: 

1. Klik tab File. 

2. Klik Save As. 

3. Klik Computer. 

4. Klik Browse. 

5. Navigasikan ke direktori/lokasi dimana Anda ingin menyimpan 

file tersebut. 

6. Masukkan nama file.  

7. Klik Save. 

 

3.4. Menutup workbooks 

Ketika Anda selesai mengerjakan Workbook Excel, Anda bisa 

menutupnya untuk mengurangi banyaknya aplikasi yang terbuka pada 

desktop dan menghemat memory yang digunakan komputer Anda 

dalam menjalankan program tersebut. Anda bisa keluar dari program 

Excel ketika Anda sudah menyelesaikan pekerjaan Anda dengan 

Excel, dan berpindah ke aplikasi lain yang akan Anda kerjakan. 

 Cara menutup Workbook: 

1. Klik tab File. 

2. Klik Close. 

3.5. Menyisipkan Worksheets 

Untuk menyisipkan lembar kerja baru , dapat dilakukan dengan cara 

sebagai berikut : 

 Klik tombol sheet Baru di bagian bawah layar 

 Klik tombol Lembar Baru 

Untuk menyisipkan lembar kerja baru di depan lembar kerja yang 

ada, pilih lembar kerja yang ada dan kemudian , klik Depan > 

Insert , > Sisipkan Lembar. 
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Untuk mengubah urutan worksheet dalam workbook, klik tab 

worksheet yang ingin Anda pindahkan, dan kemudian tarik ke 

tempat yang diinginkan. 

 

4. Memformat Worksheets  

4.1. Merubah tinggi baris 

 Pilih baris atau beberapa baris yang ingin Anda rubah 

 Pada menu Home bagian grup Cell, pilih Format 

 Pada kotak Row Height, ketikkan nilai yang Anda inginkan. Lalu 

klik Ok. 

 

4.2. Lebar Kolom 

 Pilih kolom atau beberapa kolom yang ingin Anda rubah 

 Pada menu Home bagian grup Cell, pilih Format 

 Pada kotak Column Width, ketikkan nilai yang Anda inginkan. 

Lalu klik Ok. 

4.3. Menyisipkan Kolom Dan Baris 

 Menyisipkan kolom 

 Pilih kolom yang akan Anda tambahkan 

 Klik kanan, lalu pilih Insert 

4.4. Menghapus Kolom Dan Baris 

 Blok bagian yang akan dihapus 

 Klik kanan, lalu pilih Delete 

 

5. Mengatur sel dan range 

5.1. Format data series, Metode yang paling dasar memasukkan data 

dalam sel adalah dengan memasukkan secara manual. Ketika Anda 

membuat struktur berbagai data, atau serangkaian formula, Anda 

dapat mengotomasi proses melengkapi data pola (seperti Januari, 

Februari, Maret) atau perhitungan menyalin dari satu baris atau kolom 

untuk mereka berdekatan. Otomasi menghemat waktu dan dapat 

membantu mencegah kesalahan seseorang. 
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Anda dapat mengisi sel yang berdekatan dengan data formula yang 

berkelanjutan atau serangkaian nomor, hari, atau tanggal, baik secara 

manual dari menu Fill, atau secara otomatis dengan menyeret fill 

handle. Ketika menyalin atau mengisi data dengan menggunakan 

perintah menu Fill, Anda dapat mengatur opsi khusus pada kotak 

dialog Series untuk pola urutan data yang ingin Anda buat. 

 

Gambar16 Kotak dialog Series 

Dalam membuat seri berdasarkan satu atau lebih sel yang dipilih 

(disebut mengisi seri), Anda dapat memilih jenis seri sebagai berikut: 

 Linear: Excel menghitung nilai seri dengan menambahkan nilai 

yang Anda masukkan dalam kotak, langkah nilai untuk setiap sel 

dalam seri. 

 Growth: Excel menghitung nilai seri dengan mengalikan setiap sel 

dalam seri dengan nilai langkah. 

 Date: Excel menghitung nilai seri oleh peningkatan setiap sel dalam 

rangkaian tanggal, yang ditunjuk oleh bagian tanggal  yang Anda 

pilih, dengan nilai langkah. 

 AutoFill:  Pilihan ini menciptakan serangkaian yang menghasilkan 

hasil yang sama seperti menyeret fill handle 

Ketika menggunakan fitur AutoFill, baik dari menu Fill atau dengan 

menyeret fill handle, tombol pilihan AutoFill muncul di sudut kanan 

bawah dari fill range. Klik tombol tampilan menu dari pilihan isi. Pilihan 

yang berisi variasi berdasarkan jenis konten yang diisi. 
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5.2. Format sel (number, alignment, font, border dan fill) 

 Blok sel yang akan di format 

 Lalu klik kanan dan pilih Format Cell 

 

 Tentukan Number, Alignment, Font, Border, Fill yang dikehendaki. 

6. Mengatur table 

6.1 Membuat table 

 Blok data yang akan diberi table 

 Pada menu Insert, klik Table. Lalu klik Ok pada kotak Create 

Table 

 

6.2 Memodifikasi table (styles) 

Klik Design (Table Tool), pada grup Table Style pilih bentuk table 

yang di inginkan 

 

6.3 Filter dan sort table 

 Filter 

1. Klik bagian yang akan di filter. 

2. Pada menu Home di grup Editing pilih Sort & Filter. 

3. Klik Filter 
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 Sort Table 

1. Klik bagian yang akan di filter. 

2. Pada menu Home di grup Editing pilih Sort & Filter. 

3. Klik Sort A to Z 

 
7. Menerapkan Formula Dan Fungsi 

7.1 Referensi Sel (relatif sel, absolut sel dan semi absolut sel) 

Formula bar berfungsi untuk memasukkan, memperbaiki, dan juga 

dapat menampilkan data atau rumus pada sel yang sedang aktif. Untuk 

memperbaiki data atau rumus adalah dengan cara mengklik atau 

menekan tombol F2. 

Referensi Sel (Relatif Sel, Absolut Sel dan Absolut Sel) 

 Relatif Sel 

Sel yang berubah jika disalin, contoh A1, B3 dll 

 Absolut Sel 

Sel akan tetap apabila alamat sel yang berisi rumus dicopy ke 

alamat sel yang lain, ciri alamat sel absolut adanya tanda ‘$’ di 

depan kolom dan baris, contoh $A$1, $B$1. 

 Semi Absolut Sel 

Gabungan antara sel relatif dan sel absolut, contoh $A1, B$1 

 

7.2 Penggunaan Formula/Fungsi Dasar (sum, count, counta, average, 

min dan max) 

a. Aritmatika Dasar : Fungsi penjumlahan (+), pengurangan (-), 

perkalian (*), dan pembagian (/). 

b. SUM: Berfungsi untuk menjumlahkan data. 

c. MIN: Berfungsi untuk mencari nilai terendah dari kumpulan data. 

d. MAX: Berfungsi untuk mencari nilai tertinggi dari kumpulan data. 

e. AVERAGE: Berfungsi untuk mencari nilai rata-rata dari kumpulan 

data. 

f. COUNT: Berfungsi untuk menghitung banyaknya data. 
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7.3 Penggunaan Formula/Fungsi Teks (left, mid, right, upper, lower 

dan concatenate) 

FUNGSI KEGUNAAN SYNTAK 

CONCATENATE 

sebuah fungsi yang 

berfungsi untuk 

menggabungkan item-item 

baik yang berupa teks, 

angka, referensi sel atau 

kombinasi dari item-item 

tersebut ke dalam satu 

string teks hingga 

mencapai 225 string teks 

= CONCATENATE(text1, 

[text2], ...)  

 text1 merupakan teks 

pertama yang akan 

digabungkan. 

 text2 merupakan teks 

kedua yang akan 

digabungkan. 

 Begitu seterusnya sampai 

teks ke 255. 

LEFT 

sebuah fungsi yang 

berfungsi untuk 

mengembalikan karakter 

pertama atau beberapa 

karakter dalam string teks 

dari posisi paling kiri 

berdasarkan jumlah 

karakter yang ditentukan 

=LEFT(teks, [num_chars]) 

 text merupakan strings 

teks yang berisi karakter 

yang akan diambil atau 

dikembalikan nilainya 

 num_chars merupakan 

jumlah karakter yang 

diambil atau diekstrak dari 

strings teks dihitung dari 

karakter paling kiri (satu 

spasi dihitung satu 

karakter). 

RIGHT 

sebuah fungsi yang 

berfungsi untuk 

mengembalikan karakter 

terakhir atau beberapa 

karakter dalam string teks 

dari posisi paling kanan 

berdasarkan jumlah 

karakter yang ditentukan 

=RIGHT(teks, [num_chars]) 

 text merupakan strings 

teks yang berisi karakter 

yang akan diambil atau 

dikembalikan nilainya 

 num_chars merupakan 

jumlah karakter yang 

diambil atau diekstrak dari 

strings teks dihitung dari 

karakter paling kanan 

(satu spasi dihitung satu 

karakter). 

MID 
sebuah fungsi yang 

berfungsi untuk 

MID(text, start_num, 

num_chars) 
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FUNGSI KEGUNAAN SYNTAK 

mengembalikan karakter 

dari tengah atau sebuah 

string yang posisi 

mulainya dan jumlah 

karakternya ditentukan. 

 Teks merupakan strings teks 

dalam suatu sel yang akan 

diambil karakter atau 

katanya. 

 Start_num merupakan posisi 

karakter pertama yang yang 

akan diekstrak / diambil atau 

tempat awal akan dimulai 

diambilnya teks yang 

ditentukan 

 Num_chars merupakan 

panjang atau jumlah 

karakter yang akan diambil 

dengan menggunakan 

rumus fungsi mid. 

LOWER 

sebuah fungsi yang 

berfungsi untuk mengubah 

semua string teks menjadi 

huruf kecil dalam string 

teks 

=LOWER(teks) 

 teks merupakan sebuah 

strings teks pada suatu sel 

(referensi sel) yang akan 

diubah bentuk penulisan 

katanya dengan 

menggunakan huruf besar 

semua. 

UPPER 

sebuah fungsi yang 

berfungsi untuk mengubah 

semua string teks menjadi 

huruf besar dalam string 

teks 

UPPER(teks) 

 teks merupakan sebuah 

strings teks pada suatu sel 

(referensi sel) yang akan 

diubah bentuk penulisan 

katanya dengan 

menggunakan huruf besar 

semua. 

Tabel 3. Fungsi Teks 
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7.4 Penggunaan Formula/Fungsi Logika (and, or dan if) 

Fungsi Logika Pengertian 

NOT 

Suatu fungsi yang digunakan untuk membalik suatu 

nilai logika.  

Sintaks:  

=OR(Logical) 

AND 

Suatu fungsi yang apabila salah satu pernyataan 

bernilai S (Salah), maka pernyataan kombinasinya 

juga akan bernilai S (Salah).  

Sintaks:  

=AND(Logical1,Logical2, …) 

Jadi tidak hanya terbatas dengan dua syarat (logical) 

saja, melainkan bisa lebih banyak.  

OR 

Suatu fungsi yang apabila salah satu pernyataan 

bernilai B (Benar), maka pernyataan kombinasinya 

juga akan bernilai B (Benar).  

Sintaks:  

=OR(Logical1,Logical2, …) 

Jadi tidak hanya terbatas dua syarat (logical) saja, 

melainkan bisa lebih banyak.  

IF 

Suatu fungsi yang digunakan jika ada pertalian/ 

hubungan sebab dan akibat atau ada persyaratan 

yang harus dipenuhi.  

Sintaks:  

=IF(Logical Test;True;False) 

Tabel 4. Fungsi Logika 
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Logika Ganda 

Berikut ini adalah penggabungan antara Fungi Logika IF dengan 

Fungsi Logika AND; dan penggabungan antara Fungi Logika IF 

dengan Fungsi Logika OR. 

 

Rumus Logika IF dengan 
AND 

Rumus Logika IF dengan OR 

Sintaks:  

=IF(AND(Logicall;Logical2);True;Fa

lse) 

Arti:  

Jika Logical1 dan Logical2 keduanya 

benar, maka nilai yang diambil adalah 

True. Nilai yang akan diambil untuk 

selain itu adalah False.  

Sintaks:  

=IF(OR(Logicall;Logical2);True;False)  

Arti:  

Jika Logical1 atau Logical2 bernilai 

benar, maka nilai yang diambil adalah 

True. Nilai yang akan diambil untuk selain 

itu adalah False.  

Tabel 5. Logika Ganda 

7.5 Penggunaan Formula/Fungsi Pencarian Table (hlookup, vlookup) 

a. Fungsi VLOOKUP  

Dipakai untuk mencari suatu nilai pada kolom paling kiri suatu tabel 

dan mengambil nilai kolom lain yang ditentukan pada baris yang 

sama.  

Sintaks:  

=VLOOKUP(Lookup_Value;Table_Array;Col_Index_Num;[Ran

ge_Lookup])  

 

b. Fungsi HLOOKUP  

Dipakai untuk mencari suatu nilai pada baris paling atas suatu tabel 

dan mengambil nilai baris lain yang ditentukan pada kolom yang 

sama.  

Lookup_Value  Dapat berupa isi sel atau nilai yang diketik  

Table_Array  
Tabel yang dipakai sebagai rujukan pencarian 

web 
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Sintaks:  

=HLOOKUP(Lookup_Value;Table_Array;Col_Index_Num;[Range

_Lookup]) 

8. Membuat Grafik 

8.1 Membuat Grafik 

Grafik biasa dipakai untuk menampilkan komposisi data secara visual, 

menggunakan gambar atau simbol tertentu, sehingga mempermudah 

pemahaman dan pengertian tentang data secara menyeluruh.  

Buatlah tabel seperti di bawah ini : 

 

 Klik menu Insert, lalu pilih Charts 

 

 

 

 

 

8.2 Memformat Grafik (axis title, chart title, data label, gridline, 

legend dan axis labels) 

a. Cara menambahkan Judul Grafik (Chart Title) 

 Klik chart yang ingin ditambahkan judulnya. Pada menu 

Ribbon akan muncul menu group Chart Tools dengan 3 tab: 

Design, Layout dan Format. 

Col_Index_Num  
Menunjukkan kolom beberapa yang nilainya 

akan diambil  

Range_Lookup  

Dapat dikosongkan atau diisi “True” jika tabel disusun 

terurut dan pencarian diartikan sama dengan atau lebih 

kecil, jika diisi “False” maka tabel tidak harus terurut dan 

pencarian diartikan sebagai “yang sama persis”  
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 Klik tab Layout. 

 Klik menu Chart Title, akan muncul 2 pilihan posisi untuk 

judul chart yaitu Centered Overlay Title dan Above Chart. 

Pilih Above Chart untuk meletakkan judul di atas chart. 

 

 Pada chart kita akan muncul tulisan Chart Title. Klik pada 

teks tersebut sampai kursor untuk melakukan edit muncul. 

 

 

 Masukkan teks Jumlah Unit Terjual – Tahun 2011. Setelah 

selesai klik cell atau objek di luar area judul. 

 

 Selesai 

b. Cara Menambahkan Axis Title 

 Cara mengubah skala pada sumbu nilai: 

1. Klik grafik yang ingin Anda format. 

2. Klik-kanan pada sumbu vertikal. 

3. Klik Format Axis. 

4. Dibawah Bounds, di kotak Minimum, ketikkan nilai minimal 

untuk sumbu vertikal. 

http://static.belajarexcel.info/wp-content/uploads/2013/12/01_chart_tools_ribbon_menu-compressed.png
http://static.belajarexcel.info/wp-content/uploads/2013/12/02_chart_title_menu-compressed.png
http://static.belajarexcel.info/wp-content/uploads/2013/12/03_chart_title_text-compressed.png
http://static.belajarexcel.info/wp-content/uploads/2013/12/04_hasil_akhir_chart-compressed.png
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5. Dibawah Bounds, di kotak Maximum, ketikkan nilai 

maksimal untuk sumbu vertikal. 

6. Dibawah Units, di kotak Major, ketikkan nilai untuk unit 

besar yang ditampilkan pada sumbu vertikal. 

7. Dibawah Units, di kotak Minor, ketikkan nilai untuk unit kecil 

yang ditampilkan pada sumbu vertikal. 

8. Klik Close. 

 

 Cara mengubah skala pada sumbu kategori (x): 

1. Klik grafik yang ingin Anda format. 

2. Klik-kanan pada sumbu horizontal. 

3. Klik Format Axis 

 

4. Klik Tick Marks. 

5. Ketikkan angka pada kotak Interval Between Marks. 

6. Pilih opsi untuk Major Type. 

7. Pilih opsi untuk Minor Type. 

8. Pilih atau kosongkan opsi lainnya. 

9. Klik Close. 

 

9. Pencetakan 

9.1 Pagesetup 

 Klik File, lalu pilih Print, lalu klik Pagesetup 

 Untuk menentukan orientasi dan ukuran kertas 

 Untuk menentukan margin 

 Lalu klik Ok 

9.2 Print 

Klik File, lalu pilih Print (Ctrl + P) 

Klik Print 

 

http://2.bp.blogspot.com/-67JrYdJ7jM0/Uo3bmS1o4yI/AAAAAAAAI7I/tislRY8kwd0/s1600/Excel2013-251-1.png
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D. Aktivitas Pembelajaran 

Peserta diklat mempraktekan: 

1. Cara membuat dan mengatur workbooks dan worksheets 

2. Cara memformat worksheets 

3. Cara mengatur sel dan range 

4. Cara mengatur table 

5. Cara menerapkan formula dan fungsi 

6. Cara membuat grafik 

7. Cara pencetakan 

 

E. Latihan/Kasus/Tugas 

1. Latihan 

a. Sebutkan pengertian excel? 

b. Sebutkan bagian-again berikut: 

 

c. Sebutkan tahapan dalam membuat workbooks? 

d. Sebutkan langkah-langkah menyisipkan kolom pada worksheet? 

e. Sebutkan langkah-langkah memformat cell alignment? 

f. Sebutkan langkah-langkah membuat tabel? 

g. Fungsi average adalah ...  

h. Sebutkan langkah-langkah membuat grafik?  

i. Sebutkan langkah-langkah print selection? 
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2. Tugas 

PETUNJUK PENGERJAAN : 

a. Buatlah naskah ketikan yang sama persis dengan soal berikut ini 

pada komputer masing-masing! 

b. Bacalah Petunjuk Khusus! 

c. Lengkapi semua bagian tabel dalam soal berikut ini! 

d. Selamat mengerjakan. 

 

NILAI UJIAN NASIONAL TAHUN 2012

Nomor

Peserta B. Indo B. Ingg Matematika

1 75647 Yessy Gusman 4,03 5,30 6,05 15,38 5,13 Tidak Lulus

2 92348 Adrie Subono 7,40 5,00 4,00 16,40 5,47 Lulus

3 12967 Riantino Susilo 7,45 5,50 6,30 19,25 6,42 Lulus

4 12974 Tindy Subagja 4,50 5,50 4,00 14,00 4,67 Tidak Lulus

5 13256 Nafla Fatina Zahira 9,50 7,50 8,00 25,00 8,33 Lulus

18,88 15,80 16,35

6,29 5,27 5,45

JUMLAH SISWA YANG LULUS

NILA TERENDAH per MAPEL

NILAI TERTINGGI  per MAPEL

JUMLAH per MAPEL

RATA-RATA per MAPEL

NO
NAMA Jumlah Rata

2 Kelulusan
Nilai

(Tidak perlu diketik) 

Petunjuk Khusus : 

 Buatlah Tabel di atas sama persis. 

 Isilah Cell-Cell yang kosong dengan rumus yang sesuai sebagai berikut : 

1. Untuk kolom Jumlah, isilah dengan menghitung jumlah nilai ujian. 

2. Untuk kolom Rata-Rata, isilah dengan menghitung rata-rata nilai ujian. 

3. Untuk kolom Kelulusan, jika Rata-Rata di atas 5,50 maka LULUS, tapi jika 

tidak maka TIDAK LULUS. 

4. Buat grafik  

Waktu 30 menit. 

 

  



 

 
 
 

56 Modul Paket Keahlian Administrasi Perkantoran - Sekolah Menengah Kejuruan (SMK) 

 

F. Rangkuman 

Microsoft Excel 2013 adalah  General Purpose Electronic Spreadsheet  yang 

dapat digunakan untuk mengorganisir, menghitung, menyediakan 

maupun  menganalisa  data-data  dan mempresentasikannya ke dalam 

bentuk grafik atau diagram.  

Komponen-komponen paling penting dalam program Microsoft Excel adalah 

tab, group, command button, area kerja, scrollbar, kotak teks formula dan 

kotak nama, quick access toolbar, column/kolom, row/baris, sel, control box, 

dan title bar.  

Untuk membuka program Microsoft Excel yang pertama dengan Mengklik 

‘Start’ pilih menu ‘All Prgrams’ lalu ke pilihan Microsoft Office dan klik 

‘Microsoft Excel’ maka akan muncul tampilan dasar Microsoft Excel lalu klik 

‘blank workbook’. Jika ingin menyimpan dokumen Microsoft excel adalah 

dengan cara Save / Save As. Setelah selesai menggunakan program 

Microsoft Office dapat ditutup dengan cara mengklik Tab File lalu pilih Close. 

Merubah tinggi baris dan lebar kolom dalam program Microsoft Excel, pertama 

pilih baris atau kolom yang akan diubah dan pada bagian menu Home bagian 

group Cell dan pilih Format. Dalam program Microsoft Excel juga bisa 

mengatur sel dan range untuk memformat data series dan format sel (number, 

alignment, font, border dan fill), kita juga dapat membuat table, dengan cara 

klik Menu bar pilih Insert dan klik Table, sedangkan untuk memodifikasi table 

nya pilih Styles.  

Microsoft Excel juga bisa untuk memfilter dan sort table. Di dalam program 

Microsoft Excel, kita dapat menerapkan formula dan fungsi, ada beberapa 

formula/fungsi di dalam Microsoft Excel seperti formula/fungsi dasar, 

formula/fungsi teks, formula/fungsi logika, formula/fungsi pencarian table. Di 

dalam Microsoft Excel juga memungkinkan untuk membuat grafik dan 

memformat grafik (axis title, chart title, data label, gridline, legend dan axis 

labels). Untuk mencetak di dalam program Microsoft Excel, pilih Pagesetup 

lalu klik Print. 
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G. Umpan Balik dan Tindak Lanjut 

1. Umpan Balik 

Setelah selesai mempelajari modul ini peserta diklat diharapkan dapat 

memiliki pengetahuan dan keterampilan mengenai Microsoft Excel, yang 

nantinya akan dapat diaplikasikan ke dalam pembelajaran lain seperti 

Administrasi Keuangan, Pengelolaan Kas Kecil, Akuntansi dan lain-lain. 

2. Tindak Lanjut 

Peserta diklat yang sudah kompeten pada materi Microsoft Excel ini dapat 

dibuktikan dengan bukti-bukti hasil diklatnya serta nilai yang kompeten. 

Peserta diklat yang kompeten dapat langsung melanjutkan ke materi 

berikutnya. 

Tetapi, jika belum kompeten pada materi Microsoft Excel maka peserta 

diklat dapat mengulangi dan berlatih kembali secara intensif dibawah 

bimbingan instruktur. 

H. Kunci Jawaban 

1. Microsoft Excel 2013 adalah  General Purpose Electronic 

Spreadsheet  yang dapat digunakan untuk mengorganisir, menghitung, 

menyediakan maupun  menganalisa  data-data  dan 

mempresentasikannya ke dalam bentuk grafik atau diagram. 

2. a. Row 

b. Quick access tool bar 

c. Tab worksheet 

3. Tahapan-tahapan membuat Workbook 

 Klik tab File.  

 Klik New. 

 Klik Blank Workbook 

4. Langkah-langkah menyisipkan kolom pada worksheet 

 Menyisipkan kolom 

 Klik kanan, lalu pilih Insert 

5. Langkah-langkah memformat cell alignment: 



 

 
 
 

58 Modul Paket Keahlian Administrasi Perkantoran - Sekolah Menengah Kejuruan (SMK) 

 

a. Blok sel yang akan di format 

b. Lalu klik kanan dan Format Cell 

c. Pada kotak dialog Format Cell, pilih sub alignment 

6. Langkah-langkah dalam membuat tabel 

 Blok data yang akan diberi table 

 Pada menu Insert, klik Table. Lalu klik Ok pada kotak Create Table 

7. Fungsi average adalah untuk mencari nilai rata-rata 

8. Langkah-langkah membuat grafik yaitu klik menu Insert, lalu pilih Charts 

9. Langkah-langkah print selection yaitu; 

a. Klik menu File 

b. Pilih Print 

c. Pada print setting pilih print selection 
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Kompetensi 
Profesional 

Kegiatan Pembelajaran 3: 

Mengoperasikan Microsoft 

PowerPoint 

 

A. Tujuan 

Setelah mempelajari modul Microsoft PowerPoint, peserta diklat diharapkan 

mampu untuk :  

1. Memahami pengertian Microsoft PowerPoint dengan baik 

2. Mengenal tampilan layar kerja Microsoft Power Point dengan baik 

3. Membuat dan mengatur presentasi secara terampil 

4. Memformat slide sesuai kebutuhan dengan penuh tanggung jawab 

5. Menguasai konfigurasi dan menampilkan slide secara terampil 

6. Menggunakan insert dan format slide sesuai kebutuhan dengan cermat 

7. Menggunakan format shapes sesuai kebutuhan dengan cermat 

8. Menyisipkan dan memformat table dengan teliti 

9. Menerapkan transitions dan animation sesuai kebutuhan dengan baik 

10. Mencetak dokumen dengan berbagi macam jenis printer dengan teliti 

B. Indikator Pencapaian Kompetensi 

Setelah mempelajari kegiatan belajar tiga dengan judul Mengoperasikan 

Microsoft PowerPoint, peserta diklat  diharapkan dapat : 

1. Menyebutkan pengertian Microsoft PowerPoint  

2. Mengidentifikasi tampilan layar kerja MS Power Point  

3. Melatih cara membuat dan mengatur presentasi sesuai dengan 

ketentuan 

4. Menjalankan cara memformat slide  

5. Melakukan kegiatan Konfigurasi dan menampilkan slide  

6. Menjalankan Insert dan format slide  

7. Mengoprasikan Insert dan format shapes  

8. Melakukan penyisipkan dan memformat table  

9. Menerapkan transitions dan animation pada slide 

10. Melakukan pencetakan slide  
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C. Uraian Materi 

1. Pengertian Microsoft Office PowerPoint 

Microsoft Powerpoint adalah salah satu program aplikasi microsoft office 

yang berguna untuk membuat presentasi dalam bentuk slide.  

Hadirnya Powerpoint menggantikan cara presentasi kuno yaitu dengan 

transparasi proyektor atau biasa disebut OHP (Over Head Proyector). 

Dengan adanya Ms Powerpoint, membuat presentasi menjadi sangat 

mudah karena didukung dengan fitur yang canggih dan menarik. Microsoft 

powerpoint juga menyediakan template untuk memperindah presentasi 

Anda. Berbagai macam template bisa Anda pilih di aplikasi Ms Powerpoint. 

2. Pengenalan Tampilan Layar Kerja Microsoft PowerPoint   

2.1 Pengenalan Pointer Pada Microsoft PowerPoint  

 Quick Acces 

 

 Title Bar 

 

 Ukuran Layar 

 

 Menu Bar 

 

 Tool Bar 

 

 Vertical dan Horizontal Scroll Bar 

      

 Status Bar 

 

 Notes dan Comments 
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 Tampilan Layar 

 

 Zoom 

 

2.2 Tampilan Layar Kerja Microsoft PowerPoint 

 

Gambar 17 Layar Kerja Ms PowerPoint 

3. Membuat dan Mengatur PowerPoint 

3.1 Membuat Slide  

a. Buka program Microsoft PowerPoint 2013 dengan cara klik Start 

> All Programs > Microsoft Office > Microsoft PowerPoint 

2013. Maka akan tampil template sebagai berikut. 

b. Klik Blank Presentation 

c. Bentuknya hampir sama dengan Microsoft 

Word, hanya saja pada area kerja terdiri 

dari text box yang nantinya bisa Anda isi 

dengan content presentasi Anda. Pada content presentasi 

terdapat beberapa menu pendukung untuk membantu pembuatan 

slide presentasi:  

 Insert Table 

 Insert Chart 

 Insert a SmartArt Graphic 

 Picture 

 Online Picture 

 Insert Video 
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3.3 Menyimpan PowerPoint 

 Pada menu File,,klik Save As (Ctrl + S) 

 Lalu klik Browse untuk menempatkan powerpoint yang Anda 

inginkan 

 Pada kotak isian, tulislah nama file yang akan Anda simpan 

 Klik Save 

3.4 Menutup PowerPoint 

 Pada menu ukuran layar, klik icon Close 

3.5 Menambahkan Slide 

 Klik menu Insert 

 Lalu pilih New Slide 

 Maka akan muncul slide baru dibawah slide pertama 

 

4. Memformat Presentasi 

4.1 Memodifikasi tema prentasi 

 Klik menu Design 

 Lalu pilihlah tema yang Anda inginkan 

4.2 Memodifikasi master slide 

Slide Master view adalah fitur khusus di PowerPoint yang 

memungkinkan Anda untuk dengan cepat mengubah slide dan layout 

slide dalam presentasi Anda. Dari sana, Anda dapat mengedit slide 

master, yang akan mempengaruhi setiap slide dalam presentasi.  

Anda juga dapat mengubah tata letak slide individu, yang akan 

mengubah tampilan slide dengan menggunakan layout tersebut. 

Misalnya, Anda menemukan tema yang Anda suka, tetapi Anda tidak 

menyukai tata letak slide. Anda bisa menggunakan tampilan Slide 

Master untuk menyesuaikan tata letak persis seperti yang Anda 

inginkan.  

a. Klik menu View, lalu pilih View Master 

 Modify Backgrounds: tampilan Slide Master membuatnya 

mudah untuk menyesuaikan latar belakang untuk semua 

slide Anda pada waktu yang sama. Misalnya, Anda bisa 

menambahkan watermark atau logo untuk setiap slide 
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dalam presentasi Anda, atau memodifikasi grafis latar 

belakang tema PowerPoint yang ada 

 Rearrange Placeholders: Jika Anda menemukan bahwa 

Anda sering mengatur ulang penampung pada setiap slide, 

Anda dapat menghemat waktu dengan menata ulang 

mereka dalam tampilan Slide Master sebagai gantinya. Bila 

Anda menyesuaikan salah satu layout dalam tampilan Slide 

Master, semua slide dengan layout yang akan berubah. 

 Customize Text Formatting: Daripada mengubah warna 

teks pada setiap slide individu , Anda bisa menggunakan 

slide master untuk mengubah warna teks pada semua slide 

sekaligus. 

 Create Unique Slide Layouts: Jika Anda ingin membuat 

presentasi yang terlihat berbeda dari tema biasa 

PowerPoint, Anda bisa menggunakan tampilan Slide Master 

untuk membuat layout Anda sendiri. Layout custom dapat 

menyertakan gambar Anda sendiri latar belakang, 

penampung, dan banyak lagi. 

5. Konfigurasi dan Menampilkan Slide 

5.1 Konfigurasi Custom Slide 

 Klik menu Slide Show 

 Pada grup Start Slide Show, pilih Custom Slide Show dan klik 

Custom Slide 

 Pada kotak Custom Show, klik New 

 Pada kotak isian Slide show name ketik “MO Ppt 2013” 

 Kemudian klik Add 

 Klik Ok dan klik Show 

5.2 Menampilkan Slide 

 Klik menu Slide Show 

 Pada menu Start Slide Show, klik From Beginning 

 Anda juga dapat langsung mengklik icon From Beginning pada 

Quick Access 
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6. Insert dan Format Slide 

6.1. Menyisipkan Slide 

a. Klik menu Insert 

b. Kemudian pilih Insert Slide 

c. Dari beberapa pilihan yang ada Anda dapat memilih salah satu 

darinya 

d. Anda juga dapat langsung mengklik kanan dan memilih New 

Slide 

6.2. Menghapus Slide 

a. Arahkan mouse pada slide yang akan dihapus 

b. Kemudian klik kanan dan pilih Delete Slide 

6.3. Menyembunyikan Slide 

a. Klik menu Slide Show 

b. Kemudian pada grup Set Up, klik Hide Slide  

c. Anda juga dapat langsung mengklik kanan dan pilih Hide Slide 

 

7. Insert dan Format Shapes 

7.1. Menyisipkan Shapes 

a. Klik menu Insert 

b. Kemudian pada grup Illustrations pilih Shapes 

c. Tempatkan shape ke tempat yang Anda inginkan 

7.2. Memodifikasi Shapes 

a. Klik shape yang akan dimodifikasi 

b. Theme Fills 

c. Shapes Fill 

d. Shapes Outline 

e. Shapes Effect 

 
8. Menyisipkan dan Memformat table 

8.1. Membuat Table 

a. Klik menu Insert 

b. Kemudian  klik Table 

c. Buatlah baris dan kolom sebanyak yang Anda butuhkan. Jika 

Anda membutuhkan lebih bisa dengan cara klik Insert Table 
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d. Anda juga dapat langsung mengklik Insert Table pada layar kerja 

slide 

8.2. Memformat Table 

a. Klik table yang akan diformat 

b. Klik menu  Design (Table Tool) 

c. Pada grup Table Style Anda dapat memilih gaya table yang 

Anda inginkan 

 
9. Menerapkan Transitions dan Animations 

9.1. Menerapkan Transisi Antar Slide 

a. Klik menu Transitions, untuk menambahkan efek translasi slide 

b. Lalu pilihlah tema yang Anda inginkan 

9.2. Menerapkan Animasi Antar Slide 

a. Klik menu Animations 

b. Lalu pilihlah animasi yang Anda inginkan 

9.3. Mengatur Waktu Transisi Dan Animasi 

 Mengatur Waktu Transisi 

Anda bisa berpindah dari slide satu ke slide lainnya di dalam 

presentasi menggunakan beberapa cara, seperti dengan cara klik 

atau menunggu setelah interval waktu tertentu. Tindakan manual 

dengan klik mouse memberikan Anda kontrol, tapi menjadikan 

tangan Anda sibuk ketika presentasi.   

Sedangkan fitur otomatis sangat berguna, misalnya ketika Anda 

menampilkan slide show pada situs. Jika Anda membutuhkan 

kombinasi metode tersebut di dalam presentasi, Anda bisa 

mengaturnya per slide dengan menggunakan tool yang ada pada 

tab Animations. Anda juga bisa menerapkan efek ke animasi slide 

untuk mengontrol arah transisinya. 

 Cara mengatur perpindahan slide: 

1. Tampilkan slide yang memiliki efek transisi. Pada Ribbon, 

klik tab Transitions. 

2. Agar perpindahan slide dilakukan secara manual, pada grup 

Timing, pilih check box On Mouse Click. 
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3. Kosongkan check box On Mouse Click agar perpindahan 

slide dilakukan secara otomatis mengikuti preset waktu 

tertentu.  

4. Gunakan kotak After untuk mengatur interval waktu. Ketika 

Anda menjalankan slide show, Anda akan berpindah dari 

slide satu ke slide berikutnya setelah slide pertama 

ditampilkan pada interval waktu tertentu. 

 

 Cara menerapkan efek transisi: 

1. Tampilkan slide yang memiliki efek transisi. pada Ribbon, 

klik tab Transitions. 

2. Pada grup Transition To This Slide, klik tombol Effect 

Options. 

3. Pada daftar drop-down yang ditampilkan, klik sebuah arah 

transisi untuk menerapkannya ke transisi slide. Preview 

transisi ditampilkan. 

 

 Mengatur Animasi 

Menerapkan animasi ke sebuah objek pada slide PowerPoint 

2013 dapat dimulai dari Clip Art, gambar, dan placeholder teks. 

Animasi memiliki efek yang membuat objek tampil-menghilang 

dari slide di Slide Show View tergantung dengan efek 

animasinya. Misalnya, Anda bisa memilih heading agar 

ditampilkan huruf-demi-huruf atau melayang di dalam slide 

Anda. Anda bisa menggunakan kategori animasi Motion Path 

untuk membuat objek ditampilkan lalu kemudian berpindah 

mengikuti path/jalur yang telah Anda tentukan pada slide Anda. 

 Cara menambahkan efek animasi pada sebuah objek: 

1. Klik pada sebuah objek atau placeholder teks untuk 

memilihnya. 

2. Klik tab Animations. 

3. Pada grup Advanced Animation, klik Add Animation. Galeri 

Animation ditampilkan. 
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Sumber : PanduanPraktek.com 

4. Klik pada sebuah efek di dalam galeri untuk 

menerapkannya. 

 

Sumber : PanduanPraktek.com 

 Cara mengatur animasi: 

1. Tampilkan slide yang memiliki objek yang memiliki efek 

animasi. 

2. Klik tab Animations. 

3. Pada grup Advanced Animation, klik tombol Animation Pane 

untuk menampilkan panel Animation. 

4. Pada panel Animation, klik tanda-panah di sisi kanan 

animasi yang ingin Anda ubah di dalam daftar. Menu 

pengaturan efek ditampilkan. 

5. Klik salah satu dari tiga pengaturan pertama pada menu 

tersebut untuk menentukan apakah efek dimainkan ketika 

Anda klik, bersama dengan animasi sebelumnya, atau 

setelah animasi sebelumnya. 

6. Klik perintah Effect Options pada menu tersebut untuk 

membuka kotak dialog efek yang Anda pilih. 

7. Pada tab Effect di kotak dialog, Anda bisa melakukan 

pengaturan tertentu tergantung dengan efek yang Anda 

pilih. Misalnya, jika efek Anda menganimasikan teks, daftar 

drop-down Animate Text memungkinkan Anda untuk 

memilih animasi per kata atau per huruf.  
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8. Klik tab Timing. Pilih pengaturan mulai, durasi, dan apakah 

efek akan diulang.  

9. Klik OK. 

10. Percetakan Slide 

10.1. Page Setup 

 

 Mengatur slide yang akan dicetak 

 Mengatur layout slide 

 Mencetak bentuk halaman slide 

 Mengatur pengelompokan slide 

 Mengatur warna cetakan slide 

10.2. Print 

 Klik menu File, lalu pilih Print 

 Tentukan jumlah kopian dan klik Print 

D. Aktivitas Pembelajaran 

1. Peserta diklat membaca dengan cermat isi modul 

2. Diskusi dengan sesama peserta diklat apa yang telah dicermati untuk 

mendapatkan pemahaman yang baik mengenai isi modul 

3. Apabila dalam berdiskusi peserta diklat masih mengalami kesulitan, maka 

diskusikan dengan instruktur 

4. Apabila isi modul terelah dipahami peserta diklat dapat mengerjakan 

latihan dan tugas praktek yang telah disediakan 

E. Latihan/Kasus/Tugas 

1. Latihan 

a. Sebutkan pengertian Microsoft PowerPoint? 

b. Apakah fungsi dari gambar dibawah ini? 
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c. Sebutkan langkah-langkah membuat slide presentasi? 

d. Sebutkan langkah-langkah menyembunyikan slide? 

e. Sebutkan langkah-langkah Konfigurasi Custom Slide? 

f. Sebutkan langkah-langkah untuk menambahkan slide presentasi? 

g. Sebutkan langkah-langkah menyisipkan shapes?  

h. Sebutkan langkah-langkah memformat table style? 

i. Sebutkan langkah-langkah membuat slide transitions dengan bentuk 

page curl? 

j. Sebutkan langkah-langkah mencetak slide pada power point dalam 

bentuk handout? 

 

2. Tugas 

PETUNJUK PENGERJAAN : 

a. Buatlah naskah presentasi sesuai dengan tema berikut ini pada 

komputer masing-masing! 

b. Bacalah ketentuan-ketentuan untuk pembuatan naskah presentasi! 

c. Selamat mengerjakan 

Slide Pertama 

 background, 

animasi, gambar, 

slide transition) 

Anjuran Menjaga Lingkungan 

Dipresentasikan Oleh : Nama Anda 

Slide Kedua 

 Isi menu 

presentasi dibuat 

Hyperlink 

 Gambar 

disesuaikan 

dengan kebutuhan 

 slide transition 

Menu Presentasi 

1. Judul 

2. Definisi Otomasi Perkantoran 

3. Macam-macam aplikasi otomasi 

kantor yang sering digunakan 

4. Manfaat mempelajari Otomasi 

Perkantoran 

5. Penutup 

Slide Ketiga 

 Tombol Hyperlink 

 Menu + Next 

Menyebutkan tentang  Otomasi 

Perkantoran 
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 Gambar macam-

macam komputer 

 Slide transition 

Slide Keempat 

 Tombol Hyperlink 

 Menu + Next 

 Gambar lambang-

lambang aplikasi 

otomatisasi 

 Slide transition 

Macam-macam aplikasi otomasi kantor 

yang sering digunakan  

Contoh : 

1. MS Word  

2. MS Excel 

3. dll 

Slide Kelima 

 Tombol Hyperlink 

 Menu + Next 

 Gambar  

 Slide transition 

Menyebutkan manfaat mempelajari 

Otomasi Perkantoran 

 

Slide Keenam 

 Tombol Hyperlink 

 Menu + Next 

 Gambar  

 Slide transition 

 Word Art 

Penutup 

Contoh: Terimakasih 

 

F. Rangkuman 

Microsoft PowerPoint adalah salah satu program aplikasi Microsoft Office yang 

berguna untuk membuat presentasi dalam bentuk slide. Aplikasi ini biasanya 

digunakan untuk keperluan presentasi, mengajar, dan untuk membuat animasi 

sederhana. Pengenalan tampilan  pada Microsoft Power Point, seperti quick 

access, toolbar, title bar, menu bar, ukuran layar, vertical dan horizontal scroll 

bar, status bar, notes dan comments, tampilan layar dan zoom. Untuk membuka 

program Microsoft PowerPoint pertama klik ‘Start’ lalu pilih ‘All Program’ ke 

‘Microsoft Office’ dan klik ‘Microsoft PowerPoint 2013, setelah muncul dan 

terbuka klik ‘blank presentation’.  
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Bentuk Microsoft Powerpoint hampir sama seperti Microsoft Word hanya saja 

terdapat text box yang nantinya bisa Anda isi dengan konten presentasi Anda. 

Sedangkan untuk menyimpan hasil presentasi pada Microsoft PowerPoint, 

pada menu File klik Save atau Save As (Ctrl + S). Jika ingin menambahkan 

slide baru pada slide yang sudah ada, klik ‘Insert’ lalu pilih ‘New Slide’.   

Di dalam Microsoft PowerPoint kita bisa memformat dan memodifikasi tema 

presentasi dan master slide. Terdapat juga fitur untuk mengkonfigurasi custom 

slide. Untuk menampilkan slide, klik Menu ‘Slide Show’, pada menu ‘Start Slide 

Show’ klik ‘From Beginning’. Dalam Microsoft PowerPoint juga kita bisa 

menambahkan Shapes dan Table. Klik menu ‘Transitions’ untuk menambah 

efek transisi pada slide dan klik menu ‘Animations’ untuk menambah efek 

animasi, pilih efek transisi dan animasi yang Anda inginkan. Sedangkan untuk 

mencetak pada Microsoft PowerPoint, atur Pagesetup dan kemudian Print. 

 

G. Umpan Balik dan Tindak Lanjut 

1. Umpan Balik 

Peserta diklat setelah selesai mempelajari kegiatan belajaar tiga 

diharapkan mampu membuat bahan-bahan presentasi dengan 

menggunakan Microsoft PowerPoint. Microsoft PowerPoint ini nantinya 

dapat diaplikasikan kedalam matapelajaran lainnya. 

2. Tindak Lanjut 

Peserta diklat yang sudah mampu menguasai kegiatan belajar tiga dapat 

melanjutkan kemateri berikutnya. Tetapi yang belum segera mengulangi 

materi Microsoft PowerPoint ini dengan bimbingan instruktur 

 

H. Kunci Jawaban 

1. Microsoft Powerpoint adalah salah satu program aplikasi microsoft office 

yang berguna untuk membuat presentasi dalam bentuk slide. Aplikasi ini 

biasanya digunakan untuk keperluan presentasi, mengajar, dan untuk 

membuat animasi sederhana. 

2. Fungsi dari gambar tersebut adalah sebagai Animations yaitu untuk 

perpindahan suatu objek dengan bentuk yang menarik. 
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3. Langkah-langkah membuat slide presentasi yaitu klik Start > All Programs 

> Microsoft Office > Microsoft PowerPoint 2013. Setelah muncul 

template yang ada Klik Blank Presentation. 

4. a. Klik menu Slide Show 

b. Kemudian pada grup Set Up, klik Hide Slide  

5. a. Klik menu Slide Show 

b. Pada grup Start Slide Show, pilih Custom Slide Show dan klik 

Custom Slide 

c. Pada kotak Custom Show, klik New 

d. Pada kotak isian Slide show name ketik nama slide 

e. Kemudian klik Add 

f. Klik Ok dan klik Show 

6. a. Klik menu Insert 

b. Kemudian pilih Insert Slide 

7. Langkah-langkah menyisipkan shapes 

a. Klik menu Insert 

b. Kemudian pada grup Illustrations pilih Shapes 

c. Tempatkan shape ke tempat yang Anda inginkan 

8. Langkah-langkah memformat table style 

a. Klik table yang akan diformat 

b. Klik menu Design (Table Tool) 

9. Langkah-langkah membuat Transitions bentuk Page Curl 

a. Klik menu Transitions 

b. Kemudian pilih Page Curl 

10. Langkah-langkah mencetak slide berbentuk handout 

 Klik menu File 

 Kemudian pilih Print 

 Pada grup page slide pilihlah handout 

 Tentukan jumlah handout yang dibutuhkan pada kolom Slide per Page 

 Pilih slide yang akan di print pada kolom Print Page 

 Setelah itu klik Ok 
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Kompetensi 
Profesional 

Kegiatan Pembelajaran 4:  

Mengoperasikan Microsoft 

Publisher 

 

A. Tujuan 

Setelah mempelajari kegiatan belajar empat dengan judul Mengoperasikan 

Microsoft Publisher, peserta diklat  diharapkan : 

1. Mengetahui pengertian Ms. Publisher dengan baik 

2. Mempraktekkan dasar Ms. Publisher dengan teliti 

3. Mengoprasikan objek dan kerangka sesuai kebutuhan dengan cermat 

4. Membuat teks pada publisher sesuai kebutuhan dengan penuh tanggung 

jawab 

5. Membuat gambar pada publisher dengan baik 

6. Mewarnai pada publisher design gallery sesuai keinginan dengan teliti 

7. Mengoprasikan graphics manager sesuai kebutuhan dengan teliti 

8. Mengecek mencetak dokumen dengan berbagai printer dengan teliti 

 

B. Indikator Pencapaian Kompetensi 

Setelah mempelajari kegiatan belajar empat dengan judul Mengoperasikan 

Microsoft Publisher, peserta diklat diharapkan : 

1. Menjelaskan dan mengenalan MS Publisher  

2. Melatih dasar MS Publisher  

3. Menjalankan objek dan kerangka MS Publisher  

4. Menerapkan teks pada MS Publisher  

5. Melatih gambar pada MS Publisher  

6. Menerapkan warna pada MS Publisher design gallery  

7. Mengoperasikan graphics  manager  

8. Melakukan cek akhir pada MS Publikasi 
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C. Uraian Materi 

1. Pengenalan Microsoft Publisher 2013 

1.1. Pengertian Microsoft Publisher 

Microsoft Publisher adalah salah satu program aplikasi Microsoft 

office yang digunakan untuk kegiatan desktop publishing. Hasil dari 

Desktop Publishing contohnya koran, katalog, brosur, majalah, 

kartu ucapan, poster, mading, kalender dan lain lain.  Dalam 

aplikasi Microsoft publisher, sudah tersedia berbagai macam 

template. Sehingga bila kita ingin membuat suatu karya, hanya 

tinggal memilih template yang sudah disediakan, lalu mengeditnya 

sesuai dengan kemauan kita. 

1.2. Cara membuka aplikasi Microsoft Office Publisher 2013:  

Buka program Microsoft Office Publisher 2013 dengan cara klik 

Start > All Programs > Microsoft Office > Microsoft Publisher 

2013 

 

2. Pelatihan Dasar Microsoft Publisher 2013 

2.1. Bekerja Dengan Halaman 

Salah satu elemen paling penting untuk membuat sebuah publikasi 

atau percetakan pada Publisher 2013 adalah halaman (page). 

Halaman pada Publisher tidak beda jauh dengan sebuah halaman 

pada dunia nyata. Hanya sebuah halaman dengan tulisan dan gambar. 

Ketika halaman tersebut dicetak, akan menjadi satu kesatuan utuh 

dalam satu halaman. 

a. Semisal Anda akan membuat kartu undangan, maka klik template 

Event Invitation Flyer 

 

Gambar 18. Event Invitation Flyer 

b. Kemudian klik Create 
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c. Untuk mengganti kalimat kartu undangan Anda dapat klik area 

tulisan dan hapus lalu ganti dengan kalimat baru sesuai kebutuhan.  

 

2.2. Pindah Dari Halaman Ke Halaman Lain 

Publisher membuat Anda dengan mudah memindahkan antar halaman, 

melihat halaman dengan berbagai sudut pandang, dan pembesaran yang 

berbeda, serta menambah atau menghapus halaman – halaman untuk 

memenuhi bidang kerja Anda. 

Halaman yang baru dibuka adalah halaman yang aktif, hanya satu halaman 

pada dokumen Anda yang aktif, walaupun Anda melihat lebih dari satu 

halaman pada saat yang sama. Halaman yang aktif dapat diindikasikan pada 

kontrol navigasi halaman, yang terdapat pada bagian kiri paling bawah dari 

jendela publisher. Halaman aktif ditandai dengan jendela abu- abu, halaman 

yang tidak aktif berwarna putih. Setelah memiliki lebih dari satu halaman pada 

bidang kerja, Anda dapat pindah ke halaman lain dengan beberapa cara 

sebagai berikut : 

a. Klik menu Home 

b. Pada menu Editting, klik Find 

c. Lalu klik Go To Page 

d. Kemudian ketikkan nomor halaman yang ingin Anda kerjakan 

dikotak dialog go to page dan klik Ok. Atau dengan cara tekan F5 

untuk membuka kotak dialog go to page 

 

2.3. Membuat Halaman Master 

Ketika membuat percetakan dengan banyak halaman, Anda mungkin 

ingin objek tertentu tampilpada mayoritas atau semua halaman. Objek 

ini dapat saja berupa judul publikasi, nama Anda, logo perusahaan dan 

lain-lain. Publisher membuat Anda dapat menciptakan sebuah 

halaman Master. Halaman Master merupakan sebuah halaman berisi 

objek/elemen yang nantinya akan tampil pada tiap halaman 

percetakan Anda. 

Agar dapat bekerja dengan halaman Master atau objek apapun yang 

berada dihalaman Master, kali pertama Anda harus memindahkan 

halaman depan. Untuk memindahkan halaman 

 Master klik menu View dan pilih Master Page atau tekan Ctrl+M  
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 Lalu klik Add Master Page 

 Maka akan muncul New Master Page, dan akan ada kotak 

description yang harus Anda isi 

 Kemudian klik Ok 

 

2.4. Bekerja Dengan Halaman Master   

Ketika Anda sedang mengerjakan sebuah publikasi, Publisher hanya 

membuat satu halaman Master, tapi terkadang Anda membutuhkan 

sedikit fleksibilitas. Contohnya, ketika Anda ingin membuat surat kabar 

yang mempunyai logo halaman Master yang sama didepan dan 

dibelakang halaman, tapi pada saat yang sama elemen halaman 

berbeda juga terdapat didalam halaman. Untuk itu, Anda 

membutuhkan lebih dari satu halaman Master. 

Untuk membuat halaman Master kedua, buka Master Page dengan 

menekan Ctrl+M. Kemudian pada panel kerja Edit Master Page Anda 

dapat membuat halaman Master baru. 

Pada panel Edit Master Pages, juga terdaftar jumlah halaman Master 

yang telah dibuat. Untuk membuat halaman Master baru, klik tombol 

New Master Page, kemudian klik Ok. 

 

2.5. Membuat Header dan Footer 

Untuk Publisher, sebuah header adalah kumpulan teks atau grafis atau 

elemen keduanya yang terus berulang dan terdapat pada bagian atas 

halaman. Hal ini berlaku juga pada footer, hanya saja footer terdapat 

dibawah halaman, untuk emmbuat headers  dan footees, ikuti langkah-

langkah dibawah ini: 

a. Klik menu Insert 

b. Kemudian pada grup Header & Footer 

c. Klik Header 

d. Pada kolom header isikan teks “ Microsoft Office Publisher” 

e. Klik toolbar Insert Page Number pada grup Header & Footer atau 

tekan Alt+Shift+P 

f. Klik tombol Close pada toolbar dan Footer 
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3. Objek Dan Kerangka 

3.1. Membuat Frame 

Untuk membuat frame (kerangka kerja), Anda harus memilih tool yang 

tepat. Tool dapat dipilih di toolbar Object, kemudian klik dan tarik (drag) 

tool yang diinginkan. Tool yang Anda pilih menentukan jenis frame 

yang akan dibuat. 

Ikuti langkah ini untuk membuat sebuah text box (kumpulan teks) atau 

picture frame (kumpulan gambar): 

a. Klik tool Text Box atau tool Picture Frame pada toolbar Object 

b. Pilih salah satu dari opsi dibawah ini: 

 Picture Frame: Anda dapat memilih gabar dari Clip Art Picture 

dari gile yang terdapat di komputer atau scanner dan kamera 

digital. Lepas tombol mouse untuk menciptakan frame. 

 Text Box atau Picture Frame menggunakan opsi Empty Picture 

Frame: jika kursor digerakkan akan mengubah posisi frame. 

 
Untuk membuat sebuah table, langkah-langkahnya hampir sama 

dengan membuat sebuah teks atau picture frame: 

a. Pilih jumlah kolom dan barisan yang Anda inginkan pada tabel 

(dapat dipilih melalui panel Create Table) 

b. Pilih format untuk tabel 

c. Klik tombol Ok 

 
Frame WordArt sedikit berbeda dengan text, picture, dan table box. 

Ketika Anda membuat sebuah frame untuk sebuah tipe objek, gallery 

WordArt secara otomatis akan terbuka: 

a. Klik menu Insert, lalu klik WordArt pada toolbar. Kemudian pilihlah 

tipe WirdArt sesuai dengan selera Anda. 

b. Ketik kata yang ingin Anda tampilkan pada panel Edit WordArt Text. 

c. Teruskan dengan format hasil tulisan dari WordArt itu. 
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3.2. Menambah Informasi Untuk Usaha Anda 

Untuk menambah informasi mengenai diri Anda, usaha atau organisasi 

Anda, Publisher memberikan fitur Business Information Sets. Setiap 

publikasi yang Anda buat memiliki Business Information Sets sendiri. 

Tiap Business Information Sets memiliki depalan komponen sebagai 

berikut: 

a. Nama individual 

b. Posisi pekerjaan atau jabatan 

c. Nama organisasi 

d. Alamat 

e. Motto atau Tagline 

f. Telepon, nomor faksimil, atau alamat email 

g. Logo 

h. Nama Business Information Set 

 

Untuk membuat sebuah Business Information yaitu dengan cara: 

a. Klik menu File, lalu pilih Edit Business Information 

b. Pada kotak dialog Create New Business Information Set isilah 

beberapa kotak isian yang ada sesuai dengan kebutuhan Anda. 

3.3. Memodifikasi Gambar 

Anda dapat membuat sebuah frame dan memasukan gambar 

didalamnya, atau Anda dapat membuat gambar tanpa harus 

menggunakan frame. 

Tool menggambar terdapat pada bagian bawah toolbar Object. Object 

diatur berdasarkan kategori yang berdapat pada tabel Desogn Gallery. 

Klik Mastheads untuk melihat berbagai macam tipe masthead. Klik 

Tables of Contents untuk melihat tipe-tipe table. 

3.4. Warna 

Warna merupakan salah satu komponen yang memiliki sisi teknis pada 

Publisher. Tint (mewarnai) dan Shape (bentuk) adalah perpaduan 

sebuah warna dengan warna putih. Sedangkan, pattern (susunan 

warna) menggunakan sebuah warna dasar untuk diaplikasikan pada 

garis-garis (lines), titik-titik (dots) dan warna background, biasanya 

hitam dan putih.  
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Gradient adalah efek di mana perpaduan lebih satu warna dapat 

menghasilkan efek warna khusus (dari gelap ke terang atau 

sebaliknya). Berbagai pilihan warna dapat dilihat melalui kotak dialog 

Colors.  

Berikut adalah beberapa pilihan warna yang dapat Anda dilihat melalui 

kotak dialog Colors: 

a. Font Color 

b. Shape Outline dan Shape Fill 

3.5. Membuat Teks Wrap Regular 

Membuat teks werp sangat mudah. Tempatkan saja salah satu tipe 

frame di atas sebuah text box, kemudian teks yang terdapat 

dibawahnya secara otomatis akan meng-wrap frame yang berada di 

atasnya.  

 

4. Teks Pada Microsoft Publisher 2013 

Mirosoft Publisher memiliki jenis frame: kumpulan teks (Text boxes) dan 

kerangka tabel (table frame). 

4.1. Mengenal Teks Boxes 

Jika Anda terbiasa membuat teks dengan menggunakan programa lain, 

meungkin heran mengetahui di Publisher 2013 Anda tidak dapat begitu 

saja mengetikkan sebuah kalimat. Anda harus membuat text box 

terlebih dahulu untuk mengetikkan sebuah kalimat. Caranya sangat 

mudah, klik tool text pada toolbox kemudian klik dan tarik untuk tool 

membuat sebuah text box. 

Setelah membuat text box, Anda dapat mengisinya dengan tiga cara, 

diantaranya; 

a. Mengetikkan teks langsung pada text box 

b. Paste teks dari Clipboard 

c. Import teks dari aplikasi word atau file teks 

4.2. Mengetik Teks 

Menggunakan aplikasi word membuat Anda terbiasa dengan berbagai 

hal yang berhubungan degnan teks. Tapi, ada pantangan tertentu 

mengenai teks yang tidak boleh dilakukan pada Publisher 2013. 
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a. Jangan tekan Enter untuk memaksa mengakhiri barisan atau 

kalimat. Menekan Enter membuat Publisher memberitahu bahwa 

Anda telah mencapai akhir sebuah paragraf. Jika Anda ingin 

memaksa line break tanpa membuat paragraf baru, tekanlah 

Shift+Enter. 

b. Jangan tekan Enter untuk membuat barisan kosong diantara 

paragraf. Klik menu Home, lalu klik panah pada menu Paragraph. 

Kemudian atur Line Spacing dikotak dialog Paragraph yang akan 

tampil. 

c. Jangan memasukkan jarak lebih dari satu diantara kalimat. 

Usahakan jarak antara kalimat hanya satu agar lebih mudah untuk 

dibaca. 

d. Jangan mengedit atau memformat teks sebelum selesai mengetik. 

Selesaikan dulu perkerjaan Anda, setelah itu mengedit dan terakhir 

adalah memformat. 

4.3. Import Texs 

Sebelum memilih Insert > Text file, Anda harus menyimpan teks Anda 

ke sebuah file dengan menggunakan format yang dimengerti oleh 

Publisher. Sekarang simpan file yang Anda ingin import dengan format 

yang bisa dibaca oleh Publisher. Untuk meng-import file teks ke 

Publisher, ikutilah langkah berikut ini: 

a. Lokasikan text box ke tempat di mana Anda ingin mengimport file 

teks dan posisikan insertion point ke dalam boks di tempat teks 

yang ingin Anda tampilkan. 

b. Klik menu Insert, lalu pilih Insert File 

c. Cari file yang Anda inginkan dan klik Ok 

 
Sebagai alternatif dengan menggunakan perintah menu, Anda dapat 

menampilkan context-sensitive menu dengan cara mengklik kanan 

text box > Change Text > Text file, kemudian kotak dialog Insert Text 

akan muncul.  

4.4. Exporting Texs 

Layaknya import teks, Publisher juga dapat export teks yang sama 

dengan mudah dan cepat. Anda dapat mentransfer teks yang dibuat 
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dengan aplikasi berbeda ke Publisher. Selain itu, Anda juga dapat 

mengiirm teks ke aplikasi selain Publisher agar program lain dapat 

membaca teks Anda. 

Publisher memberikan dua cara mudah untuk meng-export file teks 

Anda: 

a. Klik menu Edit > Copy untuk meng-copy file yang diinginkan ke 

Publisher menuju Windows Clipboard, kemudian ganti ke program 

Windows lain dan klik menu Edit > Paste untuk mem-paste-kan 

langsung file iu ke program yang bersangkutan. 

b. Klik menu File > Save As untuk mengirim semua file teks pada 

Publisher ke sebuah file teks atau file aplikasi word ke salah satu 

format yang dapat dibaca oleh Publisher. 

4.5. Teks Dengan Table Frames 

Table frames (kerangka tabel) berguna untuk membuat kolom dan 

garis-garis lebih tegas yang secara otomatis mengatur teks Anda 

dengan sempurna. 

Gambar tadi menunjukkan bagaimana table frame yang tidak di format 

terlihat. 

Berikut ini adalah beberapa hal penting yang harus diketahui tentang 

table frames: 

a. Seleksi sebuah table frames ditampilkan jika hanya frame yang 

diseleksi. 

b. Jika Anda ingin dapat mellihat garis-garis pada layar, klik menu 

View, lalu ceklis Boudaries dan Guides atau tekan Ctrl+Shift+O. 

c. Jika Anda memilih format tabel, elemen-elemen garis yang 

sepertinya tidak akan dicetak pada table frame, kemungkinan akan 

menjadi cell borders (batasan cell) yang dicetak. 

d. Jika memilih special characters pada publikasi Anda, tiap cell juga 

akan menampilkan tanda bahwa tulisan telah selesai. 

4.6. Memodifikasi Table 

Ketika sebuah tabel dipilih, menu perintah Table akan aktif. Menu ini, 

berisi perintah-perintah yang tepat Anda modifiaksi untuk tampilan 

tabel nantinya. Jika Anda memilih perintah Table AutoFormat, kotak 

dialog AutoFormat akan muncul. Perbedaan antara Table AutoFormat 
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dengan kotak books Create Table adalah Anda tidak dapat mengubah 

jumlah row atau cell, tapi Anda masih dapat mengatur beberapa pilihan 

format yang dipilih pada tabel. 

Walaupun mengaplikasikan format secara manuala dalah cara yang 

baik untuk membaut table frame And sesuai dengan yang diinginkan, 

tetapi terkadang hal tersebut cukup menyita waktu. Daripada harus 

menggunakan format manual, gunakan saja AutoFormat. Format 

otomatis ini bukan hanya menampilkan format karakter dan paragraf, 

tapi juga dapat menggabungkan cell dan cell border serta shading.  

4.7. Mengubah Table, Kolom dan Row 

Struktur dari table frame benar-benar berbeda dari sebuah text frame. 

Text frame merupakan sebuah bujur sangkar yang besar, dimana 

Anda menampatkan banyak teks. Sedangkan, table frame dibagi 

menajdi garis-garis dari kompartment teks yang terpisah (cell). 

a. Klik kanan lalu pilih Format Table 

b. Maka akan muncul kotak dialog Format Table seperti dibawah ini 

4.8. Menggabungkan dan Memisahkan Cell 

Anda mungkin ingin menggabungkan banyak cell agar menajdi suatu 

cell yang utuh. Berikut ini hal-hal yang perlu diperhatikan ketika 

menggabungkan cell: 

a. Untuk menggabungkan cell highlight semua cell yang ingin 

digabungkan, kemudian pilih Table > Merge Cells. 

b. Setelah menggabungkan cell, Anda dapat memisahkan cell 

tersebut menjadi cell yang berdiri sendiri. 

Tabel menu context-sensitive memiliki perintah-perintah untuk 

memasukkan dan menghapus row dan kolom serta untuk 

menggabungkan dan memisahkan cell. Setelah Anda mengklik kanan 

tabel, pilih Change Table untuk mengampilkannya.  

4.9. Bekerja Dengan Table Teks 

Layaknya dengan text boxes, Anda dapat mengisi table frame dengan 

cara mengetikkan teks langsung ke frame atau mengimport teks dari 

tempat lain. 

Terdapat satu perbedaan penting antara mengetik pada sebuah cell 

dan mengetik pada sebuah text box; ketika Anda kehabisan ruang 
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vertikal pada sebuah cell, Publisher secara otomatis meninggikan 

keseluruhan row dari cell tersebut untuk mengakomodasi garis 

tambahan pada teks. Jika suatu saat Anda menghilangkan atau 

mengurangi ukuran teks, Publisher secara otomatis mengurangi row 

tersebut.  

4.10. Import Table Text Frame 

Seperti yang bisa dilakukan dengan text boxes, Anda dapat mem-

paste atau insert sebuah file teks ke table frame. Jika table Anda 

diatur seperti spreadsheet atau table aplikasi word, Publisher 

kemudian akan meng-import di table frame tersebut.  

Beberapa hal yang harus diingat mengenai teks pada tabel: 

a. Jika teks yang telah dicopy diatur seperti tabel pada Publisher dan 

tabel yang sedang dibuat tidak memiliki cell yang cukup untuk 

mengakomodasi tiap cell yang dicopy, Publisher akan segera 

membuka kotak dialog yang menanyakan, apakah Publisher 

harus memasukkan kolom dan row. Klik Yes, untuk memastikan 

Anda mem-paste-kan semua teks. 

b. Jika Anda belum memilih table frame dan teks yang telah dicopy 

diatur layaknya table Publisher, Publisher akan membuat sebuah 

table frame baru dan menampatkan teks yang telah dicopy ke 

frame tersebut. 

c. Walapun sebuah table frame dapat terlihat seperti spreadsheet, 

Publisher tidak memiliki kemampuan untuk mengalkulasi angka. 

Jika Anda ingin mengalkulasi angka pada sebuah tabel, 

kalkulasikan angka tersebut pada aplikasi spreadsheet sebelum 

di-import ke Publisher. 

 

Berikut ini adalah beberapa cara tambahan untuk memilih teks 

table-frame:  

a. Memilih keseluruhan isi dari cell yang sedang dikerjakan: Pilih 

Table > Select Cell atau tekan Ctrl+A 

b. Memilih tiap cell pada kolom: Pilih Table > Select > Column 

c. Memilih tiap cell pada row: Pilih Table > Select > Row 



 

 
 
 

84 Modul Paket Keahlian Administrasi Perkantoran - Sekolah Menengah Kejuruan (SMK) 

 

d. Memilih banyak kolom atau row: Klik di bagian cell manapun 

dan tarik (drag) melewati row atau kolom yang ingin Anda pilih. 

Kemudian Table > Select > Row. Tahan tombol Shift apda 

keybard dan tekan tanda panah untuk memperluas bagian 

yang diseleksi. 

e. Memilih tiap cell pada sebuah table frame : Pilih Table > Select 

> table.  

4.11. Memindahkan dan Mengkopi Table Text 

Bekerja pada sebuah table frame melibatkan perbedaan yang 

penting. Bagaimanapun, ketika Anda meng-copy atau memindahkan 

isi dari banyak cell ke cell lain, Publisher asecara otomatis menimpa 

(overwrite) teks apapun pada cell yang bersangkutan.  

Untuk mempertahankan isi dari cell yang dituju, pastikan untuk 

memindahkan atau mengcopy isi hanya satu cell pada satu waktu. 

Jika Anda tanpa sengaja menimpa file text pada saat proses 

memindahkan atau mengcopy, segera pilih Edit > undo dari menu 

utama atau tekan Ctrl+Z.  Ikuti langkah berikut ini untuk memenuhi 

urutan cell atau row pada kolom : 

a. Pilihlah cell yang berisi teks dan ingin Anda copy, serta cell yang 

ingin Anda copy ke text. Untuk memenuhi perintah Fill, Anda harus 

memilih cell yang berdampingan pada cell yang berisi teks untuk 

dicopy. 

b. Pilihlah Table > Fill Down untuk mengcopy nilai pada cell paling 

atas ke cell yang telah dipilih di kolom bawahnya atau pilihlah 

Table > Fill Right untuk mengcopy nilai apda cell paling kiri ke cell 

yang telah dipilih di row sebelah kanan. 

4.12. Format Teks Secara Manual 

Anda dapat memformat teks table-frame secara manual untuk 

membuat informasi lebih mudah untuk dimengerti dan dibaca. Anda 

juga dapat menggunakan seluruh pilihan format karakter dan 

paragraf, mulai dari font, ukuran teks, efek untuk teks, line spacing, 

alignment, tab stop, indent, dan daftar bullet serta number. Bahkan 

Anda dapat menghyphenate teks table-frame. 



 

 
 
 

Otomasi Kantor | Dasar Pembelajaran yang Mendidik 85 

 

Untuk meningkatkan penampilan teks, Anda juga dapat mengubah 

cell margins, serta mengubah jarak antara isi cell dan bagian 

pinggirnya. 

Tab Cell Properties dibuat sedemikian rupa agar memenuhi semua 

fitur yang dibutuhkan dalam rangka mengedit teks serta tabel. Tab 

Cell Properties memiliki banyak pilihan, mulaid ari warna sampai 

dengan ukuran serta layout, jadi Anda tidak perlu berpindah-pindah 

tab untuk mengedit teks dan tabel. 

Untuk mengubah cell margins, pilih Format > Table dan klik Tab Cell 

Properties. 

 

5. Gambar Pada Microsoft Publisher 2013 

5.1. Mengenal Picture Frames, Publisher menggunakan picture frame 

(kerangka gambar) untuk menampilkan grafis atau gambat pada layout. 

Sebuah picture frame dapat berisi gambar ataupun foto. Anda tidak 

membuat gambar dalam picture frame, tapi gambar harus dibuat di luar 

picture frame. Gambar yang berisi picture frame dapat berupa file data 

atau objek OLE yang diatur oleh program lain. 

Objek Linking and Embedding (disingkat menjadi OLE) adalah sebuah 

teknologi berorientasi objek yang berbasiskan teknologi Component 

Object Model (COM) yang menyediakan layanan kepada aplikasi 

untuk menciptakan dokumen-dokumen yang terdiri dari banyak objek, 

mulai dari gambarm suara, hingga dokumen lainnya. 

Anda dapat membuat picture frame dengan dua cara, yaitu dapat 

menggambar sendiri atau biarkan prigram membuat gambar Anda 

dengan meng-insert atau meng-import gambar. 

5.2. Insert Atau Import Gambar 

Publisher memberikan cara mudah untuk Anda agar dapar 

memasukkan atau meng-import gambar dengan cepat:  

a. Copy gambar dari program windows lain ke windows clipboard dan 

kemudian paste gambar ke picture frame. 

b. Klik menu Insert, lalu pilih Online Picture terdapat ribuan koleksi 

gambar dari internet dan untuk membuka gambar yang sudah ada 

pada pc Anda dapat mengklik Work Offline 
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c. Klik menu Insert, lalu pilih Picture. Kemudian klik From File untuk 

meng-import gambar apapun yang telah disimpan dengan 

menggunakan format yang dapat dikenali oleh Publisher. 

d. Klik Insert, lalu pilih Form Scanner or Camera untuk scan hardcopy 

dari sebuah gambar atau capture gambar dari kamera digital. 

5.3. Menggunakan Panel Kerja Clip Art 

Anda dapat menggunakan panel kerja Clip Art untuk mencari clip art di 

hard drive lokal Anda, dijaringan lokal, atau melalui internet. Daripada 

menggunakan Insert lalu klik Online Picture dan pilih From File untuk 

memsukkan file clip art, yang mengharuskan Anda untuk mengingat 

nama dan likasi file dari gambar (file disimpan dalam folder Clip Art), 

klik saja thubnail gambar dipanel kerja Clip Art. 

Clip Art berisi koleksi gambar yang diberikan Microsoft dan telah 

diformat dengan file, gif, jpg, atau wmf (Windows metafile). Gile 

metafile membuat Anda dapat menyinpan file gambar pada file yang 

sama. 

Untuk memasukkan gambar dengan menggunkana panel kerja Clip Art 

adalah sebagi berikut: 

a. Jika Anda ingin Import gambar ke picture frame tertentu, select 

frame yang ingin Anda pilih. Anda juga dapat membuat sebuat 

picture frame koasong dengan cara memilih Insert > Picture > 

Empty Picture Frame 

b. Pilih Insert > Online Picture > Clip Art atau klik Picture Tool pada 

toolbar Object dan pilih Clip Art dari menu pop-up yang tampil. 

c. Pada kotak teks Search For, ketikkan kata-kata yang ingin Anda cari. 

Jika pencarian Anda tidak termasuk pencarian secara online, hasil 

pencarian hanya akan menampilkan hasil yang sedikit. 

d. Pilih koleksi clip art dari daftar Search In. Jika tidak yakin dengan 

koleksi gambar yang Anda cari, pilihlah Everywhere. Everywhere 

menghasilkan gambar slip art lebih banyak. 

e. Pada daftar Result Should Be, pilih jenis file media yang ingin Anda 

cari. Pilihannya beragam, seperti Clipart, Photograph, Movies, dan 

Sounds. 
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f. Pilih seperlunya pada thumbnail di panel utama dari panel kerja Clip 

Art kemudian pilihlah gambar yang Anda inginkan. 

g. Klik tanda panah ke bawah yang terletak pada sebelah gambar clip 

art utnuk melihat beberapa pilihan untuk bekerja pada clip art. 

Jika Anda membuat sebuat picture frame, sebelum Anda import 

gambar dari panel kerja Clip Art, Publisher secara otomatis akan 

mengoreksi ukuran gambar untuk membuat gambar yang 

dimasukkkan porsinya cocok dengan publikasi yang sedang Anda 

kerjakan. Setelah gambar dimasukkan ke dalam frame, Anda dapat 

memperbesar atau memperkecil sesuai dengan keinginan. 

5.4. Menggunakan Clip Organizer 

Tool Microsoft Clip Organizer telah diinstal di dalam Publlisher. Clip 

Organizer akan membantu mengklasifikasi koleksi clip art Anda. Dua 

koleksi clip art telah dibuat Publisher secara default, yaitu: 

a. My Collections: Menyimpan koleksi clip art buatan Anda 

b. Office Collections: Berisi koleksi clip art dan file media lainnya pada 

Office 2013 

5.5. Bekerja Dengan Tipe Gambar Berbeda 

Komputer menggunakan dua jenis grafis: gambar yang dibuat sendiri 

oleh pengguna dan gambar yang di import. Tipe-tipe gambar yang 

Anda gunakan menentukan karakteristik gambar yang ditampilkan 

pada layar monitor dan kualitas cetakan pada saat di print. 

Dua jenis gambar ini menggunakan format file berbeda dan 

membutuhkan dua program berbeda untuk membuat dan mengedit 

gambar. Bagusnya, Publisher dapat bekerja dalam dua jenis grafis ini, 

bahkan pada saat publikasi yang sama. 

5.6. Borders dan Border Art 

Anda dapat menambahkan bingkai atau frame dengan border dengan 

menggunakan tab Liner and Colors pada kotak dialog Format Picture 

atau pilihan More Lines pada menu pop-up yang timbul ketika Anda 

mengklik tombol Line/Border Style pada toolbar Picture. 

Ikutilah langkah berikut ini untuk mengaplikasikan Border/Art pada 

frame atau text box yang dipiilh. 

a. Klik menu Format, lalu klik Picture 
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b. Pada kotak dialog Format Picture, klik tab Colors and Lines 

c. Klik tombol BorderArt yang terletak di sisi Line dari tab Color and 

Lines. 

d. Buat seleksi dari daftar Available Border kemudian klik Ok. 

e. Atur ketebalan border BorderArt dengan mengubah setting Weight 

pada tab Colors and Lines yang ada pada kotak dialog Format 

Picture, kemudian klik Ok untuk kembali pada publikasi Anda. 

5.7. Menggambar Dengan Menggunakan Microsoft Paint 

Anda bisa saja membeli aplikasi editing gambar yang mahal sebagai 

pelengkap Microsoft Publisher 2013. Tapi, jika Anda memiliki anggaran 

terbatas, Anda masih dapat membuat gambaran format botmap 

menarik di Microsoft Paint. 

Microsoft Paint merupakan salah saatu aksesoris program yang telah 

diinstal pada oerating system windows XP dan Windows Vista. 

Untuk membuat objek Paint OLE pada Publisher, ikuti langkah berikut 

ini: 

a. Klik menu Insert, lalu klik toolbar Objek 

b. Klik tombol Create New, pilih Bitmap Image atau Paintbrush Picture 

dari kotak daftar Object Type, dan klik Ok. 

c. Buat gambar Anda dengan menggunakan berbagai macam tool 

pada toolbox di sebelah kiri layar Anda dan color palette yang 

terletak di bagian bawah. 

d. Setelah selesai, klik di luar frame untuk kembali ke Publisher. 

Hubungan antara objek gambar Anda dengan Mcrosoft Paint adalah 

satu kesatuan. Untuk mengedit gambar pada tempat yang sama, klik 

ganda saja gambar tersebut. Dikarenakan gambar tidak memiliki 

hubungan dengan aplikasi lain. Singkatnya, Anda tidak dapat 

membuka gambar tersebut dari Microsoft Paint. 

 

6. Warna Pada Microsoft Publisher 2013 Design Galery 

6.1. Membuat Warna Pada Dokumen Anda 

Apa yang Anda pilih; fotografi hitam putih atau fotografi warna? Film 

hitam putih atau warna? Mayoritas orang memilih warna, walaupun 

hitam putih memiliki nilai artistik tinggi. 
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Warna-warna menciptakan highlight, menambah semarak halaman 

pekerjaan Anda, dan menuntun mata ke arah yang menarik. Ketika 

warna kelihatan buruk, salah satu hal yang lebih menarik untuk dilihat 

Ikuti langkah berikut utnuk memahami warna dengan baik: 

a. Jangan berlebihan ketika menggunakan warna 

b. Pilih warna yang lebih menarik 

c. Lebih konsisten dalam menggunakan warna pada publikasi Anda. 

Gunakan warna yang sama untuk elemen halaman yang sama. 

d. Ciptakan skema warna. Satu paket warna mampu memproduksi 

warna terbaik. 

Dengan mengikuti sarana ini, diharapkan pembaca publikasi Anda 

tetap fokus pada sisi publikasi, tanpa harus diganggu dengan warna di 

sekeliling publikasi. 

6.2. Menentukan Warna 

Dari segi teknis, warna dapat disimpulkan sebagi reaksi dari receptor 

mata, syaraf-syaraf optis, dan otak manusia dalam menerima 

gelombang cahaya yang berbeda. Warna juga mempunyai kekuatan 

tertentu, ditentukan oleh gelombang. Jika warna tidak memiliki 

gelombang, yang timbul adalah hitam, dan Anda tidak mampu 

melihatnya. Jika gelombang hadir sangat tinggi, yang timbul hanyalah 

warna putih. 

Jika Anda menggabungkan suatu warna dengan hitam, hasilnya 

menjadi shade (berbayang/berbentuk). Jika Anda menggabungkan 

suatu warna dengan putih, hasilnya akan menjadi tint (warna tipis) 

6.3. Jenis-Jenis Warna 

Hampir semua orang mempunyai monitor warna. Sebuah monitor 

warna sangat membantu pekerjaan Anda untuk menghasilkan 

publikasi yang baik, yang mampu membuat orang yakin akan sesuatu 

yang Anda buat. Sangat penting untuk membuat monitor. Anda 

mampu menangani banyak warna. Untuk mengetahui apakah monitor 

Anda mampu menangani warna-warna, ikuti langkah berikut ini: 

a. Klik kanan desktop Anda, dan pilih Properties pada menu pop-up 

yang muncul 

b. Pada kotak dialog Display Properties, pilih tab Appearance 
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c. Pada kotak dialog Display Properties, pada tab Appearance, klik 

tombol Advanced 

d. Klik tombol color 1 

e. Setelah tombol color 1 Anda klik, akan tampil kotak sampel Color 

f. Pada kotak dialog sampel Color terdapat tombol Other klik tombol 

Other 

g. Setelah tombol Other diklik akan timbul kotak dialog Windows Color 

Setiap kali Anda pilih warna di program Windows, kotak dialog timbul 

untuk menunjukkan figur yang akan tampil. Untuk memilih warna pada 

kotak dialog Color, klik warna yang Anda inginkan atau drag lambang 

crosshair pada panel warna sebelah kanan sampai Anda menemukan 

warna yang cocok. 

Kapanpun ingin memilih warna, Anda dapat melihat nilai warna untuk 

warna hue (option Hue), dan saturasi (option Sat) sebagai tambahan 

untuk tiga nilai warna red, green, dan blue. 

Hue adalah nama warna, saturasi adalah intensitas warna dan nilai 

ketiga yang tidak berubah adalah luminosity atau lightness. 

6.4. Mengubah Skema Warna 

Skema warna adalah sekumpulan warna yang memiliki hubungan 

dengan percetakan. Publisher hadir dengan lebih dari 90 koordinasi 

warna. Untuk mengubah skema warna paling mudah adalah dengan 

mengandalkan panel Publisher Task. 

a. Jika panel Publisher Task tidak muncul, pilih View dan Task Pane 

dari menu utama atau tekan Ctrl+F1 utnuk menampilkannya. 

b. Klik menu Page design, pada grup Schemes Anda dapat memilih 

skema warna yang diinginkan. 

c. Jika tidak dapat menemukan warna yang cocok dari 90 skema 

warna, Anda dapat membuat warna sesuai dengan keinginan. Pada 

tab color Schemes pada panel kerja Format Publication, klik link 

Create New Color Schemes. 

d. Area Preview dan Sampel dapat memberikan Anda ide baru untuk 

membuat skema warna. Ketik nama di kotak teks Color Schemes 

Name dan klik tombol Save untuk menyimpan. 
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e. Setelah Anda menyimpan skema warna, skema warna Anda 

akan tampil pada daftar skema warna di panel kerja. 

 

7. Graphics Manager 

7.1. Mengakses Graphics Manager 

Anda dapat menggunakan panel kerja untuk melihat semua daftar 

gambar yang telah dipublikasi berdasarkan nama, halaman, jenis file, 

bahkan status gambar. Jika belum cukup, Anda dapat menggunakan 

tool Grapichs Manager untuk mengonversi link gambar ke gambar 

yang akan digunakan. Anda bahkan dapt menyimpan gambar yang 

sedang digunakan sebagi gambar yang di link terhubung dan 

kemudian menyimpannya sebagai file baru. 

Graphics Manager mempunyai peran yang besar pada kesuksesan 

publikasi Anda, tetapi tool ini tidak dapat melakukannya semua. Yang 

pasti, Graphics Manager tidak dapat menciptakan gambar untuk 

publikasi Anda. Jika Anda pernah menggunakan Publisher versi 

sebelumnya, pasti ingat Publishers sempat memiliki fitur yang 

bernama Microsoft PhotoDraw, yang sayangnya pada Publisher 2013 

fitur tersebut dihilangkan. 

Graphics Manager juga tidak mampu mengatur objek OLE karena 

objek OLE sekarang telah diatur melalui sebuah program yang 

terdapat di Publisher 2013. Selain tidak mendukung objek OLE, 

Graphics Manager juga tidak mendukung Auto Shapes, WordArt, 

BorderArt, dan masih banyak lagi. 

7.2. Panel Kerja Graphic Manager 

Membuat Graphics Manager aktif bukan hal yang sulit, ikuti langkah-

langkah berikut ini: 

a. Jika panel kerja Publisher tidak aktif, pilih View dan Task Panel dari 

menu utama atau tekan Ctrl+F1. 

b. Klik menu View, pada grup Show ceklis Graphics Manager 

c. Setelah panel kerja Graphics Manaher muncul, Anda dapat 

menyembunyikan dari sisi layar dengan cara memposisikan kursor 

berubah menjadi tanda panah empat jurusan, Anda dapat 
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menggeser panel kerja Graphics Manager ke manapun di bagian 

layar yang Anda inginkan. 

7.3. Embedding dan Linking Gambar 

Anda memiliki dua hal penting pada saat menaruh gambar pada 

publikasi; Embed gambar, dalam arti menaruh gambar merupakan 

bagian penting dari suatu publikasi dan link gambar, yang akan 

memberitahu Publisher dimana lokasi suatu file gambar berada dan 

bagaimana cara menampilkannya. 

Jika Anda mencetak dengan menggunakan printer profesional, 

gunakan link gambar. Printer nantinya jika dibutuhkan dapat mengedit 

gambar diluar Publisher jika dibutuhkan. 

Dan juga kemungkinan akan memutuskan menggunakan link gambar 

jika publikasi Anda benar-benar besar karena terdapat banyak gambar 

didalamnya. Jika publikasi Anda terlalu lambar bekerja atau 

menavigasikan gambar membuat komputer berjalan lambat, ganti 

embed gambar dengan link gambar. Untuk mengonvensi embed 

gambar ke gile link gambar, ikuti langkah berikut: 

a. Gunakan panel kerja Graphics Manger, navigasikan dan pilih file 

yang ingin Anda konversi menjadi link gambar 

 

b. Klik tanda panah ke bawah disebelah nama file dan pilih Save As 

Linked dari menu yang muncul. 

c. Dengan menggunakan daftar save-In, navigasikan ke folder di 

mana Anda ingin menyimpan gambar Anda. 

d. Ketikkan nama file yang Anda inginkan pada Field Name. 

e. Dari menu Save As, pilih format gambar sesuai dengan keinginan. 

 

f. Klik save 
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Jika Anda ingin mengubah link gambar menjadi embed gambar dan 

untuk mengonversi dari link gambar ke embed gambar, ikuti 

langkah berikut: 

a. Gunakan panel kerja Graphics Manager untuk bernavigasi dan 

memilih file yang ingin dikonversi ke ember file. 

b. Klik tanda panah ke bawah di samping nama file dan pilih 

Convert to Embedded Picture dari menu yang muncul. 

 

8. Cek Akhir Publikasi 

8.1. Design Checker 

Design Checker, sebuah tool di Publisher yang berguna untuk 

menemukan kesalahan-kesalahan yang terjadi pada publikasi Anda. 

Kesalahan yang biasa terjadi dan ditemukan oleh Design Checker 

adalah frame kosong objek yang tanpa sengaja ditutupi, teks yang 

melebihi batas, objek yang terdapat di area yang seharusnya tidak 

dicetak, dan jarak antarkalimat. 

Ikuti  langkah berikut untuk mengecek desain Anda dengan Design 

Checker: 

a. Klik menu File, pada menu utama klik Run Desgin Checker 

 

b. Perintahkan Design Checker untuk menjalankan desain yang ingin 

diperiksa pada checker box yang tersedia. 

 

c. Klik tanda panah ke bawah panel Select an Item to Fix untuk melihat 

pilihan perbaikan publikasi. 

d. Jika Anda ingin lebih banyak pilihan, klik Design Checker Options 

Link yang terdapat di panel kerja Design Checker. 

8.2. Printer dan Kualitas Cetak 

Kualitas cetakan ditentukan oleh engine printer (kualitas printer). 

Teorinya, kualitas cetakan dipastikan oleh jumlah titik per inci (dot per 
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inch) yang mampu diterjemahkan printer ke sebuah halaman. Tapi itu 

belum semua, ketebalan titik, peletakan titik pada kertas, dan ukuran 

titik dapat secara adramatis mengubah kualitas cetakan. 

Printer apapun yang Anda gunakan, menawarkan kemampuan 

berbeda-beda. Ketika mencetak melalui sebuah printer, Anda 

mengatur pilihan-pilihan hasil cetak pada kotak dialog Page Setup. 

Ikuti langkah berikut ini untuk memilih dan men-setup target printer: 

a. Klik menu File, lalu pilih Print 

b. Jika Anda tidak ingin menggunakan printer default, pilih salah satu 

dari daftar Printer Name pada kotak daftar. 

c. Setelah selesai mengatur printer kemudian klik Print 

 

D. Aktivitas Pembelajaran 

1. Peserta diklat membaca dengan cermat isi modul 

2. Diskusi dengan sesama peserta diklat apa yang telah dicermati untuk 

mendapatkan pemahaman yang baik mengenai isi modul 

3. Apabila dalam berdiskusi peserta diklat masih mengalami kesulitan, maka 

diskusikan dengan instruktur 

4. Apabila isi modul telah dipahami peserta diklat dapat mengerjakan latihan 

dan tugas praktek yang telah disediakan 

 

E. Latihan/Kasus/Tugas 

1. Latihan 

a. Sebutkan pengertian MS Publisher? 

b. Sebutkan langkah-langkah membuat kartu undangan? 

c. Sebutkan langkah-langkah membuat sebuah table? 

d. Sebutkan langkah-langkah meng-import file teks ke Publisher? 

e. Sebutkan empat cara mudah untuk Anda agar dapar memasukkan 

atau meng-import gambar dengan cepat? 

f. Sebutkan langkah-langkah untuk memahami warna dengan baik? 

g. Sebutkan langkah-langkah membuat Graphics Manager aktif? 
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h. Sebutkan langkah-langkah untuk mengecek desain Anda dengan 

Design Checker 

 

2. Tugas 

Buatlah kartu nama yang sama persis dengan soal berikut pada komputer 

masing-masing 

 

 

Keterangan: 

1. Font (Name) = Book Antique – 6 

2. Font (Divisi) = Book Antique – 5 

3. Font (Company) = Plantagenet Cherokee – 7 

4. Schemes = Aspect 

5. Size = Height (8,5cm) | Widht (5,4cm) 

 

F. Rangkuman 

Microsoft Publisher adalah salah satu program aplikasi Microsoft office yang 

digunakan untuk kegiatan desktop publishing. Cara membuka aplikasi 

Microsoft Office Publisher 2013 adalah Buka program Microsoft Office 
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Publisher 2013 dengan cara klik Start > All Programs > Microsoft Office > 

Microsoft Publisher 2013. 

Salah satu elemen paling penting untuk membuat sebuah publikasi atau 

percetakan pada Publisher 2013 adalah halaman (page). Publisher membuat 

Anda dengan mudah memindahkan antar halaman, melihat halaman dengan 

berbagai sudut pandang, dan pembesaran yang berbeda, serta menambah 

atau menghapus halaman – halaman untuk memenuhi bidang kerja Anda. 

Untuk membuat frame (kerangka kerja), Anda harus memilih tool yang tepat. 

Tool dapat dipilih di toolbar Object, kemudian klik dan tarik (drag) tool yang 

diinginkan. Tool yang Anda pilih menentukan jenis frame yang akan dibuat. 

Publisher memberikan fitur Business Information Sets. Setiap publikasi yang 

Anda buat memiliki Business Information Sets sendiri. 

Design Checker, sebuah tool di Publisher yang berguna untuk menemukan 

kesalahan-kesalahan yang terjadi pada publikasi Anda. Kesalahan yang biasa 

terjadi dan ditemukan oleh Design Checker adalah frame kosong objek yang 

tanpa sengaja ditutupi, teks yang melebihi batas, objek yang terdapat di are 

yang seharusnya tidak dicetak, dan jarak antarkalimat. Kualitas cetakan 

ditentukan oleh engine printer (kualitas printer). Printer apapun yang Anda 

gunakan, menawarkan kemampuan berbeda-beda. 

 

G. Umpan Balik dan Tindak Lanjut 

1. Umpan Balik 

Peserta diklat setelah selesai mempelajari kegiatan belajaar empat 

diharapkan mampu mengoperasikan MS Publisher untuk membuat brosur, 

sertifikat, kalender, dll.  

2. Tindak Lanjut 

Peserta diklat yang sudah mampu menguasai kegiatan belajar empat dapat 

melanjutkan kemateri berikutnya. Tetapi yang belum segera mengulangi 

materi MS Publisher ini dengan bimbingan instruktur. 
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H. Kunci Jawaban 

1. Microsoft Publisher adalah salah satu program aplikasi Microsoft office 

yang digunakan untuk kegiatan desktop publishing. 

2. Langkah-langkah membuat kartu undangan 

 klik template Event Invitation Flyer 

 Kemudian klik Create 

 Untuk mengganti kalimat kartu undangan Anda dapat klik area tulisan 

dan hapus lalu ganti dengan kalimat baru sesuai kebutuhan. 

3. Langkah-langkah membuat sebuah table 

 Pilih jumlah kolom dan barisan yang Anda inginkan pada tabel (dapat 

dipilih melalui panel Create Table) 

 Pilih format untuk tabel 

 Klik tombol Ok 

4. Langkah-langkah untuk meng-import file teks ke Publisher 

 Lokasikan text box ke tempat di mana Anda ingin mengimport file teks 

dan posisikan insertion point ke dalam boks di tempat teks yang ingin 

Anda tampilkan. 

 Klik menu Insert, lalu pilih Insert File 

 Cari file yang Anda inginkan dan klik Ok 

5. Empat cara mudah untuk Anda agar dapar memasukkan atau meng-

import gambar dengan cepat:  

 Copy gambar dari program windows lain ke windows clipboard dan 

kemudian paste gambar ke picture frame. 

 Klik menu Insert, lalu pilih Online Picture terdapat ribuan koleksi gambar 

dari internet dan untuk membuka gambar yang sudah ada pada pc Anda 

dapat mengklik Work Offline 

 Klik menu Insert, lalu pilih Picture. Kemudian klik From File untuk meng-

import gambar apapun yang telah disimpan dengan menggunakan 

format yang dapat dikenali oleh Publisher. 

 Klik Insert, lalu pilih Form Scanner or Camera untuk scan hardcopy dari 

sebuah gambar atau capture gambar dari kamera digital. 

6. Langkah-langkah untuk memahami warna dengan baik: 

 Jangan berlebihan ketika menggunakan warna 
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 Pilih warna yang lebih menarik 

 Lebih konsisten dalam menggunakan warna pada publikasi Anda 

 Gunakan warna yang sama untuk elemen halaman yang sama. 

 Ciptakan skema warna. Satu paket warna mampu memproduksi warna 

terbaik. 

7. Langkah-langkah membuat Graphics Manager aktif sebagai berikut ini: 

a. Jika panel kerja Publisher tidak aktif, pilih View dan Task Panel dari 

menu utama atau tekan Ctrl+F1. 

b. Klik menu View, pada grup Show ceklis Graphics Manager 

c. Setelah panel kerja Graphics Manaher muncul, Anda dapat 

menyembunyikan dari sisi layar dengan cara memposisikan kursor 

berubah menjadi tanda panah empat jurusan, Anda dapat menggeser 

panel kerja Graphics Manager ke manapun di bagian layar yang Anda 

inginkan. 

8. Langkah-langkah untuk mengecek desain Anda dengan Design Checker: 

 Klik menu File, pada menu utama klik Run Desgin Checker 

 Perintahkan Design Checker untuk menjalankan desain yang ingin 

diperiksa pada checker box yang tersedia. 

 Klik tanda panah ke bawah panel Select an Item to Fix untuk melihat 

pilihan perbaikan publikasi. 

 Jika Anda ingin lebih banyak pilihan, klik Design Checker Options Link 

yang terdapat di panel kerja Design Checker. 
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Kompetensi 
Profesional 

Kegiatan Pembelajaran 5: 

Mengoperasikan Surat 

Elektronik/E-mail 

 

A. Tujuan 

Setelah mempelajari kegiatan belajar lima dengan judul Mengoperasikan 

Surat Elektronik/E-mail, peserta diklat  diharapkan : 

1. Mengetahui pengertian email dengan baik 

2. Membuat email dari berbagai situs dengan penuh tanggung jawab 

3. Mengirim email kepada orang lain dengan santun 

4. Menggunakan attachment file sesuai kebutuhan dengan teliti 

 

B. Indikator Pencapaian Kompetensi 

Setelah selesai mempelajari kegiatan belajar lima yaitu mengoperasikan surat 

elektronik/ email, peserta diklat diharapkan dapat: 

1. Menjelaskan pengertian email  

2. Mengoprasikan cara membuat email  

3. Melatih cara mengirim email  

C. Uraian Materi 

1. Pengertian Email 

E-mail (electronic mail) adalah surat dalam bentuk elektronik. E-mail 

merupakan salah satu fasilitas atau aplikasi internet yang paling banyak 

digunakan dalam hal surat-menyurat. Menggunakan e-mail memungkinkan 

kita untuk mengirimkan pesan dalam bentuk surat ke seluruh dunia dalam 

waktu yang sangat cepat dan biaya yang murah. E-mail yang dikirimkan 

akan sampai ke alamat yang dituju sesaat e-mail tersebut dikirimkan. 
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2. Manfaat/kegunaan e-mail 

a. Media komunikasi, E-mail adalah media komunikasi yang biasa 

dilakukan secara persoal atau umum (komunitas). 

b. Media pengiriman, Dengan e-mail Anda bisa melakukan pengiriman 

data ke seluruh dunia dan tentunya pengirim dan yang dikirimi data 

sama-sama menggunakan alamat e-mail. Tidak hanya itu, dengan 

menggunakan e-mail Anda bisa mengirimkan data ke banyak orang 

hanya dalam hitung menit bahkan detik. 

c. Media promosi, Jika Anda bisa memiliki usaha di internet atau bisnis 

online, Anda bisa mengirimkan promosi produk ke para pelanggan 

Anda dengan memanfaatkan daftar e-mail pelanggan yang ada. 

d. Media informasi, Melalui e-mail, Anda bisa mendapatkan informasi-

informasi terbaru dari seluruh dunia yang Anda inginkan dengan cara 

menjadi pelanggan informasi dari media yang Anda tentukan. 

e. Membuat blog atau website, Dengan e-mail Anda bisa membuat blog 

dan website. 

f. Media Sosial, Dengan e-mail, Anda bisa menjalin hubungan dengan 

teman atau orang lain.  

 

3. Cara membuat Email 

3.1  Cara Membuat Email Menggunakan Gmail (Google) 

a. Langkah pertama, kunjungi situs Gmail.com 

b. Klik tombol “Create an account” atau “Buat akun”  

c. Isi kolom-kolom yang ada pada halaman pengisian dengan data 

Anda: 

 Nama: isi nama lengkap Anda, nama depan dan nama belakang 

 Pilih nama pengguna Anda: isi alamat email yang Anda inginkan 

 Buat sandi: buat sandi yang tidak mudah ditebak, tapi mudah 

Anda ingat 

 Konfirmasi sandi Anda: ulangi memasukkan sandi Anda 

sebelumnya 

 Tanggal lahir: isi dengan tanggal, bulan, dan tahun kelahiran 

Anda 



 

 
 
 

Otomasi Kantor | Dasar Pembelajaran yang Mendidik 101 

 

 Gender: pilih yang sesuai dengan jenis kelamin Anda 

 Ponsel: isi dengan nomor HP Anda untuk keamanan 

 Buktikan bahwa Anda bukan robot: isi dengan kode (2 kata 

dengan spasi) yang ada di halaman tersebut 

 Lokasi: isi tempat Anda tinggal 

 Centang kolom menyetujui persyaratan dan kebijakan dari 

Google 

 Klik tombol “Langkah berikutnya” 

d. Langkah selanjutnya adalah menyiapkan profil dengan 

menambahkan foto profile Anda. Untuk menambahkan foto, 

silahkan klik tombol “Tambahkan Foto Profil”. Setelah selesai 

mengatur foto profil, klik tombol “Langkah berikutnya”. 

e. Voila, akun email di Google sudah selesai dibuat. Silahkan klik 

tombol “Lanjutkan ke Gmail” untuk masuk ke halaman email Anda. 

3.2  Cara Membuat Email Menggunakan Yahoo 

a. Langkah pertama, kunjungi situs Yahoo.com  

b. Klik tombol “Buat Account Baru” di bagian atas kanan halaman 

Yahoo mail. 

c. Isi kolom-kolom yang disediakan dengan memasukkan data Anda: 

 Nama:  isi dengan nama lengkap Anda, nama depan dan 

nama belakang 

 Pilih ID Yahoo!: pilih alamat email yang Anda inginkan di 

Yahoo 

 Pilih kata sandi: isi dengan sandi yang Anda inginkan dan 

mudah diingat 

 Ketik ulang kata sandi: masukkan lagi sandi Anda 

 Saya lahir pada:  isi dengan tanggal, bulan, dan tahun 

kelahiran Anda 

 Saya tinggal di: pilih negara dimana Anda tinggal 

 Ponsel: isi dengan nomor HP Anda, untuk keamanan 

 Email Alternatif: isi bila Anda punya email lain, kosongkan bila 

memang tidak ada 

 Klik tombol “Buat akun saya” 
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d. Langkah selanjutnya adalah mengisi pertanyaan rahasia, ini 

dibutuhkan untuk menjaga keamanan akun email Yahoo Anda. 

Setelah selesai mengisi kolom-kolom yang disediakan, klik tombol 

“Selesai”. 

e. Voila, email Anda di Yahoo sudah selesai dibuat. Langkah 

selanjutnya Anda bisa klik tombol “Persiapan Awal” untuk masuk 

ke halaman email Anda. 

4. Membuka email (Login) 

Sebelum Anda masuk kedalam fasilitas email untuk berkirim pesan terlebih 

dulu Anda harus login dengan mengisi User ID dan  password Anda seperti 

pada kotak dialog dibawah ini, kemudian klik tombol Sign In. 

5. Mengirim email 

Cara-cara mengirim email 

a. Klik tombol Tulis atau Write 

b. Kemudian isi beberapa kolom seperti: 

a. Penerima: untuk memasukkan email yang akan dituju 

b. Subjek: untuk perihal pesan 

c. Kotak Pesan: untuk isi pesan 

d. Klik Kirim atau Send maka akan muncul tampilan bahwa email / pesan 

Anda telah dikirim.  

6. Attachment file 

Attachment adalah perintah mengirim file melalui email. Kadang saat kita 

mengirimkan surat kita ingin mengikutkan lampiran surat yang lain 

sehingga surat yang kita buat menjadi lebih lengkap tetapi tidak terlalu 

panjang. misalnya: document word ataupun power point. 

Cara-cara melampirkan dokumen atau Attachment file: 

a. Klik icon Attact yang berbentuk clip 

b. Setelah muncul box File Upload klik file yang akan dipilih dan klik Ok 

c. Tunggu hingga loading upload selesai kemudian klik Kirim 

7. Membaca email 

Untuk dapat membaca email yang masuk Anda tinggal mengklik pada 

inbox atau kotak masuk yang ada pada fasilitas email Anda. 
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8. Menghapus email 

Untuk menghapus email yang masuk pada kotak surat atau inbox pertama 

yang harus Anda lakukan adalah membuka inbox, kemudian berilah tanda 

centang lalu klik delete atau tombol hapus. 

9. Keluar dari email (Logout) 

Jika Anda telah selesai menggunakan fasilitas email untuk keperluan 

membaca informasi surat masuk atau kirim email keluar Anda harus 

melakukan logout/ keluar dari program email. 

 

D. Aktivitas Pembelajaran 

1. Peserta diklat membaca modul kegiatan belajar lima  

2. Peserta diklat mempraktekkan cara mengoperasikan E-mail sesuai isi dari 

modul 

3. Setelah memahami materi kegiatan belajar lima, peserta diklat 

mengerjakan latihan yang terdapat dalam kegiatan belajar lima. 

 

E. Latihan/Kasus/Tugas 

1. Latihan 

a. Jelaskan pengertian email! 

b. Sebutkan langkah-langkah membuat email? 

c. Sebutkan langkah-langkah mengirim email dengan melampirkan file? 

 

2. Tugas 

a. Lakukan pendaftaran Email baru untuk Anda melalui yahoo.co.id atau 

Gmail.com, jika Anda sudah mempuyai email address, lakukan 

pengeditan/pembaharuan untuk pasword Anda. 

b. Masuklah pada login E-mail yang Anda miliki dengan masuk pada User 

Id dan memasukkan ode pasword Anda, lakukan cek apakah ada email 

baru yang belum terbaca, apa isisnya. 

c. Tulislah surat baru yang berisi kabar Anda dan kirimlah E-mail tersebut 

kepada teman lain yang Anda ketahui email addresnys 
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d. Bacalah Email yang Anda terima melalui klik pada kotak masuk (inbox), 

bila perlu Anda cetak 

e. Hapuslah salah satu atau beberapa email yang sudah tidak diperlukan 

lagi 

f. Lakukan proses keluar dari kegiatan Email dengan cara Logout dan 

lakukan close aktifitas.  

F. Rangkuman 

E-mail (electronic mail) adalah surat dalam bentuk elektronik. E-mail 

merupakan salah satu fasilitas atau aplikasi internet yang paling banyak 

digunakan dalam hal surat-menyurat. Hal ini dikarenakan e-mail merupakan 

alat komunikasi yang murah, cepat, dan efisien. Menggunakan e-mail 

memungkinkan kita untuk mengirimkan pesan dalam bentuk surat ke seluruh 

dunia dalam waktu yang sangat cepat dan biaya yang murah. E-mail yang 

dikirimkan akan sampai ke alamat yang dituju sesaat e-mail tersebut 

dikirimkan. Biaya yang dikeluarkan pun hanyalah biaya untuk mengakses 

internet pada saat kita mengirimkan/membuka untuk menerima e-mail 

tersebut. Email juga memiliki beberapa manfaat dan kegunaan, diantara lain 

sebagai media komunikasi, media pengiriman, media promosi, media  

informasi, membuat blog atau website, dan untuk sosial media. Menggunakan 

email juga lebih efektif, efisien, dan murah. Untuk membuat email, mengirim 

email dan mengirimkan lampiran dalam email juga sangatlah mudah. Kita 

hanya tinggal mengikuti cara yang sudah dijelaskan di bagian Uraian Materi 

di atas.  

 

G. Umpan Balik dan Tindak Lanjut 

1. Umpan Balik 

Setelah selesai mempelajari kegiatan belajar lima, peserta diklat 

diharapkan dapat mengoprasikan email dengan lancar. Sehingga dapat 

diaplikasikan untuk mengirim berbagai macam surat dan dokumen kepada 

pihak lain yang membutuhkan. Selain itu dapat di ajarkan kepada 

siswa/siswinya dalam pelajaran korespondensi dll. 
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2. Tindak lanjut  

Peserta diklat yang sudah dapat menyelesaikan kegiatan belajar lima, 

dapat melanjutkan pada kegiatan belajar berikutnya. 

 

H. Kunci Jawaban 

Latihan 

1. E-mail (electronic mail) adalah surat dalam bentuk elektronik. E-mail 

merupakan salah satu fasilitas atau aplikasi internet yang paling banyak 

digunakan dalam hal surat-menyurat. Hal ini dikarenakan e-mail 

merupakan alat komunikasi yang murah, cepat, dan efisien. 

2. Langkah-langkah membuat email: 

a. Kunjungi situs email 

b. Klik tombol buat akun  

c. Isi kolom-kolom yang ada halaman pengisian dengan data 

d. Langkah selanjutnya siapkan profil dengan menambahkan foto profil 

e. Klik tombol Langkah selanjutnya untuk ke halaman email 

3. Langkah-langkah mengirim email dan melampirkan file; 

a. Klik tombol tulis atau write 

b. Kemudian isi beberapa kolom seperti penerima, subjek, kotak pesan 

c. Untuk melampirkan file klik ikon Attact yang berbentuk clip 

d. kemudian setelah muncul box File Upload klik file yang akan dipilih dan 

klik Ok 

e. Tunggu hingga loading upload selesai kemudian klik Kirim 
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Kompetensi 
Profesional 

Kegiatan Pembelajaran 6:  

Mengelola Blog 

 

 

A. Tujuan 

Setelah mempelajari kegiatan belajar enam dengan judul Mengelola Blog, 

peserta diklat  diharapkan : 

1. Menyebutkan pengertian blog dengan baik 

2. Membuat blog sesuai tahap-tahapannya dengan baik 

3. Mengisi dan menulis artikel di blog dengan penuh tanggung jawab 

 

B. Indikator Pencapaian Kompetensi 

Setelah selesai mempelajari modul ini, peserta diklat diharapkan dapat : 

1. Menjelaskan pengertian blog  

2. Melatih cara membuat blog  

3. Melakukan pengisian dan penulisan artikel di blog  

 

C. Uraian Materi 

1. Pengertian blog 

Blog merupakan singkatan dari web log adalah bentuk aplikasi web yang 

berbentuk tulisan-tulisan (yang dimuat sebagai posting) pada sebuah 

halaman web. Blog mempunyai fungsi yang sangat beragam, mulai dari 

sebuah catatan harian, media publikasi dalam sebuah kampanye politik, 

sampai dengan program-program media dan perusahaan-perusahaan. 

Sebagian blog dipelihara oleh seorang penulis tunggal, sementara 

sebagian lainnya oleh beberapa penulis. Banyak juga blog yang memiliki 

fasilitas interaksi dengan para pengunjungnya, seperti menggunakan 

buku tamu dan kolom komentar yang dapat memperkenankan 
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pengunjungnya untuk meninggalkan komentar atas isi dari tulisan yang 

dipublikasikan, namun demikian ada juga blog yang bersifat sebaliknya 

(non-interaktif).  

Beberapa jenis Blog : 

a. Blog politik: Tentang berita, politik, aktivis, dan semua persoalan 

berbasis blog (Seperti kampanye). 

b. Blog pribadi: Disebut juga buku harian online yang berisikan tentang 

pengalaman keseharian seseorang. 

c. Blog bertopik: Blog yang membahas tentang sesuatu. 

d. Blog kesehatan: Blog keterangan-ketarangan tentang kesehatan, 

dll. 

e. Blog sastra: Lebih dikenal sebagai litblog (Literary blog). 

f. Blog perjalanan: Menceritakan keterangan-keterangan tentang 

perjalanan/traveling. 

g. Blog mode: Lebih dikenal dengan "fashion blog". Isinya seputar 

gaya, perkembangan mode, selera fashion, liputan pameran mode, 

dan lain-lain. 

h. Blog riset: Persoalan tentang akademis seperti berita riset terbaru. 

i. Blog hukum: Persoalan tentang hukum disebut juga dengan blawgs 

(Blog Laws). 

j. Blog media: Berfokus pada bahasan berbagai macam informasi 

k. Blog agama: Membahas tentang agama 

l. Blog pendidikan: Biasanya ditulis oleh pelajar atau guru. 

m. Blog kebersamaan: Topik lebih spesifik ditulis oleh kelompok 

tertentu. 

n. Blog petunjuk (directory): Berisi ratusan link halaman website. 

o. Blog bisnis: Digunakan untuk kegiatan promosi bisnis mereka 

p. Blog pengejawantahan: Fokus tentang objek di luar manusia 

q. Blog pengganggu (spam): Digunakan untuk promosi bisnis affiliate; 

juga dikenal sebagai splogs (Spam Blog) 

r. Blog virus (virus): Digunakan untuk merusak. 
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2. Cara Membuat blog 

a. Buka situs web www.blogger.com 

b. Untuk membuat blog Anda harus memiliki akun google atau gmail. 

c. Masukan akun Gmail dan password ke kolom yang tersedia, lalu 

klik tombol “Masuk” atau “Sign In” 

d. Anda akan menemukan tombol “Blog Baru”, Anda klik tombol 

tersebut untuk membuat blog baru, kemudian Anda akan 

menemukan beberapa kolom - kolom yang harus Anda isi, 

diantaranya: 

a. Kolom Judul: berfungsi untuk menamai blog yang Anda buat 

b. Kolom Alamat: berfungsi untuk menamai Alamat blog Anda 

e. Pilih Template: sesuai dengan selera Anda, biasanya blogger 

sendiri sudah menyediakan beberapa pilihan tampilan standart. 

Tetapi apabila Anda berkeinginan merubah sendiri tampilan blog 

Anda bisa nanti dirubah pada menu Edit Template 

f. Step berikutnya adalah mengklik tombol “Buat blog!”, blog telah 

dibuat 

3. Mengisi dan menulis artikel di blog 

a. Judul Artikel: jangan menggunakan judul artikel yang terlalu 

panjang karena blooger membatasi panjang karakter untuk judul 

artikel Anda. 

b. Anda dapat memasukan artikel kedalam kolom kontent yang sudah 

tersedia. dan kontent yang bisa Anda masukan berbentuk text, 

images, dan juga video. 

c. Pada kolom artikel juga sudah disediakan beberapa fasilitas untuk 

mengatur format text, menambah link, dan lain sebagainya, dan 

biasnya terletak dibawah judul kontent. 

d. Label, pengisian label bisa digunakan untuk memilah-milah artikel 

yang nantinya juga difungsikan sebagai kategori pada blog Anda.  

e. Penjadwalan Posting, Fitur untuk menjadwalkan kapan artikel 

tersebut dipublikasikan tentunya sesuai dengan keinginan Anda. 

Anda juga bisa menambahkan lokasi dimana artikel itu dibuat. 

http://www.blogger.com/
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f. Setelah semuanya sudah selesai, Anda bisa mengklik tombol 

"Publikasikan" dan Anda akan menemukan kontent yang telah 

dibuat sudah online dan dapat dibaca oleh pengunjung blog Anda. 

 

D. Aktivitas Pembelajaran 

1. Peserta diklat membaca modul untuk pembelajaran enam yaitu 

mengelola blog dan memahaminya  

2. Peserta diklat mempraktekan: 

 Membuat blog sesuai tahap-tahapannya dengan baik 

 Mengeisi dan menulis artikel di blog dengan penuh tanggung jawab 

 

E. Latihan/Kasus/Tugas 

1. Latihan 

a. Sebutkan pengertian blog? 

b. Sebutkan tahapan-tahapan membuat blog? 

c. Sebutkan cara menulis artikel pada sebuah blog 

 

2. Tugas 

Buatlah blog sederhana lalu isilah dengan materi yang anda kuasai 

F. Rangkuman 

Blog merupakan singkatan dari web log adalah bentuk aplikasi web yang 

berbentuk tulisan-tulisan (yang dimuat sebagai posting) pada sebuah halaman 

web. Blog mempunyai fungsi yang sangat beragam, mulai dari sebuah catatan 

harian, media publikasi dalam sebuah kampanye politik, sampai dengan 

program-program media dan perusahaan-perusahaan. 

Beberapa jenis Blog adalah: 

1. Blog politik 

2. Blog pribadi 

3. Blog bertopik 

5. Blog sastra 

6. Blog mode 

7. Blog riset 
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4. Blog kesehatan 

 

8. Blog hukum 

9. Dll 

 

Cara Membuat blog adalah: 

 Buka situs web www.blogger.com 

 Kemudia Anda akan menemukan tampilan login dan memasukan akun 

google, untuk membuat blog Anda harus memiliki akun google atau gmail. 

 Masukan akun Gmail dan password ke kolom yang tersedia, lalu Anda klik 

tombol “Masuk” atau “Sign In” 

 Anda akan menemukan tombol “Blog Baru” , Anda klik tombol tersebut 

untuk membuat blog baru, biasanya tombol ini terletak sebelah kiri atas 

pada tampilan halaman tersebut, kemudian Anda akan menemukan 

beberapa kolom - kolom yang harus Anda isi, diantaranya: 

 Kolom Judul: Kolom judul berfungsi untuk menamai blog yang Anda buat 

 Kolom Alamat: Kolom ini berfungsi untuk menamai Alamat blog Anda, 

tentunya sesuai dengan keinginan Anda, perlu diingat bahwa alamat blog 

yang sudah dibuat oleh pengguna lainya tidak bisa didaftarkan ulang, jadi 

Anda harus mencari alternatif lainya 

 Pilih Template: Pilihlah template sesuai dengan selera dari Anda, biasanya 

blogger sendiri sudah menyediakan beberapa pilihan tampilan standart. 

Tetapi apabila Anda berkeinginan merubah sendiri tampilan blog Anda bisa 

nanti dirubah pada menu Edit Template 

o Step berikutnya adalah mengklik tombol “Buat blog!” 

o Lalu blog Anda telah dibuat 

 

G. Umpan Balik dan Tindak Lanjut 

1. Umpan Balik 

Setelah peserta diklat mempelajari kegiatan belajar enam, peserta diklat 

diharapkan dapat membuat blog sederhana. Blog tersebut nantinya dapat 

dimanfaatkan oleh peserta diklat untuk memposting materi-materi 

pembelajaran yang akan sangat berguna bagi pihak lain yang 

membutuhkan. 

http://www.blogger.com/
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2. Tindak lanjut  

Setelah selesai mempelajari kegiatan belajarl enam dan peserta diklat 

mampu menguasai dan mengerjakan soal-saol latihan tanpa melihat 

kunci jawaban, peserta diklat dapat melanjutkan pada kegiatan belajar 

tujuh. Tetapi apabila belum menguasai maka peserta diklat diharapkan 

untuk mempelajari kembali dengan bantuan instruktur secara berkala. 

 

H. Kunci Jawaban 

1. Blog merupakan singkatan dari web log adalah bentuk aplikasi web yang 

berbentuk tulisan-tulisan (yang dimuat sebagai posting) pada sebuah 

halaman web. 

2. Cara Membuat blog adalah: 

 Buka situs web www.blogger.com 

 Kemudia Anda akan menemukan tampilan login dan memasukan akun 

google, untuk membuat blog Anda harus memiliki akun google atau 

gmail. 

 Masukan akun Gmail dan password ke kolom yang tersedia, lalu Anda 

klik tombol “Masuk” atau “Sign In” 

 Anda akan menemukan tombol “Blog Baru” , Anda klik tombol 

tersebut untuk membuat blog baru, biasanya tombol ini terletak 

sebelah kiri atas pada tampilan halaman tersebut, kemudian Anda 

akan menemukan beberapa kolom - kolom yang harus Anda isi, 

diantaranya: 

 Kolom Judul: Kolom judul berfungsi untuk menamai blog yang Anda 

buat 

 Kolom Alamat: Kolom ini berfungsi untuk menamai Alamat blog Anda, 

tentunya sesuai dengan keinginan Anda, perlu diingat bahwa alamat 

blog yang sudah dibuat oleh pengguna lainya tidak bisa didaftarkan 

ulang, jadi Anda harus mencari alternatif lainya 

 Pilih Template: Pilihlah template sesuai dengan selera dari Anda, 

biasanya blogger sendiri sudah menyediakan beberapa pilihan 

http://www.blogger.com/
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tampilan standart. Tetapi apabila Anda berkeinginan merubah sendiri 

tampilan blog Anda bisa nanti dirubah pada menu Edit Template 

o Step berikutnya adalah mengklik tombol “Buat blog!” 

o Lalu blog Anda telah dibuat. 

3. Cara menulis artikel pada blog 

 Judul Artikel: Perlu diperhatikan dalam membuat judul blog, Anda 

jangan menggunakan judul artikel yang terlalu panjang karena 

blogger akan membatasi panjang karakter untuk judul artikel Anda. 

 Anda dapat memasukan artikel atau kontent kedalam kolom konten 

yang sudah tersedia. dan kontent yang bisa Anda masukan berbentuk 

text, images, dan juga video. 

 Pada kolom artikel juga sudah disediakan beberapa fasilitas untuk 

mengatur format text, menambah link, dan lain sebagainya, dan 

biasnya terletak dibawah judul kontent. 

 Label, pengisian label bisa digunakan untuk memilah - milah artikel 

yang nantinya juga difungsikan sebagai kategori pada blog Anda. 

biasnya label juga difungsikan untuk membuat menu nafigasi, karena 

untuk membuat menu di bloger, biasanya dengan memanfaatan label 

kontent. untuk pemula memang bisa dibilang agak sulit membuat 

menu pada platform Blogspot. 

 Penjadwalan Posting, Bloger sendiri juga menyediakan fitur untuk 

menjadwalkan kapan artikel tersebut dipublikasikan tentunya sesuai 

dengan keinginan Anda. Anda juga bisa menambahkan lokasi dimana 

artikel itu dibuat. 

 Setelah semuanya sudah selesai, Anda bisa mengklik tombol 

"Publikasikan" dan Anda akan menemukan kontent yang telah dibua 

tsudah online dan dapat dibaca oleh pengunjung blog Anda. 
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Kompetensi 
Profesional 

Kegiatan Pembelajaran 7:  

Mengelola Web 

 

A. Tujuan 

Setelah mempelajari kegiatan belajar tujuh dengan judul Mengelola Web, 

peserta diklat diharapkan dapat menyebutkan pengertian web, fungsi web, 

macam-macam web, Menyebutkan dan menjelaskan teknologi pembuatan 

web, membuat web sederhana sesuai dengan kebutuhan 

 

B. Indikator Pencapaian Kompetensi 

Setelah selesai mempelajari modul ini, peserta diklat diharpkan dapat : 

1. Menyebutkan pengertian web  

2. Menyebutkan fungsi web  

3. Menyebutkan macam-macam web 

4. Menyebutkan dan menjelaskan teknologi pembuatan web 

5. Membuat web sederhana 

 

C. Uraian Materi 

1. Pengertian web 

Website atau situs dapat diartikan sebagai kumpulan halaman yang 

menampilkan informasi data teks, data gambar diam atau gerak, data 

animasi, suara, video dan atau gabungan dari semuanya, baik yang 

bersifat statis maupun dinamis yang membentuk satu rangkaian 

bangunan yang saling terkait dimana masing-masing dihubungkan 

dengan jaringan-jaringan halaman (hyperlink).  

2. Fungsi web 

a. Media Promosi 

b. Media Pemasaran  

c. Media Informasi  
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d. Media Pendidikan 

e. Media Komunikasi  

3. Macam-macam web browser 

3.1 Web Browser Mozilla Firefox 

Firefox adalah salah satu dari web browser open 

source yang dibangun dengan Gecko layout engine. 

Web Browser merupakan salah satu dari macam 

macam Web Browser yang handal karena didukung 

oleh sejumlah Add-ons yang dapat diinstall secara terpisah yang 

memungkinkan pengguna melakukan sesuai dengan kegunaan Add-

ons tersebut. 

Kelebihan Web Browser Mozilla Firefox: 

 Banyak fitur tambahan add ons alias pengaya, ibarat kepingan 

puzzle, add ons ini bisa dibongkar pasang sesuai dengan 

kebutuhan user 

 Bandel, cocok untuk membuka situs-situs multimedia 

 Updatenya mudah 

 Sistem security kuat 

 Hemat resource memory 

 Interface/tampilan lay out yang simple sehingga mudah digunakan 

 

Kekurangan Web Browser Mozilla Firefox 

 Terkadang loadingnya cukup lama saat mulai start awal, terlebih 

lagi jika banyak adds-on yang terinstall.  

 Saat memulai mode Private,  harus menutup terlebih dahulu 

semua halaman dalam mode regular  

 

3.2 Web Browser Google Chrome 

 

Kelebihan Web Browser Google Chrome: 

 Memiliki kemampuan browsing yang lumayan cepat 
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 Secara otomatis dapat membookmark situs yang pernah dibuka 

sebelumnya selain histori, dan halaman yang sering dikunjungi 

 Keunggulan browser addressnya karena dapat berfungsi 

sebagai search engine 

 Memiliki fitur Google Chrome diantaranya mendukung flash dan 

java (terintegrasi) 

 Penggunaan memori tab yang terpisah 

 Mendukung Bahasa Indonesia. 

Kekurangan Web Browser Google Chrome: 

 Masih terlalu banyak security holenya sehingga tidak disarankan 

untuk pakai bertransaksi keuangan 

 Penggunaannya masih terbatas pada Windows XP dan Vista 

 Makin banyak tab baru dibuka, maka butuh lebih banyak memori 

saat browsing 

 Statis, fiturnya kurang banyak 

 

3.3 Web Browser Opera 

Opera dikembangkan oleh Opera Software company 

adalah salah satu Web Browser dan juga Internet 

Suite. Jika firefox punya Add-ons,  Opera punya 

“Opera Widgets”, sebuah aplikasi  web kecil yang 

dijalankan bersamaan dengan Opera yang mempunyai kegunaan 

tertentu, layaknya Add-ons firefox. 

Kelebihan Web Browser Opera : 

 Ringan dan cepat 

 Memiliki email client dan rss sendiri, jadi kita tidak perlu memakai 

email client lain seperti Outlook, Thunderbird dan lainnya 

 Fitur mouse gestures, membuat browsing experience semakin 

asyik 

 Fitur Turbo yang mampu mengkompres halaman saat koneksi 

lambat sehingga halaman terbuka lebih cepat 

 Memiliki fitur penyimpan halaman dalam bentuk .mht (single file), 

yang belum dimiliki Chrome & Firefox dalam versi standar 

 Banyak fitur pengaya/add ons widget dan aplikasi 

http://media.opera.com/media/images/icon/Opera_512x512.png
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 Fitur Opera yang paling unik adalah fitur "Voice Interaction". 

Dengan fitur ini, Anda dapat memerintahkan Opera untuk 

mereload halaman, log in, membuka tab baru, mengklik link dan 

lain-lain dengan suara Anda. 

 

Kekurangan Web Browser Opera : 

 Gagal dalam membaca script pada situs-situs tertentu 

 Tampilannya yang kelewat "advance", membuat pengguna 

pemula kesulitan saat awal menggunakannya 

 Untuk mengupdatenya pengguna Opera harus mendownload 

kembali file masternya 

 

3.4 Web Browser Safari 

Safari adalah sebuah penjelajah web buatan Apple 

Inc. yang awalnya ditujukan khusus bagi 

sistemoperasi Mac OS. Safari dibundel bersama Mac 

OS X dan merupakan penjelajah web default di 

sistemoperasi tersebut sejak Mac OS X v10.3. Pada 11 Juni 2007, 

versi preview untuk Windows dari Safari diperkenalkan pada 

Konferensi Pengembang Sedunia Apple di SanFrancisco. 

Kelebihan Web Browser Safari : 

 Mempunyai fitur Nitro Engine yang bisa mengevakuasi java 

script lebih cepat 

 Mendukung web dengan html 5 yang lebih dinamis 

 Memiliki tampilan browser yang simple. 

 

Kekurangan Web Browser Safari : 

 Sistem keamanan kurang 

 Tampilan terlihat asing bagi windows 

 Tidak tersedianya plug in pada versi windows 

 

  

http://216-45-49-189.rotatemyad.com/click.php?aid=861&said=06b_05301314p45&v=15&id=401a32ece696ee9d6e6df6516e19f700&url=http://216.144.227.224/click.php?key=86499b0705c57f2ef574af48404deea4a0e8578b634&btn=l&bUrl=http://2.bp.blogspot.com/-XlNe7FLpkHI/ULRSDYfIuJI/AAAAAAAAD6Q/30brYYPJfJE/s1600/macam-macam+web+browser+terlengkap4.jpg
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3.5 Web Browser Internet Explorer 

Internet Exporer besutan Microsoft Corporation. 

Sering di kenal singkatan IE. Sejak tahun 1995 

Internet Exporer mulai di masukkan sebagai default 

sotware pada saat instalasi Sistem Operasi Windows. 

Kelebihan Web Browser Internet Explorer : 

 Menyediakan add ons, walaupun tidak sebanyak Firefox 

 Khusus Internet Explorer 9 (IE9), tampilannya lebih simpel, elegan 

dan menarik 

 Browser ini sangat terintegrasi dengan Sistem Operasi Windows 

karena menjadi browser standar dari Microsoft 

 Untuk pengguna Windows Live pengguna akan di manjakan dengan 

tersedianya tab bookmark yang terhubung ke fitur-fitur milik Windows 

Live. 

 

Kekurangan Web Browser Internet Explorer 

 Adakalanya tidak bisa/gagal dalam membaca script yang ada 

dibeberapa halaman situs (khususnya CSS) 

 Seringkali berat pada saat awal start atau saat pengguna sedang 

membuka tab baru. 

 Khusus IE9 tidak mendukung Sistem Operasi Windows XP  

 

3.6 Web Browser Flock 

Flock adalah sebuah penjelajah web yang 

berspesialisasi pada penyediaan fitur jaringan sosial 

dan fitur Web 2.0 lain pada tampilan antarmukanya. 

Browser ini dibuat menggunakan codebase Mozilla 

Firefox. Pada tanggal 16 Juni 2008, Flock 2 yang menggunakan 

Mozilla Firefox 3 sebagai basisnya, diluncurkan dengan status open 

beta. Dukungan untuk browser Flock akan dihentikan secara resmi 

pada 26 April 2011. Flock dapat diunduh secara gratis, dan 

mendukung platform Microsoft Windows, Mac OS X, dan Linux. 

Kelebihan Flock : 

http://id.wikipedia.org/wiki/Penjelajah_web
http://id.wikipedia.org/wiki/Web_2.0
http://id.wikipedia.org/wiki/Antarmuka
http://id.wikipedia.org/wiki/Mozilla_Firefox
http://id.wikipedia.org/wiki/Mozilla_Firefox
http://id.wikipedia.org/wiki/16_Juni
http://id.wikipedia.org/wiki/2008
http://id.wikipedia.org/wiki/Microsoft_Windows
http://id.wikipedia.org/wiki/Mac_OS_X
http://id.wikipedia.org/wiki/Linux
https://encrypted-tbn2.gstatic.com/images?q=tbn:ANd9GcQJn6yj9L7oqk7CFOxtD6LrHIB85ntJdA4weang_rvKOrfQFiO4hQ
http://blog.sudobits.com/wp-content/uploads/2010/10/flock-web-browser-logo.jpg
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 Ada menu tersendiri(photo uploader) untuk upload foto ke situs 

layanan jaringan sosial misal : Facebook , Flickr , Twitter , 

Myspace . 

 Terintergrasi langsung dengan situ jejaring sosial 

 Update status Facebook langsung tanpa membuka website 

(tentunya harus sudah login), dan juga mengetahui update status 

teman melalui People Sidebar. Juga bisa terintegrasi dengan 

Flickr, Twitter, Youtube, MySapce dan Digg 

 Cek email melalui menu webmail. 

 Posting artikel blog langsung tanpa masuk dashboard melalui 

menu Blog Editor. Terintegerasi dengan Blogger, Blogsome, 

LiveJournal, Typepad, wordpress, Xanga dan juga akun blog 

pribadi Anda. 

 

Kekurangan Flock: 

 Flock membutuhkan resources yang lebih besar! Di beberapa 

komputer, memulai Flock untuk pertama kalinya akan memakan 

waktu agak lama (nggak selama itu kok gann 

 Skin Flock pun masih terbatas. 

 

3.7 Web Browser  K-Meleon 

 

Kelebihan K-Meleon : 

 Tampilannya lebih simple. 

 Lebih cepat dan ringan. 

 Tidak memakan resource yang banyak. 

 Sangat cocok apabila digunakan pada komputer yang memiliki 

memory yang terbatas. 

 Memiliki fitur-fitur yang cukup bagus. 

 Salah satu browser gratis yang open source, dimana para 

pengembangnya bisa datang dari seluruh dunia. Open Source 
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memungkinkan para penggunanya untuk memodifikasi atau 

mengkustomise browser tersebut sehingga sesuai dengan 

keinginannya. 

 

Kekurangan K-Meleon : 

 Kurang cocok untuk membuka Social Network seperti facebook. 

Biasanya akan ada peringatan bahwa versi browser yang 

digunakan versi lama (padahal yang digunakan adalah K-Meleon 

terbaru) 

 Agak repot untuk menambahkan plugin/add ons jika 

dibandingkan dengan browser yang lain, walaupun sudah ada 

beberapa plugin yang terpasang secara default. 

 Untuk menambah/menutup tab perlu beberapa kali klik mouse, 

walaupun masih bisa juga dengan shortcut keyboard. 

 

3.8 Web Browser Netscape Navigator 

Netscape Navigator merupakan browser web yang 

terkenal pada era 1990-an dan paling 

banyakdigunakan sebelum kemunculan Internet 

Explorer dari Microsoft, yang dibuat oleh 

NetscapeCorporation. Pada zamannya, Netscape banyak digunakan 

oleh pengguna karena memang lebihbaik dibandingkan dengan 

beberapa web browser berbasis grafis yang lainnya saat itu. 

Netscapetersedia dalam platform Windows 16-bit (Win16), Windows 

32-bit (Win32), UNIX, sertaMacintosh.Netscape Navigator 

merupakan browser yang dibuat dari basis kode sumber Mosaic 

WebBrowser dari National Center for Supercomputing Applications 

(NCSA), karena memang pembuat NCSA (Marc Andressen) adalah 

pendiri Netscape Corporation. Selain tersedia dalam bentuk 

Netscape Navigator, Netscape juga mengeluarkan paket suite 

Internet, yang disebut sebagai Netscape Communicator, yang 

menggabungkan Navigator, klien e-mail, editor halaman web,dan 

aplikasi lainnya. 

http://4.bp.blogspot.com/-R_Bd1aQcUNc/USirAxnMqFI/AAAAAAAAAHw/qS95T2m29HA/s1600/mm.jpeg
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Pada tahun 1999, Netscape Corporation diakusisi oleh America 

Online (AOL), dan proyek Geckoyang sedang dibuat oleh Netscape 

pun dibuat terbuka kode sumbernya (open source) setelah Netscape 

mendirikan proyek Mozilla.org. Jadi bisa diambil kesimpulan bahwa 

Netscape Navigator adalah browser web yang merupakan gagasan 

bagi browser Mozilla Firefox. Netscape Navigator merupakan web 

browser yang stabil jika digunakan untuk surfing, browsing,upload 

dan download, hanya saja secara GUI (Graphical User Interface) web 

browser ini kurang bagus (kasar). Netscape Navigator merupakan 

web browser yang dikomersilkan pada saat itu,web browser ini mulai 

mengalami kehilangan peminat/penggunanya pada saat IE mulai 

terpasang secara default ketika menginstall Microsoft Windows. 

 Kelebihan Netscape Navigator· 

Netscape Navigator adalah browser web yang merupakan 

gagasan bagi browser Mozilla Firefox.Netscape Navigator 

merupakan web browser yang stabil jika digunakan untuk surfing, 

browsing, upload dandownload. 

 Kekurangan Netscape Navigator· 

Secara GUI (Graphical User Interface) web browser ini kurang 

bagus (kasar). Netscape Navigator merupakanweb browser 

yang dikomersilkan pada saat itu, web browser ini mulai 

mengalami kehilangan peminat/penggunanyapada saat IE mulai 

terpasang secara default ketika menginstall Microsoft Windows. 

 

3.9 Web Browser Lunascape  

Lunascape merupakan web browser yang tegolong 

muda di dunia maya. Lunascape ditemukan oleh 

Hidekazu Kondo yang juga merupakan CEO dan 

pendirinya. Lunascape diklaim merupakan browser 

pertama di dunia yang menggabungkan tiga buah engine internet 

dalam satu aplikasi. 

Tiga engine tersebut yakni Gecko, Trident, dan Webkit. Lunascape 

juga diklaim sebagai browser tercepat dan teraman saat ini yang 

diakibatkan dari penggabungan ketiga engine tersebut.Salah satu 

http://3.bp.blogspot.com/-E9rB6iY12QQ/USirdkbyZmI/AAAAAAAAAH8/tmZE7sVo2Mo/s1600/mmmmm.jpeg
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engine tersebut adalah “nyawa” dari Mozilla Firefox yang juga diklaim 

sebagai browser teraman yaitu Gecko. 

 

3.10 Web Browser  kylo 

Untuk masalah keunikan browser, Kylo salah satu 

yang bisa dijagokan. Tampilannya sangat unik dan 

sangat sesuai bagi pengguna internet yang ingin 

menonton video streaming karena adanya fasilitas 

yang bisa menyajikan konten pada browser ini ditayangkan secara 

fullscreen. 

 

3.11 Web Browser Maxton 

Maxthon internetbrowser software merupakan 

browser handal yang sangat mudah disesuaikan 

dengan kebutuhan dan keinginan user. hal ini 

didasarkan pada sistem yang berjalan pada browser 

Internet Eksploler (IE) yang juga akan berjalan pada maxton 

(menggunakan Engine IE). namun dengan bertambah fitur yang 

lebih kaya bila dibandingakan dengan IE. 

Fitur-fitur: 

 Tabbed browsing 

interface 

 Mouse gestures 

 Super drag and drop 

 Favorites bar 

 Ad hunter 

 Ie extension support 

 External utility bar 

 Privacy protection 

 Skins 

 Plugins 

 Compatibility & low on 

resources 

Keunggulan menggunakan browser maxton : 

 Mudah digunakan  

 Bisa didownload secara gratis 

 Adanya sisitem swap, untuk menambahkan, memindahkan, 

menghapus,dan mengubah maxton tools, menu icon, warna, 

skin dan navigasi yang mudah digunakan  

http://4.bp.blogspot.com/-TzIRwAXA9b8/USiVaplWXEI/AAAAAAAAAGc/uUq3lqdqcSY/s1600/Maxthon.png
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 Tersedia ribuan plug-in yang melengkapi kerja maxtron 

 Remote conferencing,untuk menangkap aktivitas yang terlihat 

pada layar, untuk dokumentasi paspor secara elektronik, riset 

pasword yang oto,atis 

 Keamanan yang handal. 100% bebas dari serangan virus, 

spyware, adware, dan semua jenis malware 

 Filter, yang digunakan untuk menyaring halaman web yang 

tidak dikehendak 

Kelemahan menggunakan browser maxton : 

 Manajemen tab yang kompleks 

 Memori dan resource yang banyak terbuang percuma karena 

kompleksitas manajemen tab. 

3.12 Web Browser Yandex 1.0  

Yandex merupakan search engine lokal yang 

berasal dari Rusia. Di tempat asalnya Yandex ini 

mengungguli Google, karena lebih dari 60% orang 

Rusia menggunakan Search engine ini. 

Kali ini ada kabar terbaru dari Search Engine Yandex ini yaitu 

mereka meluncurkan produk terbaru berupa Browser yang diberi 

nama Yandex Browser. Seperti halnya pada Chrome, Yandex 

Browser juga memiliki URL bar dan Search bar yang dijadikan satu. 

Keunggulan dari Yandex Browser ini adalah Semua halaman yang 

kamu buka akan diperiksa Yandex dengan Antivirus Cloud 

Kaspersky. Selain itu bookmark yang muncul ketika Anda buka 

News Tab, bisa langsung menggunakan fitur translate di Web yang 

sedang Anda buka. 

Kedepannya Yandex Browser ini aan menggunakan fitur Turbo 

speerti yang akan pada Opera. Dengan adanya fitur ini Anda akan 

dapat mengakses web dengan cepat walaupun koneksi internet 

lambat. 

 

  

http://4.bp.blogspot.com/-zgMYoSBifvQ/USifjcgLyRI/AAAAAAAAAGs/LNuebQRTHH4/s1600/images.jpeg
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3.13 Avant Browser 

Avant Browser adalah browser yang cukup populer 

dan gratis dari programmer asal China yang 

bernama Anderson Che. 

Browser ini menyatukan layout (engine) Trident yang 

dibuat untuk Windows (lihat shell dari Internet Explorer) 

membuatnya kaya akan feature-feature, fleksibel dan ergonomic 

dibanding dengan Microsoft Internet Explorer (IE). Ini dapat berjalan 

pada Windows 98 keatas termasuk Vista. 

Kelebihannya diantaranya: 

 Dapat menyimpan Profile secara online. 

 Mem-filter Animasi Flash 

 Built-in AD/Pop-up Blocker 

 Built-in RSS/ATOM Reader 

Real Full Screen Mode dan Alternative Full Desktop mode: Ketika 

kamu membuka halaman web dengan Avant Browser Full Screen 

Mode, semua yang kamu lihat hanyalah webspace, tanpa toolbars 

atau menu lain. 

kekurangannya diantaranya: 

 Penggunaan IE plug-in dapat menyebabkan program fatal error. 

 Speed biasa-biasa saja 

 Fitur keamanan belum memadai 

 

3.14 Web Browser SeaMonkey 

SeaMonkey atau lengkapnya Mozilla SeaMonkey 

adalah suatu internet suite, yang merupakan 

gabungan web browser untuk menjelajah internet, 

e-mail client untuk menerima dan mengirim e-mail, 

news client untuk menerima berita dan HTML editor untuk 

menyunting halaman-halaman website yang menggunakan html 

(hyper text mark-up language). 

Dahulunya perangkat lunak ini bernama Mozilla Application Suite, 

yang merupakan pengembangan dari Netscape Navigator buatan 

http://4.bp.blogspot.com/-cuxmAH7Ilgc/USijeBR_rwI/AAAAAAAAAG8/ddv7CqvkbRA/s1600/avant.png
http://1.bp.blogspot.com/-_F2qUhOGP1Y/USikFCjK67I/AAAAAAAAAHE/teLypBYP9G0/s1600/3150b_seamonkey_logo_original_xlarge.png
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Netscape Communications Corporation (yang sudah bubar). 

SeaMonkey merupakan peranhkat lunak yang bersifat free software, 

open source, dan cross-platform. Dikembangkan secara bersama 

oleh suatu komunitas yang dipimpin oleh SeaMonkey Council 

(Dewan SeaMonkey). 

Kelebihan Dari SeaMonkey Browser: 

 Bisa berguna untuk email dan browser sekaligus. 

 Penterjemahan website2 yang berbahasa asing (China, 

Jepang, Korea, Spanyol, dll) ke bahasa Inggris yang lebih 

mudah dimengerti. 

 Dapat memfilter email spam ataupun virus. 

 

3.15 Web Browser Konqueror 

Konqueror adalah web browser, file manager, dll. 

Konqueror menyediakan file viewer yang bisa 

mengexplore file-file di komputer Anda maupun 

secara remote ke komputer lain. Protokol yang 

didukung Konqueror : 

 FTP and SFTP/SSH browser 

 SAMBA (Microsoft file-sharing) browser 

 HTTP browser 

 IMAP mail client 

 ISO (cd image) viewer 

 VNC viewer 

Untuk menginstall Konqueror ini Anda harus install KDE terlebih 

dahulu. KDE adalah Desktop Enviroment di keluarga unix, jika Anda 

pengguna windows telebih dahulu install KDE. 

Masih banyak web browser yang terdapat di internet, kembali 

kepada Anda untuk mengunakan browsing internet sehari-hari dan 

install Add-ons atau Widgetnya untuk mendapatkan pengalaman 

berbeda saat berselancar.Web browser tak hanya mempunyai 

tampilan yang cantik tapi ada juga web browser yang bisa bicara, 

http://1.bp.blogspot.com/-BR2q7lRtk8M/USipe6bHo1I/AAAAAAAAAHg/zX4hGQTI9IU/s1600/nnnn.jpeg
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ikuti ulasannya disini web browser luar biasa yang diciptakan untuk 

pengguna luar biasa. 

Kelebihan Dari Browser Konqueror: 

Selain sebagai web browser, adalah kemampuannya melakukan 

manajemen file lokal, serta file viewer. Dengan teknologi KPart 

object model, browser ini mampu mengeksekusi, bahkan mengedit 

file-file yang spesifik seperti dokumen atau file berformat Pdf. KPart 

juga dapat digunakan untuk menanamkan konten multimedia pada 

halaman HTML. 

Kelemahan Dari Browser Konqueror: 

Untuk menginstall Konqueror ini Anda harus install KDE terlebih 

dahulu. KDE adalah Desktop Enviroment di keluarga unix, jika Anda 

pengguna windows telebih dahulu install KDE. Namun, Konqueror 

tetap terbatas pada Windows. 

Tidak dapat me-render dengan baik semua halaman web, terutama 

spesifik pada web browser lain. 

 

3.16 Web Browser Camino 

Camino adalah open source web browser 

dikembangkan berfokus pada memberikan 

experience terbaik kepada pengguna Mac OS X. 

Camino mengkombinasikan visual sederhana, 

elegan dan menyajikan pengalaman yang mengagumkan yang 

menjadi filosofi dari Macintosh dengan Gecko layout engine yang 

powerful. Camino hanya dapat diinstall dalam Sistem Operasi Mac. 

 Kelebihan Dari Camino Browser: 

Tersedia block flash terintegrasi, jadi bisa hemat bandwidth. 

Koneksinya cepat dan tidak lambat. 

 Kekurangan Dari Camino Browser: 

Diproduksi hanya untuk Mac. 

 

  

http://1.bp.blogspot.com/-q6PyKhcu4VM/USioLGXLbcI/AAAAAAAAAHU/jgxfM_NBTuo/s1600/nn.jpeg
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3.17 Web Browser Palemoon 

Cara kerja browser PaleMoon sangat mirip 

dengan Firefox, namun ada beberapa fungsi 

PaleMoon yang tidak dimiliki Firefox. 

Kelebihan tersebut cukup membuat 

PaleMoon mulai dikenal dan banyak digunakan, perbedaan yang 

cukup terlihat pada PaleMoon antara lain; terdapat beberapa fitur 

yang dipilih secara hati-hati untuk dinonaktifkan hal ini disebabkan 

fitur-fitur tersebut sangat jarang digunakan dalam proses browsing. 

Dengan menonaktifkan fitur-fitur yang jarang digunakan, 

kecepatana browsing akan menjadi maksimal, karena walaupun 

ada fitur yang dinonaktifkan, hal ini tidak akan mengganggu proses 

browsing maupun mengganggu halaman web atau fungsi web yang 

ditampilkan. 

Menurut pengembangnya, Pale Moon akan terus menampilkan satu 

paket kontrol yang mudah digunakan dan umpan balik visual yang 

mirip dengan versi sebelumnya, sehingga kita tidak selalu terus 

beradaftasi dengan versi-versi baru yang dirilis. Misalnya saja, 

termasuk tombol navigasi dikelompokkan dari ukuran yang biasa, 

toolbar bookmark yang diaktifkan secara default, dan fungsi-fungsi 

bar lainnya. 

Saat ini PaleMoon telah mendukung sistem operasi antara lain; 

Windows XP, Windows Vista, Windows 7, Windows 8, Server 2003 

atau yang lainnya. Sementara untuk komputer kita dibutuhkan 

hardware paling tidak dalam sepesifikasi berkut: Semua flatform 

processor, minimal memori RAM 256, dan minimal ruang kosong 

pada harddisk 50 MB. 

 

3.18 Acoo Browser 

Acoo Browser merupakan internet browser 

dengan fitur multi-tabbed yang full power 

menggunakan IE engine. Memiliki Graphic 

User Interface yang user-friendly serta 

tabbed document windows, dockable panel serta custumizable 

http://2.bp.blogspot.com/-iZbWuGX2gHA/U4lRGL_VDHI/AAAAAAAAAEQ/Ja1M3E9R5kQ/s1600/palemoon-320x198.JPG
http://4.bp.blogspot.com/-KHnygJCELVM/U4lXBpUzQkI/AAAAAAAAAEg/zJJpvqBF-ss/s1600/acco+browser.jpg
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toolbars.Aplikasi Acoo Browser merupakan penjelajah internet 

multi-tab dengan tampilan GUI yang ciamik. Fitur multi-tab yang 

sedang naik daun ini memungkinkan Anda menjelajah lebih dari 

satu alamat Web hanya dalam satu jendela. Aplikasi Acoo Browser 

sendiri dilengkapi dengan fitur penghalang pop-up, penyaring iklan, 

penyaring activeX, kalkulator, viewer HTML, penganalisa halaman 

web, pembersih cookies, dan menu mesin pencari seperti Google, 

Yahoo, dan MSN yang dapat Anda pilih. Selain itu Anda juga dapat 

menyimpan alamat Web sekaligus mengelompokkannya sesuai 

dengan kategori tertentu. Jika Acoo Browser ditutup, maka program 

otomatis menyimpan halaman Web site yang Anda buka terakhir.  

Acoo Browser mempunyai menu yang tidak dipunyai oleh 

penjelajah lainnya, yaitu Zoom Web dan pengubah tampilan jendela 

penjelajah. Jika punya aplikasi download manager terpisah Anda 

juga dimungkinkan untuk mengintegrasikannya di sini.  

 

4. Teknologi pembuatan web 

Secara umum teknologi desain web terbagi menjadi beberapa layer 

(lapisan), yaitu structural layer, presentation layer dan behavioral layer. 

a. Structural Layer 

Layer ini berhubungan dengan struktur dokumen web. bagaimana 

sebuah dokumen tersusun, format apa yang dipakai, tanda atau mark 

up apa yang digunakan merupakan bagian dari layer. Standar 

teknologi yang direkomendasikan saat ini adalah Extensible 

Hypertext Markup Language (XHTML) dan Extensible Markup 

Language (XML). XHTML adalah HTML versi terakhir (4.01) yang 

ditulis ulang dengan aturan-aturan yang lebih ketat mengacu pada 

XML. Sedangkan XML adalah sekumpulan aturan untuk menyusun 

bahasa markup. 

b. Presentation Layer 

Layer ini berhubungan dengan bagaimana mengatur tampilan 

dokumen pada layar, suara yang keluar , atau bagaimana format 

pencetakan dokumen. pada teknologi web lama bagian ini menyatu 

dengan structural layer. Tapi pada standar baru, Layer ini disarankan 
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untuk dipisah. yang termasuk teknologi ini adalah Cascading Style 

(CSS). 

c. Behavioral Layer 

Layer ini berhubungan dengan masalah penggunaan bahasa skrip 

dan pemogramannya untuk tujuan meningkatkan sisi interaktif dan 

dinamis halaman web. yang termasuk dalam layer ini adalah 

Document Object Model (DOM) dan JavaScrift. DOM memungkinkan 

suatu dokumen atau skrip untuk mengakses atau meng-update isi, 

struktur, dan style dari dokumen. JavaScript merupakan teknologi 

yang cukup lama dan tetap digunakan untuk menambah dokumen 

menjadi lebih interaktif 

 

5. Cara membuat web sederhana 

Cara membuat halaman web sederhana sangatlah mudah, dikarenakan 

perangkat membuat web sangat mudah ditemui di internet dan rata-rata 

program tersebut gratis. Dalam tutorial kali ini perangkat yang dibutuhkan 

antara lain: 

 Notepad, atau Anda bisa mencoba notepad ++ yang mana dalam 

program ini tersedia fitur yang lebih baik ketimbang notepad bawaan 

windows. 

 Browser sebagai program penampil halaman web. Jika Anda 

pengguna windows, biasanya browser IE(Internet Explorer) akan 

terinstall otomatis. Anda juga bisa menggunakan browser dari google, 

yaitu Chrome. 

 

Yang pertama, buka program notepad dari komputer Anda dengan cara: 

 Mengeklik tombol windows 

 Setelah itu klik tulisan All Program 

 Maka akan muncul berbagai folder dan pilih folder yang bernama 

Accessories 

 Klik folder Accessories, setelah muncul berbagai program dalam 

folder tersebut, klik program notepad. 

  

http://www.nyekrip.com/nyekrip/perlengkapan-membuat-web/
http://notepad-plus-plus.org/download/v6.6.9.html
http://www.google.com/
https://www.google.com/intl/en/chrome/browser/
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Untuk lebih jelasnya silahkan perhatikan gambar dibawah ini 

 
Sumber : Htpp://i2.wp.com 

Cara membuka halaman notepad- nyekrip 

Pada gambar diatas terdapat dua blok, blok pertama yang bewarna hijau 

adalah tempat tombol Windows, dan yang kedua blok yang bewarna 

merah muda adalah tempat program Notepad. 

Setelah program Notepad terbuka, silahkan ketikkan skrip dibawah ini 

atau jika ingin cepat Anda bisa langsung mengkopi dan mempaste di 

notepad Anda. 

 Skrip HTML 

 Run Skrip 

Setelah Anda mengetik skrip diatas silahkan Anda save dengan cara 

klik file dan save, ketika muncul halaman save ketikkan nama file ” 

index.html ” atau terserah Anda, yang terpenting adalah nama file 

diakhiri .html. 

Setelah itu lihat kolom dibawah file name, disitu terdapat kolom Save 

as Type dan pilih All Files. Langkah selanjutnya tinggal klik tombol 

Save. Untuk lebih jelas silahkan lihat gambar dibawah ini. 

 
Sumber : Htpp://i0.wp.com 

http://www.nyekrip.com/nyekrip-yuk/index.php?fdata=penggunaan-tag-head-dan-body
http://i2.wp.com/www.nyekrip.com/wp-content/uploads/2014/12/cara-membuka-halaman-notepad-nyekrip.png
http://i0.wp.com/www.nyekrip.com/wp-content/uploads/2014/12/cara-save-file-di-notepad-nyekrip.png
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 Cara save file di notepad – nyekrip 

Pada gambar diatas terdapat area yang diblok dengan warna hijau, 

diarea tersebut terdapat tulisan save, dengan mengeklik tulisan ini 

maka akan muncul halaman Save seperti gambar dibawah ini: 

 Cara save file di notepad 2 – nyekrip 

Perhatikan gambar diatas, terdapat dua area yang diblok. Pada area 

yang diblok dengan warna hijau adalah tempat untuk memberi nama 

file dan pastikan nama file berakhiran .html. sedangkan area yang 

diblok bewarna merah muda adalah dropdown untuk memilih jenis 

file yang akan disimpan, pastikan pilihan berisi All files. 

Setelah file html terbentuk dan tersimpan (dalam tutorial ini file 

disimpan dalam folder yang bernama ” new folder “) maka buka file 

tersebut dengan cara mengeklik dua kali, setelah itu akan ada 

browser yang menampilkan halaman web yang telah kita buat. 

Halaman web tersebut akan terlihat seperti gambar dibawah ini: 

Elemen dalam layout halaman web head body Nyekrip 

Pada gambar diatas terdapat dua area yang diblok, yang diblok 

dengan warna hijau adalah letak tulisan yang di ketik dalam Tag 

Title sedangkan yang bewarna merah muda adalah letak tulisan 

yang diketik didalam Tag Body. 

Tutorial diatas adalah cara bagaimana membuat halaman web yang 

sederhana, belum menyentuh kearah pengaturan layout. Pengaturan 

layout akan melibatkan banyak elemen dan tentunya skrip CSS akan 

berperan penuh, untuk pembahasan lebih lanjut tentang layout akan 

dibahas dalam kategori belajar CSS pada kesempatan berikutnya. 
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D. Aktivitas Pembelajaran 

1. Peserta diklat membaca dengan cermat isi modul 

2. Diskusi dengan sesama peserta diklat apa yang telah dicermati untuk 

mendapatkan pemahaman yang baik mengenai isi modul 

3. Apabila dalam berdiskusi peserta diklat masih mengalami kesulitan, maka 

diskusikan dengan instruktur 

4. Apabila isi modul telah dipahami peserta diklat dapat mengerjakan latihan 

dan tugas praktek yang telah disediakan 

 

E. Latihan/Kasus/Tugas 

1. Latihan 

a. Jelaskan pengertian web? 

b. Sebutkan fungsi web? 

c. Sebutkan 5 macam web? 

d. Sebutkan teknologi pembuatan web? 

e. Sebutkan langkah-langkah membuat web sederhana? 

2. Tugas 

Buatlah web sederhana sesuai dengan langkah-langkah yang ada di 

kegiatan belajar tujuh. 

 

F. Rangkuman 

Website atau situs dapat diartikan sebagai kumpulan halaman yang 

menampilkan informasi data teks, data gambar diam atau gerak, data animasi, 

suara, video dan atau gabungan dari semuanya, baik yang bersifat statis 

maupun dinamis yang membentuk satu rangkaian bangunan yang saling 

terkait dimana masing-masing dihubungkan dengan jaringan-jaringan 

halaman (hyperlink). 

Fungsi web  yaitu sebagai media promosi, pemasaran, informasi, pendidikan 

dan komunikasi. Berikut adalah macam-macam web: 

1. Web browser mozila firefox, 

2. Web browser google chrome, 
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3. Web browser opera, 

4. Web browser internet Explorer, 

5. dll. 

Teknologi pembuatan web: 

1. Structural Layer 

2. Presentation Layer 

3. Behavior Layer 

 

Cara membuat web sederhana: 

1. Klik Start > All Program > Accessories > Notepad. 

2. Menulis skrip HTML pada notepad 

3. Lalu save file dengan format .html 

 

G. Umpan Balik dan Tindak Lanjut 

1. Umpan Balik 

Setelah selesai mempelajari kegiatan belajar tujuh, peserta diklat 

diharapkan dapat membuat web sederhana. Web tersebut dapat 

digunakan sesuai dengan kebutuhan. 

2. Tindak lanjut  

Setelah peserta diklat selesai mempelajari kegiatan belajar tujuh dan 

sudah mampu menguasainya maka dapat dilanjutkan dengan 

mempelajari kegiatan belajar delapan. Tetapi apabila belum menguasai 

dapat meminta bantuan kepada instruktur untuk menyelesaikan kegiatan 

belajar tujuh. 

H. Kunci Jawaban 

1. Website adalah suatu kumpulan halaman yang menampilkan informasi 

data teks, data gambar diam atau gerak, data animasi, suara, video dan 

atau gabungan dari semuanya, yang bersifat statis maupun dinamis yang 

kemudian dihubungkan dengan jaringan-jaringan halaman (hyperlink). 
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2. Fungsi web  yaitu sebagai: 

a. media promosi 

b. media pemasaran 

c. media informasi 

d. media pendidikan 

e. media komunikasi 

3. 5 macam web yaitu: 

a. Web browser mozila firefox 

b. Web browser google chrome 

c. Web browser opera 

d. Web browser internet Explorer 

e. Web browser safari 

4. Teknologi pembuatan web adalah; 

a. Structural Layer 

b. Presentation Layer`1234 

c. Behavior Layer 

5. Cara membuat web sederhana yaitu; 

a. Klik Start > All Program > Accessories > Notepad. 

b. Menulis skrip HTML pada notepad 

c. Lalu save file dengan format .html 
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Kompetensi 
Profesional 

Kegiatan Pembelajaran 8  

Mengoperasikan Teleconference 

 

 

A. Tujuan 

Setelah mempelajari kegiatan belajar delapan dengan judul Mengoperasikan 

Teleconfrence, peserta diklat diharapkan mengetahui pengertian 

teleconference dengan santun, jenis-jenis teleconference dengan cermat, 

manfaat teleconference dengan baik, aplikasi teleconference dengan teliti, 

cara menggunakan teleconference dengan tepat 

 

B. Indikator Pencapaian Kompetensi 

1. Menyebutkan pengertian teleconference 

2. Menyebutkan jenis-jenis teleconference 

3. Menyebutkan manfaat teleconference 

4. Dapat menerapkan aplikasi teleconference 

5. Dapat mempraktikan cara menggunakan teleconference 

 

C. Uraian Materi 

1. Pengertian 

Teleconference atau telekonferensi atau teleseminar adalah komunikasi 

langsung di antara beberapa orang yang biasanya dalam jarak jauh atau 

tidak dalam satu ruangan dan dihubungkan oleh suatu sistem 

telekomunikasi. 

Jadi teleconference adalah pertemuan yang dilakukan oleh dua orang atau 

lebih yang dilakukan melewati telefon atau koneksi jaringan. Pertemuan 

tersebut bisa menggunakan suara (audio conference) atau menggunakan 

audio-video (video conference) yang memungkinkan peserta konferensi 
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saling melihat dan mendengar apa yang dibicarakan, sebagaimana 

pertemuan biasa. Dalam telekonferensi juga dimungkinkan menggunakan 

whiteboard yang sama dan setiap peserta mempunyai kontrol terhadapnya, 

juga berbagi aplikasi. 

Sistem telekomunikasi dapat mendukung teleconference karena 

menyediakan satu atau lebih dari berikut ini: audio, video, dan / atau 

layanan data oleh satu atau lebih berarti, seperti telepon, komputer , 

telegraf, teletip, radio, dan televisi. 

Di Indonesia, terdapat beragai layanan teleconference melalui telepon baik 

fixed maupun mobile (Audio Conference) yang mempunyai kemampuan 

untuk melayani percakapan sampai 30 pemanggil dalam satu konferensi. 

Jumlah peserta dapat diatur sesuai dengan keinginan penyelenggara 

konferensi. Sistem conference atau konferensi juga bisa dilengkapi dengan 

PIN (Personal Identification Number) sehingga menjamin kerahasiaan 

suatu konferensi dari pemanggil yang tidak diundang dalam telekonferensi 

atau teleconference tersebut. 

 

2. Jenis-jenis teleconference 

2.1  Audio Conference (Conference Call) 

Audio Conference atau disebut juga conference call adalah 

percakapan dua atau lebih partisipan dengan menggunakan fasilitas 

telepon dimana komunikasi yang terjadi antara partisipan hanya dalam 

bentuk suara (audio). 

Dari semua jenis telekonferensi, Conference Call paling popular 

karena memiliki kelebihan sebagai berikut : 

 Partisipan hanya perlu menggunakan telepon biasa untuk 

melakukan telekonferensi tanpa alat atau software tambahan. 

 Dapat digunakan kapan dan dimana saja tanpa perlu melakukan 

konfigurasi perangkat yang akan digunakan. 

 Tanpa perlu koneksi internet yang cepat. Karena layanan 

panggilan konferensi ini menggunakan jalur telepon, maka anda 

tidak perlu mempunyai jalur koneksi internet yang cepat.  

http://www.kongkow.com/en
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Untuk melakukan conference call, para partisipan diharuskan 

menelepon nomor tertentu yang akan menyambungkan mereka ke 

conference bridge (peralatan khusus yang menghubungkan jalur-jalur 

telepon yang masuk menjadi satu) yang disediakan oleh provider 

conference call. Biasanya ada biaya tambahan yang dikenakan oleh 

provider conference call bagi penggunanya. 

 

a. Video Conference 

Video conference adalah teknologi komunikasi yang mengijinkan 

terjadinya komunikasi dari beberapa lokasi yang berbeda yang secara 

simultan dapat mengirimkan gambar video dan suara. 

Untuk melakukan video conference dapat memanfaatkan teknologi 

jaringan IP (melalui internet) dan teknologi ISDN (Integrated Services 

Digital Network). 

Meskipun video conference memiliki kelebihan dengan adanya 

tampilan visual (video), penggunaan fasilitas telekonferensi ini masih 

kurang populer di Indonesia karena beberapa hal berikut : 

 Dibutuhkan perangkat khusus seperti video input (video camera 

atau webcam) dan video output (monitor), audio input 

(microphone) dan audio output (speaker) serta fasilitas data 

transfer (jaringan telepon ISDN, LAN atau Internet) 

 Biaya yang relatif mahal 

Saat ini video conference lebih banyak digunakan oleh media televisi 

dan perusahaan-perusahaan berskala besar. 

 

b. Web Conference 

Web conference atau biasa juga disebut webinars adalah fasilitas 

telekonferensi interaktif yang menawarkan fitur data stream (aliran 

data) lebih lengkap dimana partisipan dapat berkomunikasi secara 

simultan menggunakan teks, suara, video hingga berbagi file (file 

sharing) atau melakukan slide presentation. 

Untuk menjalankan web conference biasanya menggunakan aplikasi 

(software) khusus yang disediakan oleh provider web conference 
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dengan cara berlangganan, dan memanfaatkan teknologi internet 

khususnya TCP/IP connection. 

Berbeda dengan video conference, untuk melakukan web conference 

cukup menggunakan perangkat komputer yang dilengkapi dengan 

perangkat multimedia yang memadai seperti webcam, microphone dan 

speaker, serta koneksi internet. 

Dengan fitur yang lebih banyak, perangkat web conference lebih 

sederhana dibanding video conference biasa. 

Web conference banyak digunakan untuk kegiatan-kegiatan seperti 

seminar atau workshop online. 

 

3. Manfaat teleconference 

Manfaat Teleconference dalam Konseling 

a. Membantu individu maupun kelompok untuk dapat berkomunikasi 

dengan lebih mudah dan relatif murah dalam pelaksanaan konseling. 

b. Memberikan kesempatan kepada individu untuk berkomunikasi lebih 

baik dengan menggunakan informasi yang mereka terima tanpa perlu 

bertemu secara fisik (cyber counseling). 

c. Memungkinkan konseling tidak merasa malu/canggung yang bisa 

dilakukan kapan dan dimana saja 

d. Walaupun kegiatan konseling dilakukan dengan jarak jauh namun 

kerahasian konseli harus tetap terjaga. 

e. Dapat menghemat waktu konselor karena dapat melakukan layanan 

dimana saja walaupun tempatnya berjauhan 

f. Layanan konseling dapat berlangsung di luar jam praktek maupun di 

saat praktek 

g. Memberikan peluang klien untuk mengakses layanan dari lokasi 

terpencil 

h. Mengurangi kesulitan penjadwalan 
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4. Aplikasi teleconference 

Berikut adalah beberapa aplikasi teleconference: 

a. ooVoo 

ooVoo merupakan aplikasi mengagumkan yang 

sering digunakan untuk melakukan video call, 

bahkan untuk melakukan video call group juga 

bisa. 

Aplikasi ini tidak hanya tersedia untuk Windows, tetapi juga untuk Mac 

dan mudah diakses di iPhone bahkan Ponsel Android. Sekarang, 

ooVoo adalah salah satu dari aplikasi video call gratis yang memiliki 

lebih dari 35 juta pengguna dan memiliki basis penggemar yang sangat 

besar. Di ooVoo, kita bisa video chat dengan 12 orang yang berbeda 

pada saat bersamaan, juga dapat digunakan merekam seluruh video 

chat. 

b. Google Hangouts 

Google Hangouts adalah layanan video chat gratis dari Google yang 

memungkinkan face to face chatting dan chatting kelompok dengan 10 

orang sekaligus. Kedengaranya agak mirip dengan Skype, dan 

Facebook Video Chat, tetapi Google Hangouts lebih berfokus pada 

“face-to-face” interaksi kelompok  video chatting, dan menggunakan 

teknologi canggih. 

Google Hangouts dapat diakses melalui laptop dan komputer desktop 

serta dengan mobile perangkat Android (Android “Gingerbread” v2.3 

keatas) dan perangkat mobile iOS. Selain video chatting, pengguna 

Google Hangouts dapat berbagi dokumen, scratchpads, gambar dan 

video YouTube dengan pengguna lain. Google+ Hangouts juga 

menawarkan “Hangouts on Air” fitur untuk penyiaran percakapan 

video langsung yang dapat diakses siapa saja dengan web browser. 

c. iVisit 

 iVisit memungkinkan anda untuk berbicara tatap muka 

dengan teman, keluarga dan rekan dari mana saja – gratis.  iVisit 

adalah software atau aplikasi lain yang sangat berguna untuk 
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melakukan panggilan video dua arah. Fitur terbaik dari iVisit termasuk 

video dan audio chatting, dan juga kita dapat berbagi dokumen saat 

panggilan dan juga kita dapat melihat desktop orang lain dengan siapa 

kita melakukan panggilan video call. 

iVisit bekerja pada Peer to Peer teknologi jaringan. Ini merupakan 

perangkat lunak panggilan video unik yang sangat berguna untuk 

organisasi anda, karena dapat digunakan untuk melakukan video 

konferensi dengan sampai 8 user. iVisit bekerja pada semua komputer 

PC / laptop dan juga pada semua jenis perangkat mobile. 

d. Skype 

Skype merupakan salah satu software Video Call terbaik yang Gratis, 

karena sangat mudah digunakan untuk melakukan panggilan video call 

dan audio call. Skype tersedia untuk semua jenis sistem operasi 

komputer / laptop dan juga untuk iPhone , iPads , iPod Touch , dan 

juga untuk ponsel yang berbasis Android. Skype baru-baru ini sudah 

dibeli oleh Microsoft , Skype memungkinkan panggilan video call dua 

arah dan menuntut konfigurasi sistem yang sangat lumayan dan 

kecepatan internet. Skype juga memungkinkan untuk melakukan 

berbagi layar dan sekarang juga sudah dapat dipasang di TV anda. 

Skype adalah aplikasi VoIP populer yang mampu membuat panggilan 

video call antara PC  ke PC dan PC  ke Ponsel , asalkan di support 

dengan webcam. Dengan rilisnya Skype 4.0 Beta untuk Windows , 

video chat di Skype jauh lebih baik dari versi sebelumnya, karena 

kompatibilitas  Cross-platform dan hasil videonya lebih halus 

e. Eyeball Chat 

Eyeball Chat adalah software yang sangat bagus dan gratis untuk 

digunakan panggilan video call. Dapat digunakan untuk mengobrol 

berkelompok atau group dan berbagi file. Room Chat  yang tersedia 

di Eyeball Chat yang memungkinkan memudahkan pengguna untuk 

menemukan teman baru. 

Eyeball Chat menawarkan kualitas video chat, pesan video dan pesan 

teks . Aplikasi ini didukung AIM , MSN dan Yahoo! Messenger 

sehingga anda dapat mengirim pesan video dan teks ke teman-teman 

anda yang menggunakan layanan tersebut. 
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Eyeball Chat relatif mudah digunakan , dengan website yang 

sederhana untuk melakukan navigasi , dengan memberikan link di 

depan mata semua informasi yang anda butuhkan. 

f. Yugma 

Yugma merupakan software gratis yang 

bagus karena memberikan solusi dalam 

penggunaan pribadi serta penggunaan 

organisasi untuk web conference. Sekarang sudah tersedia untuk 

Windows, Mac dan Linux dan mudah untuk mendapatkannya . Yugma 

secara luas populer untuk perusahaan iklan online dan organisasi 

lainnya. 

Yugma adalah layanan web gratis yang memungkinkan orang untuk 

langsung terhubung melalui internet untuk berkomunikasi dan berbagi 

konten dan ide. Mudah digunakan untuk sistem Windows , Mac atau 

Linux, Anda dapat menghubungkan on-demand dan real-time dengan 

rekan kerja , klien , teman dan keluarga . Untuk sesi chat lebih dari 20 

orang , pengguna dapat mendaftar dan membayar untuk versi 

premium dari Yugma . Yugma juga tersedia dalam bentuk widget di 

situs Web mereka sehingga chatting bisa dimulai dari situs, dan juga 

telah menerbitkan edisi Yugma Skype. 

g. Ekiga 

Ekiga (sebelumnya dikenal sebagai Gnome Meeting) adalah aplikasi 

VoIP dan video conference untuk GNOME , dan juga berjalan pada 

Windows . Ekiga menggunakan  H.323 dan SIP protocol, dengan 

dukungan  audio dan video codec , dan dapat dioperasikan dengan 

software SIP – compliant dan juga dengan Microsoft NetMeeting . 

Mudah digunakan dalam video call dengan kualitas Graphical User 

Interface yang bagus. Ekiga memungkinkan panggilan video call ke 

telepon rumah dan ponsel juga. Fitur menakjubkan Ekiga adalah 

bahwa hal itu memungkinkan untuk dapat melakukan Call Holding, Call 

Transfering dan Call Forwarding. 

Ekiga memiliki dukungan yang kuat dan luas untuk multimedia, dan 

kompatibel dengan Windows Messenger dan aplikasi VoIP . Ekiga 
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tidak dapat berkomunikasi dengan Skype karena Skype menggunakan 

protokol sendiri yang non-standar  Jika anda memiliki penyedia SIP 

yang cocok , anda juga dapat menggunakan Ekiga untuk digunakan 

sebagai panggilan ke saluran telepon biasa. Selama instalasi Ekiga , 

mungkin perlu untuk mengubah konfigurasi pengaturan router dahulu. 

h. iChat 

iChat (atau iChat AV) adalah sebuah aplikasi perangkat lunak instant 

messaging yang dikembangkan oleh Apple Inc untuk digunakan hanya 

pada sistem operasi Mac OS X.  iChat menawarkan multi-user video 

chat (hingga 4 orang sekaligus), iChat Theater untuk berbagi dan 

melihat file saat video chat, dan fitur Backdrops yang memungkinkan 

pengguna untuk menyesuaikan background di belakang mereka. 

iChat dibuat untuk pengguna Mac, iPhone, atau iPad. Ketika anda 

menginstal iChat AV, perangkat lunak secara otomatis 

mengkonfigurasi dan mengoptimalkan diri untuk setup anda. Tidak ada 

kerumitan atas penyiapan jaringan atau periferal. 

i. Vsee 

Vsee adalah aplikasi gratis untuk Windows Video Conference , selain 

video chat Vsee juga dirancang sebagai alat kolaborasi. Jadi , misal 

anda ingin berkolaborasi dengan rekan pada dokumen Photoshop ( 

bahkan jika orang itu tidak memiliki instalan Photoshop) melalui 

berbagi layar , dan anda dapat berbagi file ( atau dokumen apapun, 

dalam hal ini) oleh men drag file ke dalam video chat anda. VSee bisa 

digunakan untuk video chatt dengan sampai 4 orang secara 

bersamaan , sedangkan versi premium mendukung hingga 8 orang. 

VSee dapat digunakan dengan bandwidth rendah, layanan ini 

memungkinkan beberapa pengguna di berbagai lokasi untuk 

berkomunikasi secara real -time dengan video dan audio antarmuka 

yang mampu secara bersamaan menampilkan wajah video dan 

memungkinkan pengguna membubuhi keterangan pada konten layar 

bersama . VSee mengirimkan video pada kecepatan serendah 50 

kbit/s dan dapat digunakan untuk komunikasi real-time video melalui 

jaringan seluler 3G. 

 



 

 
 
 

142 Modul Paket Keahlian Administrasi Perkantoran - Sekolah Menengah Kejuruan (SMK) 

 

j. TokBox 

TokBox adalah aplikasi video chat berbasis web. Terlepas dari 

homepage standar , di mana anda dapat login dan memulai video chat 

dengan siapapun melalui browser web anda. Dengan TokBox 

memungkinkan setiap orang untuk menambahkan fitur video chat 

group untuk situs blog atau web mereka sendiri. Pengguna dapat men-

download aplikasi OpenTok plug-n-play yang kemudian di instal ke 

blog atau website pribadi mereka. 

 
5. Cara menggunakan teleconference 

Pertama-tama pilih software Microsoft Visual C# 

2005 yang merupakan Integrated Development 

Environment (IDE) yang berbasiskan .NET 

Framework 2.0 SP1. Microsoft Visual C# 

menyediakan Graphical User Interface (GUI) yang mudah didesain dan 

memiliki banyak library yang sangat membantu dalam pembuatan sistem. 

Selain itu, digunakan beberapa library tambahan seperti: 

a. Microsoft Managed DirectShow 

b. ConferenceXP RTP Filter 

c. Microsoft Visual C++ 2005 Redistributable 

d. Windows Media Player 11 Codec 

Pertama kali, user harus memilih jenis IP yang akan digunakan (IPv4 atau 

IPv6) dengan memilih radio button. Untuk memilih IP address, user dapat 

mengklik combo box dan memilih IP yang terdapat pada komputer. Setelah 

itu, user menekan tombol centang yang ada di kanan bawah. 

Jika user diperbolehkan untuk bergabung ke dalam konferensi, akan 

muncul form set destination IP and port. Setelah user mengisi alamat IP 

dan nomor port, user akan tergabung ke dalam konferensi. 

Salah satu aspek yang penting dalam aplikasi video conference adalah 

penggunaan bandwidth, karena aplikasi ini mengirimkan data berupa 

gambar dan suara yang memiliki ukuran yang cukup besar, sehingga untuk 

dapat berjalan dengan lancar, bandwidth yang ada harus mencukupi. 
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D. Aktivitas Pembelajaran 

1. Peserta diklat membaca dengan cermat isi modul 

2. Diskusi dengan sesama peserta diklat apa yang telah dicermati untuk 

mendapatkan pemahaman yang baik mengenai isi modul 

3. Apabila dalam berdiskusi peserta diklat masih mengalami kesulitan, maka 

diskusikan dengan instruktur 

4. Apabila isi modul telah dipahami peserta diklat dapat mengerjakan latihan 

dan tugas praktek yang telah disediakan 

 

E. Latihan/Kasus/Tugas 

1.  Latihan 

a. Jelaskan pengertian teleconference! 

b. Sebutkan jenis-jenis teleconference? 

c. Sebutkan 5 manfaat teleconference dalam konseling? 

d. Sebutkan 5 aplikasi-aplikasi teleconference? 

e. Sebutkan langkah-langkah menggunakan teleconference? 

2. Tugas 

Buatlah suatu pertemuan dengan tekan Anda menggunakan salah satu 

aplikasi teleconference yaitu dengan skype! 

 

F. Rangkuman 

Teleconference atau telekonferensi atau teleseminar adalah komunikasi 

langsung di antara beberapa orang yang biasanya dalam jarak jauh atau tidak 

dalam satu ruangan dan dihubungkan oleh suatu sistem telekomunikasi. 

Jenis-jenis teleconference adalah: 

a. Audio Conference (Conference Call) 

b. Video Conference 

c. Web Conference 
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Manfaat teleconference dalam konseling adalah: 

a. Membantu individu maupun kelompok untuk dapat berkomunikasi dengan 

lebih mudah dan relatif murah. 

b. Memberikan kesempatan kepada individu untuk berkomunikasi tanpa perlu 

bertemu secara fisik. 

c. Memungkinkan konseling tidak merasa malu/canggung yang bisa 

dilakukan kapan dan dimana saja. 

d. Walaupun kegiatan konseling dilakukan dengan jarak jauh namun 

kerahasian konseli harus tetap terjaga. 

e. Dapat menghemat waktu. 

 

Langkah-langkah menggunakan teleconference: 

a. Pilih software Microsoft Visual C# 2005 

b. User harus memilih jenis IP yang akan digunakan (IPv4 atau IPv6) dengan 

memilih radio button 

c. Untuk memilih IP address, user dapat mengklik combo box dan memilih IP 

yang terdapat pada komputer. 

d. Setelah itu, user menekan tombol centang yang ada di kanan bawah. 

e. Jika user diperbolehkan untuk bergabung ke dalam konferensi, akan 

muncul form set destination IP and port. Setelah user mengisi alamat IP 

dan nomor port, user akan tergabung ke dalam konferensi 

G. Umpan Balik dan Tindak Lanjut 

1. Umpan Balik 

Setelah mempelajari kegiatan belajar delapan, peserta diklat diharapkan 

dapat mempraktikkan cara menggunakan aplikasi-aplikasi tele conference 

untuk kegiatan pembelajaran jarak jauh. Praktik teleconference juga dapat 

digunakan dalam pembelajaran pertemuan atau rapat. 

2. Tindak lanjut  

Peserta diklat sudah mengusai kegiatan belajar delapan dapat mengikuti 

evaluasi akhir yang terdapat pada akhir modul ini. Apabila peserta diklat 

belum mengusai kegiatan pembelajaran delapan maka mintalah bimbingan 

dan arahan dari instruktur secara intensif. 
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H. Kunci Jawaban 

1. Teleconference atau telekonferensi atau teleseminar adalah komunikasi 

langsung di antara beberapa orang yang biasanya dalam jarak jauh atau 

tidak dalam satu ruangan dan dihubungkan oleh suatu sistem 

telekomunikasi. 

2. Jenis-jenis teleconference adalah: 

a. Audio Conference (Conference Call) 

b. Video Conference 

c. Web Conference 

3. Manfaat teleconference dalam konseling adalah: 

a. Membantu individu maupun kelompok untuk dapat berkomunikasi 

dengan lebih mudah dan relatif murah dalam pelaksanaan konseling. 

b. Memberikan kesempatan kepada individu untuk berkomunikasi lebih 

baik dengan menggunakan informasi yang mereka terima tanpa perlu 

bertemu secara fisik (cyber counseling). 

c. Memungkinkan konseling tidak merasa malu/canggung yang bisa 

dilakukan kapan dan dimana saja 

d. Walaupun kegiatan konseling dilakukan dengan jarak jauh namun 

kerahasian konseli harus tetap terjaga. 

e. Dapat menghemat waktu konselor karena dapat melakukan layanan 

dimana saja walaupun tempatnya berjauhan 

4. Aplikasi-aplikasi teleconference yaitu; 

ooVoo  Google Hangouts iVisit Skype Eyeball Chat 

5. Langkah-langkah menggunakan teleconference: 

a. Pilih software Microsoft Visual C# 2005 

b. User harus memilih jenis IP yang akan digunakan (IPv4 atau IPv6) 

dengan memilih radio button 

c. Untuk memilih IP address, user dapat mengklik combo box dan 

memilih IP yang terdapat pada komputer. 

d. Setelah itu, user menekan tombol centang yang ada di kanan bawah. 

e. Jika user diperbolehkan untuk bergabung ke dalam konferensi, akan 

muncul form set destination IP and port. Setelah user mengisi alamat 

IP dan nomor port, user akan tergabung ke dalam konferensi. 
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Evaluasi 

 

 

1. Jari Yang digunakan untuk Tombol Q, A & Z pada sistem pengetikan 

sepuluh jari adalah .... 

A. Jari manis -  tangan kiri 

B. Jari tengah - tangan kiri 

C. Jari telunjuk - tangan kiri 

D. Jari kelingking - tangan kiri 

E. Jari manis  - tangan kanan 

2. Jari yang digunakan untuk tombol "spasi" pada sistem pengetikan 

sepuluh jari yang benar adalah ? 

A. Telunjuk kanan 

B. Jari kelingking kanan 

C. Jari tengah kiri 

D. Jari manis kiri 

E. Jari Kelingking Kiri 

3. Dalam pengetikan menggunakan 10 jari tombol E, D, C adalah 

menggunakan jari…. 

A. Telunjuk kanan 

B. Jari kelingking kanan 

C. Jari manis kiri 

D. Jari Kelingking Kiri 

E. Jari tengah kiri 

4. Di bawah ini yang bukan merupakan  hal-hal yang perlu diperhatikan 

dalam mengetik mengunakan 10 jari,adalah..... 

A. Konsentrasi 

B. Kuasai bahasa inggris 

C. Emosi 

D. Pelajari setiap hari 

E. Santai jangan terburu-buru 

5. Di dalam mengetik menggunakan 10 jari telunjuk tangan kanan menekan 

tombol …. 

A. Huruf Y, U, H, J, B, N, M 

B. Huruf I, K,tanda koma dan Angka  



 

 
 
 

Otomasi Kantor | Dasar Pembelajaran yang Mendidik 147 

 

C. Huruf L, O tanda titik dan angka 9 

D. Huruf P, tanda titik koma dan tanda slash 

E. Tombol Space dan Alt 

6. Didalam mengetik 10 jari kelingking kiri menekan tombol.... 

A. Huruf Q. A, Z 

B. Huruf  O, L, M 

C. Huruf P, tanda titik koma dan tanda slash 

D. Huruf  Y, H, N, U, J, M 

E. Huruf E, D, C 

7. Didalam mengetik 10 jari, kelingking kanan menekan tombol .... 

A. Huruf Q, A, Z 

B. Huruf W, S, X 

C. Huruf P, ; , / 

D. Huruf E, D, C 

E. Huruf Y, H, N, U, J, M 

8. Kata “BUKU” diketik menggunakan jari .... 

A. Jari kelingking kanan, jari telunjuk kiri, jari telunjuk kanan, jari manis 

kiri 

B. Jari telunjuk kiri, jari telunjuk kiri, jari tengah kiri, jari manis kanan 

C. Jari telunjuk kiri, jari telunjuk kanan, jari tengah kanan, jari telunjuk 

kanan 

D. Jari manis kiri, jari telunjuk kiri, jari tengah kanan, jari kelingking kiri 

E. Jari telunjuk kiri, jari telunjuk kanan, jari tengah kiri, jari telunjuk 

kanan 

9. Dalam pengetikan menggunakan 10 jari tombol E, D, C adalah 

menggunakan jari…. 

A. Telunjuk kanan 

B. Jari tengah kiri 

C. Jari kelingking kanan 

D. Jari manis kiri 

E. Jari Kelingking Kiri 

10. Jari kelingking tangan kiri digunakan untuk menekan tombol.... 

A. A 

B. B 

C. C 

D. D 

E. E 
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11. Program Aplikasi dari Microsoft Office yang merupakan program 

pengolah kata adalah …. 

A. Ms. Acces 

B. Ms. Excel 

C. Ms. Word 

D. Ms. Powerpoint 

E. Ms. Windows 

12. Untuk menggeser lembar kerja ke atas atau ke bawah menggunakan .... 

A. Layout button    

B. Scroll bar vertikal    

C. Ruller    

D. Scroll bar horizontal    

E. Ribbon 

13. Istilah jarak halaman yang diukur dari tepi kertas bagian atas disebut ... 

Margin 

A. Top 

B. Buttom 

C. Left 

D. Right 

E. Center 

14. Columns terdapat pada Tab ..... 

A. Home 

B. Insert 

C. Page Layout 

D. Reference 

E. Mailings 

15. Ikon yang digunakan untuk membuat huruf pertama pada teks atau 

paragraf menjadi huruf yang lebih   besar dari pada huruf yang lain 

adalah... 

A. Font Style 

B. Autocorrect 

C. Auto Fprmat 

D. Font Color 

E. Drop Cap 

16. Saat kita membuat surat dengan menggunakan Word, submenu yang 

digunakan untuk mengatur jarak baris kedua dan seterusnya pada suatu 

paragraf adalah ..... 

A. Indentasi 

B. First Line 

C. Line Spacing 
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D. Paragraph 

E. Table 

17. Perintah dari keyboard untuk melakukan cetak miring pada tulisan di 

Microsoft Word adalah ..... 

A. Ctrl + I 

B. Ctrl + A 

C. Ctrl + U 

D. Ctrl + C 

E. Ctrl + B 

18. Tab yang digunakan untuk mengatur tampilan halaman dokumen adalah 

.... 

A. Home 

B. Insert 

C. View 

D. Reference 

E. Review 

19. Urutan perintah yang digunakan untuk menyisipkan gambar / foto di 

dokumen Word adalah : ...... 

A. Insert => Chart 

B. Insert => Smart Art 

C. Insert => Shapes 

D. Insert => Clip Art 

E. Insert => Picture 

20. Batas pengetikan pada program Microsoft Word disebut .... 

A. Paragraf 

B. Layout 

C. Page Size 

D. Spacing 

E. Margin 

21. Aplikasi Microsoft Excel termasuk kedalam golongan… 

A. Spreadsheets                                              

B. Database                                                    

C. Bahasa Pemrograman 

D. Word Processor 

E. Antivirus 

22. Microsoft Excel merupakan software terpadu dari keluarga besar… 

A. Worksheet                                                  

B. Workbook                                                    

C. Windows 
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D. Microsoft Office 

E. Microsoft Outlook 

23. Cara lain untuk menyimpan lembar kerja Excel yang aktif adalah… 

A. Ctrl  +  B                                                      

B. Ctrl  +  D                                                      

C. Shift + S 

D. Ctrl + I 

E. Ctrl + S 

24. Suatu daerah pada worksheet yang berbentuk segi empat dan 

merupakan tempat kumpulan beberapa sel disebut …. 

A. sheet 

B. column 

C. range 

D. pointer 

E. gridline 

25. Langkah yang harus dilakukan untuk mengganti nama sheet adalah.... 

A. klik kanan pada sheet – klik rename 

B. klik kanan pada sheet – klik delete 

C. klik kanan pada sheet – klik insert 

D. klik pada sheet – klik rename 

E. klik pada sheet – klik delete 

26. Perintah untuk mencari banyak data terendah adalah… 

A. AVERAGE                                                                        

B. MIN                                                                                    

C. SUMIF 

D. SUM 

E. MAX 

27. Dua pilihan penyimpanan lembar kerja yang disediakan Excel… 

A. Keep dan Save                                                       

B. Write to… dan Save                                           

C. Save dan Save As… 

D. Input dan Save 

E. Keep dan Save As… 

28. Untuk membuat garis atau bingkai setelah perintah Format – Cells , 

dilanjutkan dengan memilih tab.... 

A. Number                                  

B. Alignment                              

C. Font 

D. Border 
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E. Pattern 

29. Fungsi wrap text dalam perintah Format-Cells, Alignment, adalah untuk.... 

A. Mengetengahkan teks 

B. Melipat teks 

C. Menyesuaikan ukuran berdasarkan tinggi dan lebar sel 

D. Menggabung sel 

E. Menghapus sel 

30. Microsoft Excel merupakan program aplikasi yang berfungsi untuk.... 

A. Pengolah kata 

B. Pengolah angka 

C. Desain grafis 

D. Database 

E. Pemrograman 

31. Fungsi SUM untuk mencari total range dari S3 sampai S10 adalah.... 

A. =SUM(J3:J10)             

B. =SUM(S3:S6)              

C. SUM(S3:10) 

D. *SUM(S3:S10) 

E. =SUM(S3:S10) 

32. Perintah untuk membuka lembar kerja dengan tombol keyboard adalah.... 

A. CTRL S 

B. CTRL O 

C. CTRL P 

D. CTRL N 

E. CTRL X 

33. Untuk menempelkan data yang dicopy pada lokasi lain digunakan 

perintah… 

A. Paste                                                                                   

B. Copy                                                                                  

C. Copy As… 

D. Cut 

E. Save 

34. Pertemuan antara kolom dan baris disebut…. 

A. Row 

B. Range 

C. Cell 

D. Column 

E. Merge cell 
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35. Tombol F2 pada program aplikasi pengolah data/Excel berfungsi 

untuk….. 

A. Membuka File 

B. Mengedit data 

C. Menghapus data 

D. Menyimpan data 

E. Mengakhiri lembar kerja 

36. Baris yang digunakan untuk meletakkan rumus disebut…. 

A. Formula bar 

B. Function bar 

C. Name 

D. Tollbar 

E. Function row 

37. Fungsi statistik yang berfungsi untuk menentukan suatu kondisi bernilai 

benar atau salah adalah.... 

A. IF                   

B. LEFT              

C. RIGHT 

D. VLOOKUP 

E. HLOOKUP 

38. Tombol keyboard untuk mencetak hasil kerja ke dalam kertas adalah.... 

A. CTRL N 

B. CTRL X 

C. CTRL W 

D. CTRL P 

E. CTRL Q 

39. Microsoft PowerPoint adalah paket program Microsoft Office yang 

digunakan untuk …. 

A. Membuat pengetikan naskah 

B. Membuat laporan daftar 

C. Membuat grafik 

D. Membuat program computer 

E. Membuat presentasi dalam berbagai tampilan 

40. Lembar kerja pada Microsoft PowerPoint biasa disebut sebagai … 

A. Slide 

B. Clip 

C. Layer 

D. Themes 

E. File 
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41. Untuk menambahkan slide baru dapat dilakukan melalui menu bar … 

A. Insert – Group Slides – New Slides 

B. Button – Insert – New Slides 

C. Home – Group Slides – New Slides 

D. Home – Styles – New Slides 

E. Start – Insert – New Slides 

42. Format file dokumen Microsoft PowerPoint pada umumnya ber-extention 

… 

A. xls 

B. ppt 

C. rft 

D. mdb 

E. doc 

43. Cara menambahkan Bullets and Numbering adalah … 

A. Home – Font – Bullets and Numbering 

B. Home – Editing – Numbering 

C. Home – Styles – Bullets and Numbering 

D. Insert – Paragraph – Bullets and Numbering 

E. Home – Paragraph – Bullets and Numbering 

44. Untuk menampilkan slide presentasi juga dapat dilakukan dengan lebih 

cepat dengan menekan pada keyboard tombol … 

A. F6 

B. F5 

C. Ctrl – A 

D. Enter 

E. Ctrl – Enter 

45. Animasi pergantian slide pada saat ditampilkan disebut … 

A. Efek Slide 

B. Efek animasi 

C. Efek transisi 

D. Media Clip 

E. Group Animasi 

46. Cara menambahkan efek pada teks atau objek adalah … 

A. Animation – Custom Animation – Group Animation – Animated 

B. Effect – Group Animation – Animated – Custom Animated 

C. Animation – Effect – Group Animation – Custom Animated 

D. Home – Group Animation – Animated – Custom Animation 

E. Animation – Group Animation – Animated - Custom Animated 
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47. Yang digunakan untuk menghubungkan antara slide satu dengan slide 

yang lain atau dengan file presentasi yang lain disebut ... 

A. Hyperslide 

B. Action 

C. Transition 

D. Hyperlink 

E. Animasi 

48. Untuk menambahkan teks pada slide, pilih dan klik menu … 

A. Insert – Group Text – Text Box 

B. Insert – Paragraph – Text Box 

C. Home – Group Text – Text Box 

D. Home – Group Text – Font 

E. Insert – Group Text – Font 

49. Cara membuat presentasi dengan master presentasi, klik … 

A. Home – Presentation Views – Slide Master 

B. Home – View – Slide Master 

C. Insert – Presentation Views - Slide Master 

D. View – Insert – Slide Master 

E. View – Presentation Views – Slide Master  

50. Untuk mengatur format teks dengan cara seleksi atau klik teks yang akan 

diedit, kemudian klik menu … 

A. Insert – Group Font 

B. View – Group Font 

C. Home – Text 

D. Home – Group Font 

E. Design – Text 

51. Cara menghapus slide yaitu pilih slide yang akan dihapus kemudian pilih 

menu … 

A. Home – Slides – Delete 

B. Home – Editing – Delete 

C. Insert – Slides – Delete 

D. Insert – Editing – Delete 

E. Editing – Slides – Delete 

52. Yang tidak termasuk dalam menu insert adalah … 

A. Illustrations 

B. Table 

C. Text 

D. Link 

E. Animation 
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53. Cara membuat album foto dengan menambahkan foto album melalui 

menu … 

A. Home – photo album – new photo album 

B. Insert – photo album – new photo album 

C. Insert – picture – new photo album 

D. Insert – image – new photo album 

E. Home – image – new photo album 

54. Salah satu bagian aplikasi Ms. Office yang dapat digunakan untuk 

membantu merancang dan menyajikan   presentasi adalah … 

A. Microsoft Publisher                                  

B. Microsoft Power Point                              

C. Microsoft Word 

D. Microsoft Excell 

E. Microsoft Access 

55. Untuk mendukung presentasi dalam ruangan dengan sekelompok 

peserta, kita dapat menggunakan media berupa ... 

A. Mikroskup                                                

B. Laptop                                                      

C. LCD Projektor 

D. Sinar Laser / sinar X 

E. Lampu senter 

56. Di bawah ini adalah kegunaan Power Point di bidang pelayanan umum, 

kecuali ... 

A. Komunikasi berita                                                

B. Sertifikasi                                                             

C. Training/ Pelatihan 

D. Laporan keuangan 

E. Gambaran sebuah ilham/ ide 

57. Salah satu kegunaan Power Point di bidang Perusahaan adalah ... 

A. Kemajuan proyek (status)                                     

B. Laporan penelitian                                                

C. Training/ pelatihan 

D. Perencanaan bisnis 

E. Untuk mencari keuntungan/ laba perusahaan 

58. Bagian ini berisi salah satu elemen dari menu bar, kecuali … 

A. File 

B. Animations 

C. View 

D. Format 

E. Slide Show 
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59. Aplikasi Microsoft Publisher merupakan program aplikasi Microsoft Office 

yang berfungsi untuk ... 

A. Mengelola kata 

B. Mengelola angka 

C. Mengelola presentasi 

D. Mengelola kegiatan desktop publishing 

E. Mengelola  surat menyurat melalui internet 

60. Salah satu elemen yang paling penting dalam membuat sebuah publikasi 

adalah ... 

A. Halaman 

B. Slide 

C. Objek 

D. Master Page 

E. Page Design 

61. Langkah awal dalam penggunaan aplikasi Microshoft Publisher untuk 

membuat kartu nama (business cards) melakukan prosedur sebagai 

berikut .... 

A. Aktifkan Microshoft Publisher, klik change template,  klik home, klik 

business cards 

B. Aktifkan Microshoft Publisher, klik change template, pilih template, 

klik business cards 

C. Aktifkan Microshoft Publisher, pilih template, klik change template,  

klik home, klik business cards 

D. Aktifkan Microshoft Publisher, pilih pege design, klik change 

template,  klik home, klik business cards 

E. Aktifkan Microshoft Publisher, klik home, Microshoft Publisher, klik 

change template, klik business cards 

62. Cara memindahkan halaman ke halaman lain yaitu dengan cara ... 

A. Home – Find – Replace - Ok 

B. Home – Find – Go To Page – Fill Dialog Page – Ok 

C. Home – Go To Page – Fill Dialog Box – Find – Ok 

D. View – Find – Go To Page – Fill Dialog Page – Ok 

E. View – Go To Page – Fill Dialog Box – Find – Ok 

63. Pada menu manakah Grup schemes berada ... 

 
A. Home 

B. Insert 

C. Page Design 
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D. Mailings 

E. View 

64. Banyak cara yang dapat digunakan untuk merancang dan membuat 

publikasi baru. Diantaranya menggunakan fasilitas Publication by Design 

dengan langkah pertama adalah .... 

A. Klik menu File, kemudian klik pilihan New 

B. Klik pilihan Design Sets pada bagian New from a design 

C. Klik salah satu publikasi yang akan dibuat 

D. Klik pilihan objek publikasi sesuai keinginan 

E. Klik menu, kemudian Microsoft Office, Ms. Publisher 

65. Membuat tulisan tampak sedikit melengkung seperti tulisan dibawah ini 

yaitu dengan cara ... 

  
A. Home – Style 

B. Insert – Draw Text Box 

C. Insert – WordArt 

D. Insert – Objek 

E. Page Design – Change Template 

66. Untuk memindahkan halaman Master adalah .... 

A. Klik menu view - pilih Master Page - klik Add Master Page - New 

Master Page – ok 

B. Klik menu view – pilih page – klik master – klik header & footer – ok  

C. Klik menu insert - Header & Footer – beri halaman – ok 

D. Klik menu insert – page number – beri halaman – ok 

E. Klik menu file – edit business – pilih no yang diinginkan – ok  

67. Berikut ini yang tidak termasuk kedalam untuk memilih teks table-frame 

adalah .... 

A. Memilih keseluruhan isi dari cell yang sedang dikerjakan: Pilih Table 

> Select Cell atau tekan Ctrl+A 

B. Memilih tiap cell pada kolom: Pilih Table > Select > Column 

C. Memilih tiap cell pada row: Pilih Table > Select > Row 

D. Memilih banyak kolom atau row: Klik di bagian cell manapun dan 

tarik (drag) melewati row atau kolom yang ingin Anda pilih. 

Kemudian Table > Select > Row. Tahan tombol Shift apda keybard 

dan tekan tanda panah untuk memperluas bagian yang diseleksi. 

E. Pilih Edit > undo dari menu utama atau tekan Ctrl+Z 
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68. Banyak cara yang dapat digunakan untuk merancang dan membuat 

publikasi baru. Berikut ini yang bukan cara untuk merancang publikasi 

adalah .... 

A. Publication by Wizard 

B. Publication by Design 

C. Bank Publication 

D. Publication crom 

E. Publication from Menu 

69. E-mail adalah singkatan dari …. 

A. Elektric Mail 

B. Extra Mail 

C. Elektronic Mail 

D. Elect Mail 

E. Efective Mail 

70. Mengirimkan email langsung ke sebuah alamat tertentu biasa disebut .... 

A. Carbon Copy  

B. Blind Carbon Copy  

C. Point to Point 

D. Distribution List 

E. Discussion List 

71. E-mail dapat dibedakan menjadi dua, yaitu E-mail berbasis SMTP dan …. 

A. E -mail berbasis POP 

B. E-Mail Berbasis WEB 

C. Ms Outlook Express 

D. Pegasus 

E. Netscape Communicator 

72. Yahoo (mail.yahoo.com), Google (Gmail.google.com), Hotmail 

(www.hotmail.com) merupakan jenis dari …. 

A. E -mail berbasis POP 

B. E-Mail Berbasis WEB 

C. Ms. Outlook Express 

D. Pegasus 



 

 
 
 

Otomasi Kantor | Dasar Pembelajaran yang Mendidik 159 

 

E. Netscape Communicator 

73. Menggunakan peramban web dan menggunakan program pengakses 

surat elektronik (e-mail client) merupakan …. 

A. Jenis e-mail 

B. Cara mengakses e-mail 

C. Langkah-langkah membuat e-mail 

D. Macam-macam e-mail 

E. Langkah-langkah pengiriman e-mail 

74. Pengertian spam dalam sebuah e-mail adalah …. 

A. Tempat file (pesan masuk) 

B. Draft pesan yang Anda simpan 

C. Berisi file (email yang telah Anda kirim) 

D. Berisi email sampah 

E. Message 

75. Untuk mengakhiri sesi e-mail maka kita klik tombol …. 

A. Close 

B. Sign out 

C. Sign in 

D. Back 

E. Open 

76. Perangkat keamanan email yang digunakan untuk mengidentifikasi spam 

yang masuk dan virus email. Dibangun menggunakan platfor .net 2.0 dan 

di desain untuk bekerja sama dengan software spamassasin dan clamav 

merupakan pengertian dari …. 

A. ClamAV/ClamD 

B. SpamAssassin 

C. Message Sniffer 

D. MXScan 

E. MSScan 
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77. Lampiran dalam sebuah e-mail biasa disebut …. 

A. Attachment 

B. Bcc 

C. Cc 

D. Milserver 

E. Enkrip 

78. Tombol Reply yang ada saat membuka e-mail, digunakan untuk ... e-mail. 

A.   Menghapus   

B.   Men-download 

C.   Menutup   

D.   Mengembalikan 

E.   Membalas 

79. Blog merupakan singkatan dari ... 

A. Blogger 

B. Web Blog 

C. Web Log 

D. Log Web 

E. Log 

80. Berikut ini yang bukan merupakan fungsi blog ... 

A. Catatan harian 

B. Media publikasi 

C. Media program perusahaan 

D. Media satu arah 

E. Media dua arah 

81. Berikut ini yang bukan merupakan jenis blog ... 

A. Blog politik 

B. Blog pribadi 

C. Blog bertopik 

D. Blog kesehatan 

E. CMS 
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82. Langkah-langkah membuat blog yang benar adalah ... 

A. Buka situs web www.blogger.com - masukan akun Gmail dan 

password – klik tombol Blog Baru – kemudian isi beberapa kolom 

yang ada 

B. Buka situs web www.blogger.com – klik tombol Blog Baru – 

masukkan akun Gmail dan Password – kemudian isi beberapa 

kolom yang ada 

C. Buka situs web www.blogger.com – klik tombol Blog Baru – 

kemudian isi beberapa kolom yang ada 

D. Buka situs web www.blogger.com – masukkan akun Gmail dan 

password – isi beberapa kolom yang ada 

E. Buka situs web www. Blogger.com – isi beberapa kolom yang ada 

83. Tiga syarat penting dalam membuat blog di bawah ini yang benar, kecuali 

... 
A. Punya email  

B. Memasukkan foto 

C. Memasukkan nama blog 

D. Memilih tempelate 

E. Mengisi format 

84. Apakah kepanjangan dari HTML … 

A.   Hyper Text Mark Up Language 

B.   Hyper Text Mark Language 

C.   Hight Text Mark Up Language 

D.   Hight Text Mark Language 

85. Berikut ini adalah termasuk Software Browser, Kecuali … 

A.   Mozilla Firefox 

B.   Opera 

C.   Netscape Navigator  

D.   Internet Explorer 

E.   Macromedia Dreamweaver 

86. Untuk memasukkan file gambar ke dalam web menggunakan perintah … 

A.   <embed src="…"> 

B.   <embedded src="…"> 

C.   <image src=”…”> 

D. <marquee src=”…”> 

E. <images src=”…”> 

  

http://www.blogger.com/
http://www.blogger.com/
http://www.blogger.com/
http://www.blogger.com/
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87. Berikut ini adalah Software untuk mendisain Halaman Web (Webn Design 

Software), kecuali: 

A.   Adobe Image Ready, 

B.   Macromedia Dreamweaver 

C.   Macromedia Fireworks, 

D.   Microsoft Frontpage  

E.   Google Chrome 

88. Berikut ini adalah Bahasa Pemrograman Web, kecuali: 

A.   PHP,  

B.   JavaScript,  

C.   CSS  

D.   XML 

E.   EXL  

89. Heading HTML mempunyai level ukuran huruf: 

A.   1 sampai 6 

B.   1 sampai 7 

C.   1 sampai 8 

D.   1 sampai 9 

E.   1 sampai 10 

 

90. Software untuk menulis bahasa HTML yang paling sederhana adalah …. 

A.   Ms Word 

B.   Ms Excel 

C.   Ms Powerpoint 

D.   Notepad 

E.   Ms Acces 

91. Untuk memberi warna teks web diatur dengan mengubah nilai atribut …. 

A.   Body 

B.   Title 

C.   Bgcolor 

D.   Fontcolor 

E.   Head 

92. Untuk memberi gambar pada  belakang web diatur dengan mengubah 

nilai atribut …. 

A.   Body background 

B.   Body 

C.   Bgcolor 

D.   Fontcolor 

E.   Head 
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93. Untuk membuat sebuah website dibutuhkan bahasa pemrograman yang 

disebut dengan script. Dan script yang paling mendasar dalam 

pembuatan web adalah: 

A.   Link 

B.   HTML 

C.   Konten 

D.   Jquery 

E.   CSS 

94. Sebelum membuat website atau blog yang bisa langsung dibuka di 

internet, syarat pertama yang harus dimiliki adalah: 

A.   Desain Web/blog 

B.   Email 

C.   Konsep tulisan  

D.   Postingan 

E.   Nomor HP/ Telephone 

95. Bagaimanakah proses komunikasi via teleconference terjadi, kecuali ... 

A. Satu arah 

B. Dua arah 

C. Tiga arah 

D. Empat arah 

E. Banyak arah 

96. Nama lain dari teleconference adalah ... 

A. Telekom 

B. Telepati 

C. Telektex 

D. Teleseminar 

E. Telepon  

97.  Yang bukan termasuk jenis teleconference adalah ... 

A. Audio Conference 

B. Video Conference 

C. Web Conference 

D. Conference Call 

E. Visual Conference 

98. Berikut ini adalah manfaat teleconference ... 

A. Membantu individu maupun kelompok untuk berkomunikasi 

B. Memberikan kesempatan untuk berkomunikasi tanpa perlu bertemu 

secara fisik 

C. Dapat dilakukan dimana dan kapan saja 

D. Kerahasiaan sulit terjaga 

E. Dapat menghemat waktu 
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99. Manakah yang tidak termasuk aplikasi teleconference ... 

A. Google Hangouts 

B. iVisit  

C. Skype 

D. Instagram 

E. ooVoo 

100. Berikut ini adalah langkah-langkah menggunakan teleconference ... 

A. Pilih software notepad – buat skrip – save file 

B. Pilih software Microsoft Visual C# 2005 – pilih jenis IP – pilih IP 

address 

C. Pilih jenis IP – pilih software Microsoft Audio – pilih IP address 

D. Pilih IP address – pilih jenis IP 

E. Langsung memulai konferensi 

  
 
 

Kunci Jawaban 

 

1.  D 
2. C 
3. E 
4. C 
5. A 
6. A 
7. C 
8. C 
9. B 
10. A 
11. C 
12. B 
13. A 
14. C 
15. E 
16. C 
17. A 
18. C 
19. E 
20. E 
21. A 
22. D 
23. E 
24. C 
25. A 

 

26. B 
27. C 
28. B 
29. D 
30. B 
31. B 
32. B 
33. E 
34. B 
35. A 
36. C 
37. B 
38. A 
39. A 
40. D 
41. E 
42. A 
43. A 
44. B 
45. E 
46. B 
47. C 
48. E 
49. D 
50. A 

 

51. E 
52. D 
53. A 
54. E 
55. B 
56. B 
57. C 
58. D 
59. D 
60. A 
61. C 
62. B 
63. C 
64. A 
65. C 
66. A 
67. E 
68. E 
69. C 
70. C 
71. B 
72. B 
73. B 
74. D 
75. B 

 

76. E 
77. A 
78. E 
79. C 
80. E 
81. E 
82. A 
83. B 
84. A 
85. E 
86. C 
87. E 
88. E 
89. A 
90. D 
91. D 
92. A 
93. B 
94. B 
95. A 
96. D 
97. E 
98. D 
99. D 
100. B 
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Penutup 

 

etelah mempelajari modul ini, maka Guru Pembelajar diharapkan dapat 

menguasai cara mengelola otomasi perkantoran yang di dalamnya 

terdapat aplikasi: 

1. Microsoft Word  

2. Microsoft Excel  

3. Microsoft Power Point 

4. Microsoft Publisher 

5. Menggunakan surat elektronik/e-mail 

6. Mengelola blog 

7. Mengelola web 

8. Konferensi Audio (Audio Conference) 

Sehingga aplikasi-aplikasi tersebut diimplementasikan pada pelajaran-pelajaran 

lainnya, seperti administrasi kepegawaian, administrasi keuangan, administrasi 

sarana prasarana serta administrasi humas dan keprotokolan. 

Selain itu, dengan menyelesaikan modul ini pula maka peserta diklat berhak untuk 

mengikuti evaluasi yang telah disediakan. Apabila Guru Pembelajar dinyatakan 

memenuhi syarat kelulusan dari hasil evaluasi dalam modul ini, maka peserta 

diklat berhak untuk melanjutkan ke topik/modul berikutnya. 

 

 

 

  

S 
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Glosarium 

PC : Singkatan Personal Computer, Komputer 

Pribadi. 

Tabel biasa : Lembar kerja sebenarnya hanya berisi tabel 

biasa, yang tidak ada bedanya dengan tabel 

yang diketik dengan MS Word. 

Workbook & Sheet    : Satu workbook dapat terdiri dari banyak Sheet. 

Dapat dimanfaatkan untuk mengorganisasi file 

anda.  Jangan lupa memberi nama pada setiap 

sheet. 

Page Set Up : Pengaturan halaman harus dilakukan secara 

otomatis, bukan dengan memelototi daerah 

worksheet-nya Pengaturan bahwa teks akan 

“Cukup” atau “tidak” dalam satu halaman harus 

dilakukan otomatis. 

Pengolahan Data 

dengan Excel 

: Menghitung dengan rumus-rumus sesuai 

formula, fungsi kalkulasi. 

Formula : Rumus perhitungan, sebuah EKSPRESI 

(seperti pada pemrograman).   Pengetikan 

ekspresi diawali “=“.  Kompo nen Ekspresi : 

alamat (berarti isi yang akan dipakai 

menghitung) konstanta, operator, hasil 

perhitungan fungsi. 

Contoh: =A4+B4-SUM(C4:C7) 

Sort (mengurut)    

 

: Mengurutkan   bisa berdasarkan satu atau 

beberapa kolom. 

Word processing : Penggunaan suatu peralatan elektronic yang 

secara otomatis melakukan beberapa tugas 

yang diperlukan untuk membuat dokumen 

ketik atau cetak. 

Electronic mail : e-mail adalah penggunaan jaringan komputer 

yang memungkinkan pemakai untuk mengirim, 

menyimpan dan menerima pesan dengan 

menggunakan terminal komputer dan 

peralatan penyimpanan. 

Voice mail                          : persis sama dengan electronic mail. 

Perbedaannya bahwa anda hanya 
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mengirimkan pesan dengan mengucapkan 

pesan tersebut melalui telepon dan bukan 

mengetiknya 

Audio conferencing  : penggunaan  peralatan komunikasi suara 

untuk membuat  hubungan audio diantara 

orang-orang yang tersebar secara geografis 

untuk tujuan melakukan konferensi 

Video conferencing : melengkapi   signal   audio  dan  signal  video.   

Peralatan televisi digunakan untuk mengirim 

dan menerima signal audio dan video 

Hotkey / shortcut : Berupa kombinasi beberapa tombol tertentu  

pada keybotomatisasi kantor rd yang 

menyebabkan program aplikasi yang sedang 

berjalan untuk melakukan suatu proses 

tertentu 

Toolbar : perintah-perintah sudah ditampulkan dalam 

grup-grup terpisah 

Ruler  margin (Indent) : digunakan untuk mengatur batas kiri dan 

kanan dari suatu halaman 
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Bagian II : 
Kompetensi Pedagogik 

Kompetensi pedagogik adalah kemampuan guru untuk memahami 

dinamika proses pembelajaran dengan baik. Pembelajaran di ruang 

kelas bersifat dinamis karena terjadi interaksi antara pengajar dengan 

peserta didik, antar sesama peserta didik dan sumber belajar yang ada. 

Pendidik perlu memiliki strategi pembelajaran tertentu agar interaksi 

belajar yang terjadi berjalan efektif untuk mencapai tujuan 

pembelajaran. 
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Pendahuluan 

 

 

A. Latar Belakang 

elajar tidak terjadi begitu saja begitu pula halnya  dengan kegiatan 

mengajar. Mengajar tidak akan terjadi jika tidak ada orang yang 

belajar. Mengajar dan belajar merupakan asas resiprokal. Para guru 

perlu lebih mengetahui dan mengerti mengenai kunci prinsip-prinsip belajar 

dan bagaimana mengaplikasikannya dalam kelas untuk memastikan bahwa 

mereka mengajar dan para siswa belajar.  

Kebanyakan belajar dan pembelajaran formal berlangsung satu arah. Guru 

sangat dominan mengendalikan kegiatan belajar siswa. Guru masih banyak 

memberikan ceramah ( teaher centered ) sementara siswa harus mengikuti 

perintah guru sebagai pendengar. Namun apa sebenarnya yang terjadi dalam 

proses pembelajaran, bukankah yang mestinya aktif dalam kegiatan belajar 

itu  adalah peserta didik. Ada banyak alasan mengapa belajar aktif harus 

diterapkan kapanpun. Salah satunya karena proses belajar terjadi di dalam 

diri orang yang belajar. Menurut ahli pendidikan, mereka yang belajar sudah 

memiliki pengetahuan  ataupun pengalaman sebelumnya yang dapat 

dikembangkan. Melalui belajar aktif, para siswa dapat berinteraksi dengan 

sesamanya, dengan objek, fenomena alam, lingkungan dan manusia serta hal 

ini memungkinkan mereka untuk merefleksikan, merekayasa ulang dalam 

upaya mengembangkan pengetahuan dan pengalaman yang telah diperoleh 

sebelumnya untuk menghasilkan yang lebih baru. Ketika proses ini terjadi, 

disinilah proses belajar terjadi.   

Pembelajaran dengan pendekatan saintifik adalah sebuah pendekatan yang 

membantu guru dan siswa memahami apa sebenarnya belajar itu. Peran guru   

sebagai fasiltator untuk kegitan belajar siswa. Siswalah yang harus aktif 

mengamati peristiwa yang terjadi, mengajukan pertanyaan, mengumpulkan 

B 
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informasi, mengolah informasi , dan mengomunikasikan apa yang telah siswa 

lakukan. Hal tersebut akan meningkatkan  motivasi siswa ketika  mereka  

memahami  apa yang mereka pelajari. 

Pendekatan saintifik  merupakan sebuah pendekatan yang direkomendasikan 

oleh Departemen Pendidikan dan kebudayaan sehubungan dengan 

diberlakukannya kurikulum 2013. Selain itu dikembangkan juga berbagai 

model pembelajaran yang seirama dengan   pendekatan pembelajaran 

saintifik yaitu model pembelajaran penemuan, model pembelajaran berbasis 

proyek, dan model pembelajaran berbasis masalah. 

Modul diklat PKB bagi guru dan tenaga kependidikan ini merupakan acuan 

bagi penyelenggara pendidikan dan pelatihan dalam memfasilitasi 

pencapaian kompetensi dalam pelatihan yang diperlukan guru pada saat 

melaksanakan kegiatan PKB 

 

B. Tujuan 

Setelah menyelesaikan modul ini, diharapkan Anda dapat: 

1. Menjelaskan konsep dasar teori belajar 

2. Menjelaskan prinsip-prinsip  pembelajaran yang mendidik. 

3. Menjelaskan konsep dasar pendekatan saintifik 

4. Merancang pendekatan saintifik. 

5. Menjelaskan konsep dasar model pembelajaran penemuan. 

6. Merancang model pembelajaran penemuan. 

7. Menjelaskan konsep dasar model pembelajaran berbasis proyek. 

8. Merancang model pembelajaran berbasis proyek. 

9. Menjelaskan konsep dasar model pembelajaran berbasis masalah. 

10. Merancang model pembelajaran berbasis masalah. 
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C. Peta Kompetensi 

 

 

D. Ruang Lingkup 

Untuk mencapai tujuan yang diharapkan, bahan ajar berbentuk modul ini 

terbagi dalam tiga (3) kegiatan pembelajaran sebagai berikut: 

1. Teori dan prinsip-prinsip  belajar. 

2. Pendekatan/ model pembelajaran  

 

 

 

Melakukan tindakan reflektif untuk peningkatan kualitas 
pembelajaran

Memanfaatkan hasil penilaian dan evaluasi untuk 
kepentingan pembelajaran

Menyelenggarakan penilaian dan evaluasi proses dan 
hasil belajar

Berkomunikasi secara efektif, empatik, dan santun 
dengan peserta didik

Memfasilitasi pengembangan potensi peserta didik untuk 
mengaktualisasikan berbagai potensi yang dimiliki

Memanfaatkan teknologi informasi dan komunikasi 
untuk kepentingan pembelajaran

Menyelenggarakan pembelajaran yang mendidik

Mengembangkan kurikulum yang terkait dengan mata 
pelajaran yang diampu

Menguasai teori belajar dan prinsip-prinsip 
pembelajaran yang mendidik

Menguasai karakteristik pserta didik dari aspek fisik, 
moral, spiritual, sosial, kultural, emosional dan intelektual
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E. Cara Penggunaan Modul 

Modul ini terdiri dari materi pelatihan yang dikemas dalam suatu unit program 

pembelajaran yang terencana agar Anda dapat mempelajari secara mandiri. 

Saran penggunaan modul adalah: 

1. Pelajari uraian materi yang berupa paparan fakta/data, konsep, prinsip, 

dalil , teori, prosedur, keterampilan, hukum dan nilai-nilai. 

2. Kerjakan aktivitas pembelajaran untuk memantapkan pengetahuan, 

keterampilan serta nilai dan sikap yang terkait dengan uraian materi. 

3. Isi latihan untuk memfasilitasi anda menganalisis untuk berpikir dan 

bersikap kritis. 

4. Baca ringkasan yang merupakan sari pati dari uraian materi kegiatan 

pembelajaran untuk memperkuat pencapaian tujuan kegiatan 

pembelajaran. 

5. Tulis umpan balik , rencana pengembangan dan implementasi dari 

kegiatan belajar pada halaman yang tersedia sebagai tindak lanjut 

kegiatan pembelajaran. 

6. Cocokkan hasil latihan/kasus/tugas pada kunci jawaban untuk mengukur 

tingkat pemahaman dan keberhasilan anda. 

7. Bila sudah mempelajari dan berlatih seluruh kegiatan pembelajaran, isikah 

evaluasi akhir modul untuk mengukur tingkat penguasaan anda pada 

keseluruhan modul ini. 

Bila Anda kesulitan terhadap istilah/kata-kata/frase yang berhubungan 

dengan materi pembelajaran, Anda dapat melihat pada daftar glosarium yang 

tersedia pada modul ini. 
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Kegiatan Pembelajaran 1 

Teori belajar, Prinsip-Prinsip 

Belajar 

 

 

A. Tujuan 

Setelah mempelajari kegiatan pembelajaran 1, diharapkan Anda dapat 

memahami teori belajar, prinsip-prinsip belajar. 

 

B. Indikator Pencapaian Kompetensi 

Anda dinyatakan telah menguasai kompetensi pada kegiatan pembelajaran 

ini apabila telah menunjukkan kinerja sebagai berikut: 

1. Menjelaskan teori belajar  

2. Menjelaskan prinsip-prinsip belajar 

3. Menganalisis  implikasi prinsip-prinsip belajar dalam proses pembelajaran 
 
 

C. Uraian Materi 

1. Pengertian  

Belajar merupakan suatu proses usaha sadar yang dilakukan oleh individu 

untuk suatu perubahan dari tidak tahu menjadi tahu , dari tidak memiliki 

sikap menjadi bersikap benar , dari tidak terampil menjadi terampil 

melakukan sesuatu .  Belajar tidak hanya sekedar memetakan 

pengetahuan atau informasi yang disampaikan,   namun bagaimana 

melibatkan individu secara aktif  membuat atau pun merevisi hasil belajar 

yang diterimanya menjadi suatu pengalamaan yang bermanfaat bagi 

pribadinya.   

 

  

Kompetensi 
Pedagogik 
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2. Macam-Macam Teori Belajar 

Teori belajar adalah upaya untuk menggambarkan atau menjelaskan 

secara logis tentang  bagaimana orang  belajar.  Mengingat kompleksnya 

peristiwa belajar maka  munculah  berbagai macam teori belajar. 

Secara garis besar ada tiga kategori utama atau tiga kerangka filosofis 

mengenai teori-teori belajar, yaitu teori belajar behaviorisme, teori belajar 

kognitivisme, dan teori belajar konstruktivisme.  

a. Teori belajar Behaviorisme 

Teori behavioristik adalah sebuah teori yang dicetuskan oleh Gagne 

dan Berliner tentang perubahan tingkah laku sebagai hasil dari 

pengalaman. Teori ini lalu berkembang menjadi aliran psikologi belajar 

yang berpengaruh terhadap arah pengembangan teori dan praktik 

pendidikan dan pembelajaran yang dikenal sebagai aliran 

behavioristik. Aliran ini menekankan pada terbentuknya perilaku yang 

tampak sebagai hasil belajar. 

Teori Behavioristik  memandang belajar sebagai proses perubahan  

dalam  tingkah laku sebagai akibat dari interaksi antara stimulus dan 

respon.  Atau dengan kata lain belajar adalah perubahan yang dialami 

siswa dalam hal kemampuannya untuk bertingkah laku dengan cara 

yang baru sebagai hasil interaksi antara stimulus dan respon. 

(Hamzah Uno, 7: 2006).  

b. Teori belajar kognitivisme 

Teori belajar kognitivisme mulai berkembang pada abad terakhir 

sebagai protes terhadap teori perilaku yang  telah berkembang 

sebelumnya. Model kognitif ini memiliki perspektif bahwa para peserta 

didik memproses infromasi dan pelajaran melalui upayanya 

mengorganisir, menyimpan, dan kemudian menemukan hubungan 

antara pengetahuan yang baru dengan pengetahuan yang telah ada. 

Model ini menekankan pada bagaimana informasi diproses. 

c. Teori belajar Kontruktivisme 

Kontruksi berarti bersifat membangun, dalam konteks filsafat 

pendidikan dapat diartikan Konstruktivisme adalah suatu upaya 

membangun tata susunan hidup yang berbudaya modern. 

http://belajarpsikologi.com/teori-belajar-behaviorisme/
http://belajarpsikologi.com/
http://belajarpsikologi.com/macam-macam-metode-pembelajaran/
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Konstruktivisme merupakan landasan berfikir (filosofi) pembelajaran 

konstektual yaitu bahwa pengetahuan dibangun oleh manusia sedikit 

demi sedikit, yang hasilnya diperluas melalui konteks yang terbatas 

dan tidak sekonyong-konyong. 

Pengetahuan bukanlah seperangkat fakta-fakta, konsep, atau kaidah 

yang siap untuk diambil dan diingat. Manusia harus mengkontruksi 

pengetahuan itu dan memberi makna melalui pengalaman nyata. 

 
3. Prinsip-Prinsip Belajar dan Implikasinya Bagi Guru  

Dalam kegiatan belajar mengajar, seorang guru harus menggunakan 

teori-teori dan prinsip-prinsip belajar tertentu agar dapat membimbing 

aktivitasnya  dalam merencanakan dan melaksanakan kegiatan belajar 

mengajar.  Prinsip-prinsip belajar yang relatif berlaku umum adalah hal-

hal yang berkaitan dengan antara lain :   

a. Perhatian dan motivasi 

Perhatian terhadap pelajaran akan timbul pada siswa apabila bahan 

pelajaran itu dirasakan sebagai sesuatu yang dibutuhkan, diperlukan 

untuk belajar lebih lanjut atau diperlukan dalam kehidupan sehari-hari. 

Motivasi adalah tenaga yang digunakan untuk menggerakkan dan 

mengarahkan aktivitas seseorang. Menurut H.L. Petri, “motivation is 

the concept we use when we describe the force action on or within an 

organism to initiate and direct behavior”.  

Implikasinya: 

Implikasi prinsip perhatian bagi guru tampak pada perilaku-perilaku 

sebagai berikut: 

 Guru menggunakan metode secara bervariasi 

 Guru menggunakan media sesuai dengan tujuan belajar dan 

materi yang diajarkan 

 Guru menggunakan gaya bahasa yang tidak monoton 

 Guru mengemukakan pertanyaan-pertanyaan membimbing 

(direction question) 

http://belajarpsikologi.com/pentingnya-media-dalam-pembelajaran/
http://belajarpsikologi.com/pentingnya-media-dalam-pembelajaran/
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Sedangkan implikasi prinsip motivasi bagi guru tampak pada perilaku-

perilaku yang diantaranya adalah: 

 Memilih bahan ajar sesuai minat siswa  

 Menggunakan metode dan teknik mengajar yang disukai siswa 

 Mengoreksi sesegera mungkin pekerjaan siswa dan sesegera 

mungkin memberitahukan hasilnya kepada siswa 

 Memberikan pujian verbal atau non verbal terhadap siswa yang 

memberikan respons terhadap pertanyaan yang diberikan 

 

b. Keaktifan  

Belajar tidak dapat dipaksakan oleh orang lain dan juga tidak dapat 

dilimpahkan kepada orang lain. Belajar hanya mungkin terjadi apabila 

anak aktif mengalaminya sendiri. John Dewey mengemukakan bahwa 

belajar adalah menyangkut apa yang harus dikerjakan siswa untuk 

dirinya sendiri, maka inisiatif harus datang sendiri. Guru sekedar 

pembimbing dan pengarah. 

Implikasinya: 

Untuk dapat menimbulkan keaktifan belajar pada diri siswa, maka guru 

di antaranya dapat melaksanakan perilaku-perilaku berikut: 

 Menggunakan multimetode dan multimedia 

 Memberikan tugas secara individual dan kelompok 

 Memberikan kesempatan pada siswa melaksanakan eksperimen 

dalam kelompok kecil (beranggota tidak lebih dari 3 orang) 

 Memberikan tugas untuk membaca bahan belajar, mencatat hal-

hal yang kurang jelas 

 Mengadakan tanya jawab dan diskusi 

 

c. Keterlibatan langsung/berpengalaman 

Menurut Edgar Dale, dalam penggolongan pengalaman belajar yang 

dituangkan dalam kerucut pengalamannya, mengemukakan bahwa 

belajar yang paling baik adalah belajar dari pengalaman langsung. 

Belajar secara langsung dalam hal ini tidak sekedar mengamati secara 

langsung melainkan harus menghayati, terlibat langsung dalam 
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perbuatan, dan bertanggung jawab terhadap hasilnya. Belajar harus 

dilakukan siswa secara aktif, baik individual maupun kelompok dengan 

cara memecahkan masalah (problem solving).  

Implikasinya 

Perilaku guru sebagai implikasi prinsip keterlibatan 

langsung/berpengalaman diantaranya adalah: 

 Merancang kegiatan pembelajaran yang lebih banyak pada 

pembelajaran individual dan kelompok kecil 

 Mementingkan eksperimen langsung oleh siswa dibandingkan 

dengan demonstrasi 

 Menggunakan media yang langsung digunakan oleh siswa 

 Memberikan tugas kepada siswa untuk mempraktekkan gerakan 

psikomotorik yang dicontohkan 

 Melibatkan siswa mencari informasi/pesan dari sumber informasi 

di luar kelas atau luar sekolah 

 Melibatkan siswa dalam merangkum atau menyimpulkan informasi 

pesan pembelajaran 

 

d. Pengulangan 

Menurut teori psikologi daya, belajar adalah melatih daya-daya yang 

ada pada manusia yang terdiri atas mengamat, menanggap, 

mengingat, mengkhayal, merasakan, berpikir, dan sebagainya. 

Dengan mengadakan pengulangan maka daya-daya tersebut akan 

berkembang. 

Implikasinya 

Perilaku guru yang merupakan implikasi prinsip pengulangan di 

antaranya: 

 Merancang pelaksanaan pengulangan  

 Mengembangkan/merumuskan soal-soal latihan 

 Mengembangkan petunjuk kegiatan psikomotorik yang harus 

diulang 

 Mengembangkan alat evaluasi kegiatan pengulangan 

 Membuat kegiatan pengulangan yang bervariasi 
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e. Tantangan 

Tantangan yang dihadapi dalam bahan belajar membuat siswa 

bergairah untuk mengatasinya. Bahan belajar yang baru, yang banyak 

mengandung masalah yang perlu dipecahkan membuat siswa 

tertantang untuk mempelajarinya.  

Implikasinya 

Perilaku guru yang merupakan implikasi prinsip tantangan diantaranya 

adalah: 

 Merancang dan mengelola kegiatan eksperimen yang memberikan 

kesempatan kepada siswa untuk melakukannya secara individual 

atau dalam kelompok kecil (3-4 orang) 

  Memberikan tugas pada siswa memecahkan masalah yang 

membutuhkan informasi dari orang lain di luar sekolah sebagai 

sumber informasi 

 Menugaskan kepada siswa untuk menyimpulkan isi pelajaran yang 

selesai disajikan  

  Mengembangkan bahan pembelajaran (teks, hand out, modul, 

dan yang lain) yang memperhatikan kebutuhan siswa untuk 

mendapatkan tantangan di dalamnya, sehingga tidak harus semua 

pesan pembelajaran disajikan secara detail tanpa memberikan 

kesempatan siswa mencari dari sumber lain. 

 Membimbing siswa untuk menemukan fakta, konsep, prinsip, dan 

generalisasi sendiri 

 Guru merancang dan mengelola kegiatan diskusi untuk 

menyelenggarakan masalah-masalah yang disajikan dalam topik 

diskusi 

 

f. Balikan dan penguatan 

Prinsip belajar yang berkaitan dengan balikan dan penguatan terutama 

ditekankan oleh teori belajar Operant Conditioning dari B.F. Skinner. 

Kalau pada teori conditioning yang diberi kondisi adalah stimulusnya, 

maka pada operant conditioning yang diperkuat adalah responnya. 

Kunci dari teori belajar ini adalah law of effect Thorndike.  
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Siswa belajar sungguh-sungguh dan mendapatkan nilai yang baik 

dalam ulangan. Nilai yang baik itu mendorong anak untuk belajar lebih 

giat lagi. Nilai yang baik dapat merupakan Operant Conditioning atau 

penguatan positif. Sebaliknya, anak yang mendapat nilai yang jelek 

pada waktu ulangan akan merasa takut tidak naik kelas. Hal ini juga 

bisa mendorong anak untuk belajar lebih giat. Inilah yang disebut 

penguatan negatif atau Escape Conditioning.  

Implikasinya : 

Implikasi prinsip balikan dan penguatan bagi guru, berwujud perilaku-

perilaku yang diantaranya adalah: 

 Memberitahukan jawaban yang benar setiap kali mengajukan 

pertanyaan yang telah dijawab siswa secara benar ataupun salah 

 Mengoreksi pembahasan pekerjaan rumah yang diberikan kepada 

siswa pada waktu yang telah ditentukan  

 Memberikan catatan-catatan pada hasil kerja siswa (berupa 

makalah, laporan, klipping pekerjaan rumah) berdasarkan hasil 

koreksi guru terhadap hasil kerja pembelajaran 

 Membagikan lembar jawaban tes pelajaran yang telah dikoreksi 

oleh guru, disertai skor dan catatan-catatan bagi pebelajar 

 Mengumumkan atau mengkonfirmasikan peringkat yang diraih 

setiap siswa berdasarkan skor yang dicapai dalam tes 

 Memberikan anggukan atau acungan jempol atau isyarat lain 

kepada siswa yang menjawab dengan benar pertanyaan yang 

disajikan guru. 

 Memberikan hadiah/ganjaran kepada siswa yang berhasil 

menyelesaikan tugas 

 

g. Perbedaan individu 

Siswa merupakan individual yang unik, artinya tidak ada dua orang 

siswa yang sama persis, tiap siswa memiliki perbedaan satu dengan 

yang lainnya. Perbedaan belajar ini berpengaruh pada cara dan hasil 

belajar siswa. Sistem pendidikan klasikal yang dilakukan di sekolah 

kita kurang memperhatikan masalah perbedaan individual, umumnya 
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pelaksanaan pembelajaran di kelas dengan melihat siswa sebagai 

individu dengan kemampuan rata-rata, kebiasaan yang kurang lebih 

sama, demikian pula dengan pengetahuannya. 

Implikasinya: 

Implikasi prinsip perbedaan individual bagi guru berwujud perilaku-

perilaku yang diantaranya adalah: 

 Menentukan penggunaan berbagai metode yang diharapkan dapat 

melayani kebutuhan siswa sesuai karakteristiknya 

  Merancang pemanfaatan berbagai media dalam menyajikan 

pesan pembelajaran  

 Mengenali karakteristik setiap siswa sehingga dapat menentukan 

perlakuan pembelajaran yang tepat bagi siswa yang bersangkutan  

 Memberikan remediasi ataupun pertanyaan kepada siswa yang 

membutuhkan 

 

D. Aktivitas Pembelajaran 

 

Petunjuk! 

a. Buat kelompok yang terdiri dari 3 – 5 orang. 

b. Anda diminta untuk mendiskusikan 3 teori belajar 

c. Hasil diskusi kelompok dituliskan pada lembar kerja (LK.1) dan 

dipaparkan di depan kelas. 

 

 

Petunjuk! 

a. Buat kelompok yang terdiri dari 3 – 5 orang  

b. Anda diminta untuk mengkaji prinsip-prinsip belajar  

c. Hasil kajian ditulis pada LK 2 kemudian presentasikan/paparkan hasil 

diskusi di depan kelas! 

Aktivitas  Belajar 1 

Aktivitas  Belajar 2 
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E. Latihan/Kasus/Tugas 

Uraiakan tahapan belajar pada  gambar di bawah ini ! bagaimana peran guru dan 

peran siswa dalam tahapan belajar . Siapakah yang seharusnya aktif dalam 

kegiatan belajar. 

 

Gambar 19. Tahapan Belajar 

F. Rangkuman 

 Belajar dan mengajar merupakan kegiatan yang saling 

berhubungan.Kegiatan mengajar tidak mungkin terjadi tanpa ada orang 

yang belajar. Oleh karena itu dalam kegiatan mengajar guru perlu 

memahami bagaiman proses yang terjadi pada diri orang yang belajar. 

 Penjelasan tentang bagaimana proses  belajar melahirkan berbagai teori 

belajar. Ada tiga teori belajar yang menjelaskan tentang peristiwa belajar 

yaitu teori belajar behaviorisme, kognitivisme, dan konstruktivisme. 

 Belajar merupakan  proses perubahan tingkah laku pada setiap individu 

yang belajar . Perubahn tersebut berupa perubahan pengetahuan, sikap, 

maupun keterampilan. 

 Prinsip-prinsip belajar yang berlaku umum adalah : 1. Perhatian dan 

motivasi, 2. Keaktivan, 3. Keterlibatan langsung,4. Pengulangan, 5. 

Tantangan,6. Balikan dan penguatan,7. Perbedaan individual. 
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G. Umpan Balik dan Tindak Lanjut 

Mohon untuk mengisi lembar umpan balik dan tindak lanjut  di bawah ini 

berdasarkan materi pelatihan yang Anda  sudah pelajari.  

1. Hal-hal apa saja yang sudah saya pahami terkait dengan materi pelatihan 

ini ? 

............................................................................................................... 

2. Apa saja yang telah saya lakukan yang ada hubungannya dengan materi 

kegiatan ini tetapi belum ditulis pada materi pelatihan ini? 

............................................................................................................... 

3. Manfaat apa saja yang saya peroleh dari materi pelatihan ini untuk 

menunjang keberhasilan tugas pokok dan fungsi sebagai guru SMK? 

............................................................................................................... 

4. Langkah-langkah apa saja yang perlu ditempuh untuk menerapkan materi 

pelatihan ini dalam rangka meningkatkan mutu pembelajaran pada mata 

pelajaran yang saya ampu? 

............................................................................................................... 
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Kegiatan Pembelajaran 2 

Pendekatan / Model 

Pembelajaran 

 

 

A. Tujuan 

Setelah  mempelajari dan menyelesaikan tugas pada kegiatan pembelajaran  

ini Anda mampu: 

1. Merancang pendekatan pembelajaran  saintifik sesuai mata pelajaran/ 

paket keahlian yang diampu. 

2. Merancang model pembelajaran penemuan 

3. Merancang model pembelajaran berbasis proyek 

4. Merancang model pembelajaran berbasis masalah 

 

B. Indikator Pencapaian Kompetensi 

Anda dinyatakan telah menguasai kompetensi pada kegiatan pembelajaran 

ini apabila telah menunjukkan kinerja sebagai berikut: 

1. Menjelaskan konsep pendekatan saintifik 

2. Merancang pembelajaran saintifik.  

3. Menjelaskan konsep dasar model pembelajaran penemuan. 

4. Merancang model pembelajaran penemuan. 

5. Menjelaskan konsep dasar model pembelajaran berbasis proyek. 

6. Merancang model pembelajaran berbasis proyek. 

7. Menjelaskan konsep dasar model pembelajaran berbasis masalah. 

8. Merancang model pembelajaran berbasis masalah. 
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C. Uraian Materi 

1. Pendekatan Pembelajaran Saintifik 

a. Konsep Dasar Pendekatan Saintifik 

Pendekatan saintifik 

adalah proses 

pembelajaran yang 

dirancang  agar  peserta 

didik secara aktif 

mengonstruksikan 

konsep, hukum atau 

prinsip melalui tahapan-

tahapan mengamati 

(untuk mengidentifikasi 

atau menemukan 

masalah), merumuskan 

masalah, mengajukan 

atau merumuskan hipotesis, mengumpulkan data dengan berbagai 

teknik, menganalisis data, menarik kesimpulan dan 

mengomunikasikan konsep, hukum atau prinsip yang “ditemukan”.  

Untuk dapat disebut ilmiah, metode pencarian (method of inquiry) 

harus berbasis pada bukti-bukti dari objek yang dapat diobservasi, 

empiris, dan terukur dengan prinsip-prinsip penalaran yang spesifik. 

Metode ilmiah pada umumnya memuat serangkaian aktivitas 

pengumpulan data melalui observasi atau ekperimen, mengolah 

informasi atau data, menganalisis, kemudian memformulasi, dan 

menguji hipotesis. 

Dalam proses pembelajaran harus  menyentuh tiga ranah,  yaitu sikap, 

pengetahuan dan keterampilan. Pembelajaran dengan pendekatan 

saintifik, ranah sikap mencangkup transformasi substansi atau materi 

ajar agar anak didik “tahu mengapa”. Ranah keterampilan 

mencangkup substansi atau materi ajar agar anak didik “tahu 

bagaimana”. Sedangkan ranah pengetahuan mencangkup 

 

Gambar 20. Keterkaitan Sikap, 
Pengetahuan, Keterampilan 

https://donipengalaman9.files.wordpress.com/2014/08/saintifik.jpg
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transformasi substansi atau materi ajar anak didik “tahu apa”. Ketiga 

ranah tersebut dapat digambarkan sebagai berikut : 

Jika dilihat dari beberapa teori belajar yang ada pendekatan saintifik 

sangat relevan dengan tiga teori belajar yaitu teori Bruner, teori Piaget, 

dan teori Vygotsky.   

 Teori belajar Bruner disebut juga teori belajar penemuan. Ada 

empat hal pokok berkaitan dengan teori belajar Bruner (dalam 

Carin & Sund, 1975). Pertama, 

individu hanya belajar dan 

mengembangkan pikirannya 

apabila ia menggunakan 

pikirannya. Kedua, dengan 

melakukan proses-proses kognitif 

dalam proses penemuan, siswa 

akan memperoleh sensasi dan 

kepuasan intelektual yang 

merupakan suatau penghargaan intrinsik. Ketiga, satu-satunya 

cara agar seseorang dapat mempelajari teknik-teknik dalam 

melakukan penemuan adalah ia memiliki kesempatan untuk 

melakukan penemuan. Keempat, dengan melakukan penemuan 

maka akan memperkuat retensi ingatan. Empat hal di atas adalah 

bersesuaian dengan proses kognitif yang diperlukan dalam 

pembelajaran menggunakan pendekatan saintifik. 

 Teori Piaget, menyatakan bahwa belajar berkaitan dengan 

pembentukan dan perkembangan skema (jamak skemata). Skema 

adalah suatu struktur mental atau struktur kognitif yang dengannya 

seseorang secara intelektual beradaptasi dan mengkoordinasi 

lingkungan sekitarnya (Baldwin, 1967). Skema tidak pernah 

berhenti berubah, skemata seorang anak akan berkembang 

menjadi skemata orang dewasa. Proses yang menyebabkan 

terjadinya perubahan skemata disebut dengan adaptasi. Proses 

terbentuknya adaptasi ini dapat dilakukan dengan dua cara yaitu 

asimilasi dan akomodasi. Asimilasi merupakan proses kognitif 

 

Gambar 21. Pembelajaran Penemuan 
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yang dengannya seseorang 

mengintegrasikan stimulus yang 

dapat berupa persepsi, konsep, 

hukum, prinsip ataupun 

pengalaman baru ke dalam 

skema yang sudah ada didalam 

pikirannya. Akomodasi dapat 

berupa pembentukan skema 

baru yang dapat cocok dengan 

ciri-ciri rangsangan yang ada 

atau memodifikasi skema yang 

telah ada sehingga cocok 

dengan ciri-ciri stimulus yang ada. Dalam pembelajaran diperlukan 

adanya penyeimbangan atau ekuilibrasi antara asimilasi dan 

akomodasi.  

 

 Vygotsky, dalam teorinya  

menyatakan bahwa 

pembelajaran terjadi apabila 

peserta didik bekerja atau 

belajar menangani tugas-tugas 

yang belum dipelajari namun 

tugas-tugas itu masih berada 

dalam jangkauan kemampuan 

atau tugas itu berada dalam 

zone of proximal development 

daerah terletak antara tingkat 

perkembangan anak saat ini 

yang didefinisikan sebagai 

kemampuan pemecahan 

masalah di bawah bimbingan orang dewasa atau teman sebaya 

yang lebih mampu. (Nur dan Wikandari, 2000:4). 

  

 

Gambar 22. Perkembangan Berpikir Anak 

 

Gambar 23. Perkembangan Bahasa dan 
Berpikir 
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b. Prinsip-prinsip pembelajaran  pendekatan saintifik 

Permendikbud No.103 tahun 2014 mencantumkan  beberapa prinsip  

pendekatan saintifik dalam kegiatan pembelajaran yaitu : 

 Peserta didik difasilitasi untuk mencari tahu;  

 Peserta didik belajar dari berbagai sumber belajar; 

 Proses pembelajaran menggunakan pendekatan ilmiah;  

 Pembelajaran berbasis kompetensi;  

 Pembelajaran terpadu; 

  Pembelajaran yang menekankan pada jawaban divergen yang 

memiliki kebenaran multi dimensi; 

  Pembelajaran berbasis keterampilan aplikatif; 

  Peningkatan keseimbangan, kesinambungan, dan keterkaitan 

antara hard-skills dan soft-skills;  

 Pembelajaran yang mengutamakan pembudayaan dan 

pemberdayaan peserta didik sebagai pembelajar sepanjang hayat;  

 Pembelajaran yang menerapkan nilai-nilai dengan memberi 

keteladanan (ing ngarso sung tulodo), membangun kemauan (ing 

madyo mangun karso), dan mengembangkan kreativitas peserta 

didik dalam proses pembelajaran (tut wuri handayani);  

 Pembelajaran yang berlangsung di rumah, di sekolah, dan di 

masyarakat;  

 Pemanfaatan teknologi informasi dan komunikasi untuk 

meningkatkan efisiensi dan efektivitas pembelajaran; 

 Pengakuan atas perbedaan individual dan latar belakang budaya 

peserta didik; dan  

 Suasana belajar menyenangkan dan menantang.  

 

c. Langkah-langkah umum  pembelajaran  pendekatan saintifik 

 

Gambar 24. Langkah-Langkah Pendekatan Saintifik 

http://2.bp.blogspot.com/-ORDUxw3XG9c/Uee5EAo3kZI/AAAAAAAABqg/9Vzfk4kQsos/s1600/langkah-langkah+pendekatan+scientific.jpg
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Langkah-langkah pembelajaran dengan menggunakan pendekatan 

saintifik harus diperhatikan oleh guru. Pertama perlu diingat bahwa 

tidak semua materi harus dipaksakan menggunakan pendekatan 

saintifik secara lengkap. Semua disesuaikan dengan materi pelajaran 

yang akan diajarkan. Sebelum penerapan pembelajaran saintifik, 

alangkah baiknya guru menyiapkan anak didik secara psikis maupun 

fisik. Unsur persiapan memerankan hal yang penting untuk 

keberhasilan tujuan pembelajaran. Guru harus menjelaskan tujuan 

pembelajaran atau kompetensi dasar yang akan dicapai dan 

menyampaikan garis besar cakupan materi dan penjelasan tentang 

kegiatan yang akan dilakukan oleh anak didik. Ada lima langkah 

pengalaman belajar yang harus dilakukan siswa dalam pendekatan 

saintifik, yaitu : 

 Mengamati (observasi) 

Tahap pertama proses pembelajaran dengan menggunakan 

pendekatan saintifik yang dilakukan oleh peserta didik adalah 

mengamati. Pengamatan bisa melalui kegiatan melihat, 

menyimak, mendengar dan membaca. Guru memfasilitasi anak 

didik untuk melakukan pengamatan, melatih mereka untuk 

memperhatikan hal yang penting dari suatu objek. Lingkungan 

sekitar merupakan laboratorium nyata bagi anak didik. 

 Menanya 

Setelah perserta didik mengamati, guru memberikan kesempatan 

kepada peserta didik untuk bertanya. Tahap kedua adalah 

menanya perlu dipahami yang bertanya disini bukanlah guru 

melainkan peserta didik. Guru harus benar-benar membuka 

kesempatan kepada semua anak didik untuk bertanya. Dalam hal 

ini adalah melatih keaktifan peserta didik. Selain itu juga untuk 

menggetahui sejauh mana pengetahuan dan rasa ingin tahu dari 

peserta didik.  

Guru perlu membimbing peserta didik untuk dapat mengajukan 

pertanyaan: pertanyaan tentang  hasil pengamatan objek yang 

konkrit sampai kepada yang abstrak berkenaan dengan fakta, 

konsep, prosedur, atau pun hal lain yang lebih abstrak. Pertanyaan 
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yang bersifat faktual sampai kepada pertanyaan yang bersifat 

hipotetik.  

 Mengumpulkan Informasi 

Kegiatan “mengumpulkan informasi”  merupakan tindak lanjut dari 

bertanya. Kegiatan ini dilakukan  dengan menggali dan 

mengumpulkan informasi dari berbagai sumber melalui berbagai 

cara. Untuk itu peserta didik dapat membaca buku yang lebih 

banyak, memperhatikan fenomena atau objek yang lebih teliti, atau 

bahkan melakukan eksperimen. Dari kegiatan tersebut terkumpul 

sejumlah informasi. Dalam Permendikbud Nomor  81a Tahun 2013, 

aktivitas mengumpulkan informasi dilakukan  melalui eksperimen,  

membaca sumber lain selain buku teks,  mengamati objek/ 

kejadian/, aktivitas wawancara dengan nara sumber dan 

sebagainya. 

 Mengasosiasikan/ Mengolah Informasi/Menalar 

Kegiatan “mengasosiasi/ mengolah informasi/ menalar” dalam 

kegiatan pembelajaran sebagaimana disampaikan dalam 

Permendikbud Nomor  81a Tahun 2013, adalah memproses  

informasi yang sudah dikumpulkan baik terbatas dari hasil kegiatan 

mengumpulkan/eksperimen maupun hasil dari kegiatan 

mengamati dan kegiatan mengumpulkan informasi. Pengolahan 

informasi yang dikumpulkan dari yang bersifat menambah 

keluasan dan kedalaman sampai kepada pengolahan informasi 

yang bersifat mencari solusi dari berbagai sumber yang memiliki 

pendapat yang berbeda sampai kepada yang bertentangan. 

Kegiatan ini dilakukan untuk menemukan keterkaitan satu 

informasi dengan informasi lainya, menemukan pola dari 

keterkaitan  informasi tersebut. 

 Mengomunikasikan  

Pada pendekatan scientific guru diharapkan memberi kesempatan 

kepada peserta didik untuk mengomunikasikan apa yang telah 

mereka pelajari. Kegiatan ini dapat dilakukan melalui  menuliskan 

atau menceritakan apa yang ditemukan dalam kegiatan mencari 

informasi, mengasosiasikan dan menemukan pola. Hasil tersebut 
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disampikan di kelas dan dinilai oleh guru sebagai hasil belajar 

peserta didik atau kelompok peserta didik tersebut. Kegiatan 

“mengomunikasikan” dalam kegiatan pembelajaran sebagaimana 

disampaikan dalam Permendikbud Nomor  81a Tahun 2013, 

adalah menyampaikan hasil pengamatan, kesimpulan 

berdasarkan hasil analisis secara lisan, tertulis, atau media 

lainnya.   

 
d. Rancangan Penerapan Pendekatan Saintifik Dalam Pembelajaran. 

Kegiatan pembelajaran meliputi tiga kegiatan pokok, yaitu kegiatan 

pendahuluan, kegiatan inti, dan kegiatan penutup. 

Kegiatan Pendahuluan  

Pada kegiatan pendahuluan, disarankan guru menunjukkan fenomena 

atau kejadian “aneh” atau “ganjil” (discrepant event) yang dapat 

menggugah timbulnya pertanyaan pada diri siswa. 

Contoh kegiatan pendahuluan :   

Guru mengingatkan kembali tentang konsep-konsep yang telah 

dipelajari oleh siswa yang berhubungan dengan materi baru yang akan 

dibelajarkan. Sebagai contoh dalam mapel IPA, guru menanyakan 

konsep tentang larutan dan komponennya sebelum pembelajaran 

materi asam-basa.  

Kegiatan Inti  

Kegiatan inti dalam metode saintifik ditujukan untuk terkonstruksinya 

konsep, hukum atau prinsip oleh peserta didik dengan bantuan dari 

guru melalaui langkah-langkah kegiatan yang diberikan di muka. 

Contoh Kegiatan Inti: 

 Mengamati: 

Dalam mapel IPA, guru meminta siswa untuk mengamati suatu 

fenomenon. Sebagai contoh dalam mapel IPA guru meminta siswa 

untuk mengamati sifat larutan yang diperoleh dari ekstrak buah 

belimbing atau tomat. Fenomena yang diberikan dapat juga dalam 

bentuk video.  
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 Menanya: 

Dalam mapel IPA, siswa mengajukan pertanyaan tentang suatu 

fenomenon. Sebagai contoh siswa mempertanyakan “Mengapa 

larutan ekstrak buah belimbing atau tomat memiliki rasa manis dan 

asin”.  

 Menalar untuk mengajukan hipotesis: 

Sebagai contoh, dalam mapel IPA siswa mengajukan pendapat 

bahwa rasa manis dan masam pada larutan enkstrak buah 

belimbing atau tomat disebabkan oleh adanya zat yang memiliki 

rasa manis dan zat yang memiliki rasa asam. Pendapat siswa ini 

merupakan suatu hipotesis.  

 Mengumpulkan data: 

Dalam mapel IPA, siswa mengumpulkan data atau guru 

memberikan data tentang komponen-komponen yang terdapat 

dalam larutan ekstrak buah belimbing atau buah tomat. 

 Menganalisis data: 

Siswa menganalis data yang diberikan oleh guru. Analisis data 

dalam IPS,  misalnya siswa diajak untuk membaca buku siswa 

halaman 2-6 tentang konsep ruang, waktu, konektivitas, dan 

interaksi sosial. Konsep-konsep ini dihubungkan dengan informasi 

atau data  awal, pertanyaan dan hipotesis, serta data yang 

terkumpul. 

 Menarik kesimpulan 

Dalam mapel IPA, siswa menarik kesimpulan berdasar hasil 

analisis yang mereka lakukan. Sebagai contoh siswa 

menyimpulkan bahwa rasa manis pada larutan ekstrak buah 

belimbing atau buah tomat disebabkan oleh adanya gula, 

sedangkan rasa masam disebabkan oleh adanya asam. Contoh 

bentuk kesimpulan yang ditarik dalam IPS misalnya hujan di Bogor 

menyebabkan banjir di Jakarta menunjukkan adanya keterkaitan 

antarruang dan waktu. 
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 Mengomunikasikan:  

Pada langkah ini, siswa dapat menyampaikan hasil kerjanya 

secara lisan maupun tertulis, misalnya melalui presentasi 

kelompok, diskusi, dan tanya jawab. 

Kegiatan Penutup  

Kegiatan penutup ditujukan untuk dua hal pokok. Pertama, validasi 

terhadap konsep, hukum atau prinsip yang telah dikonstruk oleh siswa. 

Kedua, pengayaan materi pelajaran yang dikuasai siswa. 

Contoh Kegiatan Penutup: 

 Dalam mapel IPA maupun mapel lain, guru dapat meminta siswa 

untuk meningkatkan pemahamannya tentang konsep, prinsip atau 

teori yang telah dipelajari dari buku-buku pelajaran yang relevan 

atau sumber informasi lainnya. Contoh dalam mapel IPA di atas 

juga dapat digunakan dalam mapel IPS. 

 

2. Model Pembelajaran Penemuan 

a. Konsep Dasar 

Perancang pembelajaran penemuan (discovery learning) adalah 

Jerome  Bruner. Bruner berpendapat bahwa “Discovery Learning can 

be defined as the learning that takes place when the student is not 

presented with subject matter in the final form, but rather is required to 

organize it him self” (Lefancois dalam Emetembun, 1986:103).  

Dari pendapat tersebut dapat dikatakan bahwa pembelajaran 

penemuan (discovery learning)  adalah  proses pembelajaran yang 

terjadi bila pelajar tidak disajikan dengan pelajaran dalam bentuk 

finalnya, tetapi diharapkan mengorganisasi sendiri. 

Discovery dilakukan melalaui observasi, klasifikasi, pengukuran, 

prediksi, penentuan. Proses tersebut disebut cognitive process 

sedangkan discovery itu sendiri adalah the mental process of 

assimilatig conceps and principles in the mind (Robert B. Sund dalam 

Malik, 2001:219). 
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b. Langkah-langkah Operasional Implementasi dalam Proses 

Pembelajaran 

Menurut Syah (2004:244) dalam mengaplikasikan strategi discovery 

learning di kelas, ada beberapa prosedur yang harus dilaksanakan 

dalam kegiatan belajar mengajar secara umum sebagai berikut: 

1) Stimulation (stimulasi/pemberian rangsangan) 

Pertama-tama pada tahap ini pelajar dihadapkan pada sesuatu 

yang menimbulkan kebingungannya, kemudian dilanjutkan untuk 

tidak memberi generalisasi, agar timbul keinginan untuk menyelidiki 

sendiri. Disamping itu guru dapat memulai kegiatan PBM dengan 

mengajukan pertanyaan, anjuran membaca buku, dan aktivitas 

belajar lainnya yang mengarah pada persiapan pemecahan 

masalah. Stimulasi pada tahap ini berfungsi untuk menyediakan 

kondisi interaksi belajar yang dapat mengembangkan dan 

membantu peserta didik dalam mengeksplorasi bahan.  

2) Problem statement (pernyataan/ identifikasi masalah) 

Setelah dilakukan stimulation langkah selanjutya adalah guru 

memberi kesempatan kepada peserta didik untuk mengidentifikasi 

sebanyak mungkin agenda-agenda masalah yang relevan dengan 

bahan pelajaran, kemudian salah satunya dipilih dan dirumuskan 

dalam bentuk hipotesis (jawaban sementara atas pertanyaan 

masalah) (Syah 2004:244). Memberikan kesempatan peserta didik 

untuk mengidentifikasi dan menganalisa permasalahan yang 

mereka hadapi, merupakan teknik yang berguna dalam 

membangun peserta didik agar mereka terbiasa untuk menemukan 

suatu masalah.  

3) Data collection (pengumpulan data). 

Ketika eksplorasi berlangsung guru juga memberi kesempatan 

kepada para peserta didik untuk mengumpulkan informasi 

sebanyak-banyaknya yang relevan untuk membuktikan benar atau 

tidaknya hipotesis (Syah, 2004:244). Pada tahap ini berfungsi untuk 

menjawab pertanyaan atau membuktikan benar tidaknya  hipotesis, 

dengan demikian anak didik diberi kesempatan untuk 
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mengumpulkan (collection) berbagai informasi yang relevan, 

membaca literatur, mengamati objek, wawancara dengan nara 

sumber, melakukan uji coba sendiri dan sebagainya. Konsekuensi 

dari tahap ini adalah peserta didik belajar secara aktif untuk 

menemukan sesuatu yang berhubungan dengan permasalahan 

yang dihadapi, dengan demikian secara tidak disengaja peserta 

didik menghubungkan masalah dengan pengetahuan yang telah 

dimiliki. 

4) Data processing (pengolahan data) 

Menurut Syah (2004:244) pengolahan data merupakan kegiatan 

mengolah data dan informasi yang telah diperoleh para peserta 

didik baik melalui wawancara, observasi, dan sebagainya, lalu 

ditafsirkan, dan semuanya diolah, diacak, diklasifikasikan, 

ditabulasi, bahkan bila perlu dihitung dengan cara tertentu serta 

ditafsirkan pada tingkat kepercayaan tertentu (Djamarah, 2002:22). 

Data processing disebut juga dengan pengkodean 

coding/kategorisasi yang berfungsi sebagai pembentukan konsep 

dan generalisasi. Dari generalisasi tersebut peserta didik akan 

mendapatkan pengetahuan baru tentang alternatif jawaban/ 

penyelesaian yang perlu mendapat pembuktian secara logis 

5) Verification (pembuktian) 

Pada tahap ini peserta didik melakukan pemeriksaan secara cermat 

untuk membuktikan benar atau tidaknya hipotesis yang ditetapkan 

tadi dengan temuan alternatif, dihubungkan dengan hasil data 

processing (Syah, 2004:244). Berdasarkan hasil pengolahan dan 

tafsiran, atau informasi yang ada, pernyataan atau hipotesis yang 

telah dirumuskan terdahulu itu kemudian dicek, apakah terjawab 

atau tidak, apakah terbukti atau tidak. 

6) Generalization (menarik kesimpulan/generalisasi) 

Tahap generalisasi/menarik kesimpulan adalah proses menarik 

sebuah kesimpulan yang dapat dijadikan prinsip umum dan berlaku 

untuk semua kejadian atau masalah yang sama, dengan 

memperhatikan hasil verifikasi (Syah, 2004:244). Berdasarkan hasil 

verifikasi maka  dirumuskan prinsip-prinsip yang mendasari 
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generalisasi. Setelah menarik kesimpulan  peserta didik harus 

memperhatikan proses generalisasi yang menekankan pentingnya 

penguasaan pelajaran  atas makna dan kaidah atau prinsip-prinsip 

yang luas yang mendasari pengalaman seseorang, serta 

pentingnya proses pengaturan dan generalisasi dari pengalaman-

pengalaman itu. 

 

3. Pembelajaran Berbasis Proyek 

a. Pengertian  

Pembelajaran berbasis proyek (PBP) merupakan strategi 

pembelajaran yang menggunakan proyek/kegiatan sebagai sarana 

pembelajaran untuk mencapai kompetensi sikap, pengetahuan dan 

keterampilan. Penekanan pembelajaran terletak pada aktivitas peserta 

didik untuk memecahkan masalah dengan menerapkan keterampilan 

meneliti, menganalisis, membuat, sampai dengan mempresentasikan 

produk pembelajaran berdasarkan pengalaman nyata. Strategi  ini 

memperkenankan pesera didik untuk bekerja secara mandiri maupun 

berkelompok dalam mengkostruksikan produk otentik yang bersumber 

dari masalah nyata dalam kehidupan sehari-hari..  

b. Prinsip-prinsip pembelajaran berbasis proyek (PBP)  

Sebagaimana telah diurakan di atas bahwa sarana pembelajaran 

untuk mencapai kompetensi dalam PBP menggunakan tugas proyek 

sebagai strategi pembelajaran. Para peserta didik bekerja secara 

nyata, memecahkan persoalan di dunia nyata yang dapat 

menghasilkan solusi berupa produk atau hasil karya secara nyata atau 

realistis. Prinsip yang mendasari pembelajaran berbasis proyek 

adalah:  

1) Pembelajaran berpusat pada peserta didik yang melibatkan tugas-

tugas pada kehidupan nyata untuk memperkaya pembelajaran. 

2) Tugas proyek menekankan pada kegiatan penelitian berdasarkan 

suatu tema atau topik yang telah ditentukan dalam pembelajaran.  

3) Penyelidikan atau eksperimen dilakukan secara otentik dan 

menghasilkan produk nyata yang telah dianalisis dan 

dikembangkan berdasarkan tema/topik yang disusun dalam 
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bentuk produk (laporan atau hasil karya). Produk, laporan atau 

hasil karya tersebut selanjutnya dikomunikasikan untuk mendapat 

tanggapan dan umpan balik untuk perbaikan proyek berikutnya. 

c. Langkah-langkah pembelajaran berbasis proyek 

Dalam PBP, peserta didik diberikan tugas dengan mengembangkan 

tema/topik dalam pembelajaran dengan melakukan kegiatan proyek 

yang  realistik.  Di samping itu, penerapan pembelajaran berbasis 

proyek ini mendorong tumbuhnya kreativitas, kemandirian, tanggung 

jawab, kepercayaan diri, serta  berpikir kritis dan analitis pada peserta 

didik.  

Secara umum, langkah-langkah Pembelajaran berbasis proyek (PBP) 

dapat dijelaskan sebagai berikut. 

 

 

 

 

 

 

 

Diadaptasi dari Keser & Karagoca (2010) 

Gambar 25. Langkah-Langkah Pembelajaran Berbasis Proyek 

 

4. Model Pembelajaran Berbasis Masalah 

a. Pengertian  

Pembelajaran berbasis masalah adalah suatu kegiatan pembelajaran 

yang berpusat pada masalah. Istilah berpusat berarti menjadi tema, 

unit, atau isi sebagai focus utama belajar (Mustaji, dalam  h.35). 

Menurut Resnick dan Gleser dalam Gredler (1991), masalah dapat 

diartikan sebagai suatu keadaan dimana seseorang melakukan 

tugasnya yang tidak diketahui sebelumnya. Masalah pada umumnya 
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timbul karena adanya kesenjangan antara kondisi nyata dengan 

kondisi yang seharusnya. 

Sebagai model  pembelajaran, pembelajaran berbasis masalah dapat 

diartikan sebagai suatu kegiatan pembelajaran yang  menggunakan 

masalah sebagai langkah awal dalam mengumpulkan dan 

mengintegrasikan pengetahuan baru. 

 
b. Prinsip Dasar 

Adapun prinsip-prinsip yang mendasari penggunaan model 

pembelajaran berbasis masalah antara lain : 

1) Pembelajaran berangkat dari adanya masalah (soal, pertanyaan, 

dsb) yang perlu diselesaikan.  

2) Masalah yang dihadapi akan merangsang siswa untuk mencari 

solusinya; siswa mencari/membentuk pengetahuan baru untuk 

menyelesaikan masalah. 

 

c. Langkah-langkah  

Pembelajaran Berbasis Masalah diawali dengan aktivitas,  proses 

tersebut dilakukan dalam tahapan-tahapan atau sintaks pembelajaran 

yang disajikan pada Tabel  berikut. 

Tahap Aktivitas Guru dan Peserta didik 

Tahap 1 

Mengorientasikan peserta 

didik terhadap masalah 

Guru menjelaskan tujuan pembelajaran dan 

sarana atau logistik yang dibutuhkan. Guru 

memotivasi peserta didik untuk terlibat dalam 

aktivitas pemecahan masalah nyata yang 

dipilih atau ditentukan 

Tahap 2 

Mengorganisasi peserta 

didik untuk belajar 

Guru membantu peserta didik mendefinisikan 

dan mengorganisasi tugas belajar yang 

berhubungan dengan masalah yang sudah 

diorientasikan pada tahap sebelumnya. 
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Tahap Aktivitas Guru dan Peserta didik 

Tahap 3 

Membimbing penyelidikan 

individual maupun 

kelompok 

Guru mendorong peserta didik untuk 

mengumpulkan informasi yang sesuai dan 

melaksanakan eksperimen untuk 

mendapatkan kejelasan yang diperlukan 

untuk menyelesaikan masalah. 

Tahap 4 

Mengembangkan dan 

menyajikan hasil karya 

Guru membantu peserta didik untuk berbagi 

tugas dan merencanakan atau menyiapkan 

karya yang sesuai sebagai hasil pemecahan 

masalah dalam bentuk laporan, video, atau 

model. 

Tahap 5 

Menganalisis dan 

mengevaluasi proses 

pemecahan masalah 

Guru membantu peserta didik untuk 

melakukan refleksi atau evaluasi terhadap 

proses pemecahan masalah yang dilakukan  

  

D. Aktivitas Pembelajaran 

 

Petunjuk! 

a. Buat kelompok yang terdiri dari 3 – 5 orang  

b. Anda diminta untuk mengkaji konsep dasar pendekatan saintifik, model 

pembelajaran penemuan, proyek, dan pembelajaran berbasis masalah.  

c. Diskusikan penerapan prinsip-prinsip tersebut dalam proses belajar 

mengajar. 

d. Hasil diskusi ditulis pada lembar kerja 3 (LK 3) kemudian dipresentasikan 

di depan kelas. 

Aktivitas  Belajar 1 
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Petunjuk! 

a. Secara berkelompok, diskusikan  permasalahan yang paling penting untuk 

segera ditemukan solusinya dalam menerapkan pendekatan saintifik, 

model pembelajaran penemuan,proyek, berbasis masalah 

b. Hasil diskusi kelompok ditulis pada LK 4. 

 

 

Petunjuk! 

a. Buat kelompok yang terdiri dari 3 – 5 orang  

b. Anda diminta untuk melaksanakan pembelajaran sesuai dengan 

pendekatan/model yang dipilih  (saintifik, model pembelajaran penemuan, 

Proyek, dan berbasis masalah) 

c. Laporkan hasil pelaksanaan pembelajaran  yang dituangkan dalam LK 5.  

 

E. Latihan/Kasus/Tugas 

Pilihlah jawaban yang paling tepat dengan memberi tanda silang (X) pada 

salah satu huruf: a, b, c, atau d  yang mewakili jawaban yang paling tepat pada 

lembar jawaban yang telah disediakan. 

 

1. Pembelajaran yang menekankan pada pendekatan keilmuan, dan 

berdasarkan data  fakta serta kajian empirik, merupakan pembelajaran 

yang  menerapkan .... 

a. Pendekatan Saintifik 

b. Strategi Discovery Learning 

c. Strategi Project Based Learning 

d. Strategi Problem Based Learning 

 

Aktivitas  Belajar 2 

Aktivitas  Belajar 3 
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2. Pembelajaran yang  menekankan pada pemecahan masalah yang tidak 

terstruktur (ill-structured) dan bersifat terbuka dalam menyelesaikan 

masalah untuk meningkatkan berpikir kritis, merupakan strategi 

pembelajaran .... 

a. Saintifik 

b. Problem Based Learning 

c. Project Based Learning 

d. Discovery Learning 

 
3. Pada saat guru bertanya, pada saat itu pula dia membimbing atau 

memandu peserta didiknya belajar dengan baik. Ketika guru menjawab 

pertanyaan peserta didiknya, ketika itu pula dia mendorong asuhannya itu 

untuk menjadi penyimak dan pembelajar yang baik. 

     Pernyataan tersebut merupakan salah satu kegiatan pendekatan saintifik,  

yaitu pada langkah .... 

a. mengamati 

b. menanya  

c. mengasosiasi   

d. mengumpulkan informasi 

 
4. Peserta didik mempraktekkan  gerakan  bayang-bayang tubuh manusia 

pada saat kena sinar matahari.  Kegiatan tersebut merupakan salah satu 

langkah dalam penerapan pendekatan saintifik .... 

a. mengamati  

b. mengasosiasi  

c. mengkomunikasikan  

d. mengumpulkan informasi 

 
5. Proses menarik sebuah kesimpulan yang dapat dijadikan prinsip umum 

dan berlaku untuk semua kejadian atau masalah yang sama, dengan 

memperhatikan hasil verifikasi, merupakan .... 

a. Spesifikasi 

b. Generalisasi 

c. Optimalisasi 

d. Standarisasi 
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6. Keuntungan Pembelajaran Berbasis Proyek  adalah .... 

a. Ada kemungkinan peserta didik yang kurang aktif dalam kerja 

kelompok 

b. Peserta didik yang memiliki kelemahan dalam percobaan dan 

pengumpulan informasi akan mengalami kesulitan 

c. Ketika topik yang diberikan kepada masing-masing kelompok berbeda, 

dikhawatirkan peserta didik tidak bisa memahami topik secara 

keseluruhan 

d. Meningkatkan motivasi belajar peserta didik untuk belajar, mendorong 

kemampuan mereka untuk melakukan pekerjaan penting, dan mereka 

perlu untuk dihargai 

 
7. Pembelajaran Berbasis Masalah (PBM) sangat diperlukan dalam 

pembelajaran dewasa ini karena …. 

a. PBM berbeda dengan pembelajaran konvensional yang menjadikan 

masalah nyata sebagai penerapan konsep-konsep ilmiah 

b. peserta didik perlu mendapatkan konsep-konsep faktual dalam 

menyelesaikan masalah sehingga dapat menemukan  strategi 

pemecahan masalah baru 

c. PBM menjadikan masalah nyata sebagai pemicu bagi proses belajar 

siswa untuk mengidentifikasi informasi dan strategi yang relevan 

menyelesaikan masalah  

d. peserta didik dapat memperoleh atau membangun pengetahuan 

tertentu dan sekaligus mengembangkan kemampuan berpikir kritis 

dan keterampilan menyelesaikan masalah  
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F. Rangkuman 

 Pembelajaran dengan penerapan pendekatan saintifik adalah proses 

pembelajaran yang dirancang sedemikian rupa agar  peserta didik secara 

aktif mengonstruk konsep, hukum atau prinsip melalui tahapan-tahapan 

mengamati (untuk mengidentifikasi atau menemukan masalah), 

merumuskan masalah, mengajukan atau merumuskan hipotesis, 

mengumpulkan data dengan berbagai teknik, menganalisis data, menarik 

kesimpulan dan mengomunikasikan konsep, hukum atau prinsip yang 

ditemukan. 

 Kegiatan pembelajaran meliputi tiga kegiatan pokok, yaitu kegiatan 

pendahuluan, kegiatan inti, dan kegiatan penutup. Kegiatan pendahuluan 

bertujuan untuk menciptakan suasana awal pembelajaran yang efektif 

yang memungkinkan siswa dapat mengikuti proses pembelajaran dengan 

baik. Kegiatan inti merupakan kegiatan utama dalam proses pembelajaran 

atau dalam proses penguasaan pengalaman belajar (learning experience) 

siswa. Kegiatan penutup ditujukan untuk dua hal pokok. Pertama, validasi 

terhadap konsep, hukum atau prinsip yang telah dikonstruk oleh siswa. 

Kedua, pengayaan materi pelajaran yang dikuasai siswa 

 Discovery terjadi bila individu terlibat, terutama dalam penggunaan proses 

mentalnya untuk menemukan beberapa konsep atau prinsip yang 

sebelumnya tidak diketahui. Discovery dilakukan melalui observasi, 

klasifikasi, pengukuran, prediksi, penentuan dan inferi. 

 Pembelajaran berbasis proyek merupakan salah satu strategi 

pembelajaran yang berpusat pada siswa. Dalam pembelajaran berbasis 

proyek, peserta didik diberi kesempatan yang seluas-luasnya mengelola 

proses pembelajarannya mulai dari mengidentifikasi masalah, pemecahan 

masalah, pengambilan keputusan, sampai kepada menghasilkan produk 

atau hasil karya lain untuk memecahkan masalah yang dihadapi. 

 Pembelajaran berbasis masalah (PBM) adalah suatu strategi 

pembelajaran yang menggunakan masalah dunia nyata sebagai suatu 

konteks bagi Peserta didik untuk belajar tentang cara berfikir kritis dan 

ketrampilan pemecahan masalah, serta untuk memperoleh pengetahuan 

dan konsep yang esensial dari materi pelajaran. 
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G. Umpan Balik dan Tindak Lanjut 

Mohon untuk mengisi lembar umpan balik dan tindak lanjut  di bawah ini 

berdasarkan materi pelatihan yang Anda  sudah pelajari.  

1. Hal-hal apa saja yang sudah saya pahami terkait dengan materi pelatihan 

ini ? 

.................................................................................................................... 

.................................................................................................................... 

.................................................................................................................... 

.................................................................................................................... 

2. Apa saja yang telah saya lakukan yang ada hubungannya dengan materi 

kegiatan ini tetapi belum ditulis pada materi pelatihan ini? 

.................................................................................................................... 

.................................................................................................................... 

.................................................................................................................... 

.................................................................................................................... 

3. Manfaat apa saja yang saya peroleh dari materi pelatihan ini untuk 

menunjang keberhasilan tugas pokok dan fungsi sebagai guru SMK? 

.................................................................................................................... 

.................................................................................................................... 

.................................................................................................................... 

.................................................................................................................... 

4. Langkah-langkah apa saja yang perlu ditempuh untuk menerapkan materi 

pelatihan ini dalam rangka meningkatkan mutu pembelajaran pada mata 

pelajaran yang saya ampu? 

.................................................................................................................... 

.................................................................................................................... 

.................................................................................................................... 

.................................................................................................................... 
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Kunci Jawaban Latihan/Kasus/Tugas 

 

Kegiatan Pembelajaran 1 

Peran guru di kelas semestinya serupa dengan orang dewasa yang ada dalam 

gambar. Peran mereka harus berubah dari aktif ke lebih pasif. Di awal pelajaran, 

guru harus menjelaskan dan mencontohkan keterampilan yang akan dipelajari 

oleh para siswa. Mereka memberikan pengetahuan mengenai keterampilan 

tersebut dan bagaimana menerapkannya. Seiring berlanjutnya pelajaran, guru 

memberikan kesempatan kepada siswa untuk aktif dalam melatih keterampilannya 

sendiri. Guru mengawasi para siswa bekerja dan memberikan feedback. Guru 

perlu menerima bahwa berbuat kesalahan adalah hal yang lumrah dan merupakan 

bagian penting dari proses belajar. Peran siswa dalam kelas seharusnya sama 

dengan anak yang ada dalam gambar yang sedang belajar mengendarai sepeda. 

Mulanya, siswa cenderung pasif. Mereka mendengarkan dan mengamati guru. 

Ketika pelajaran berlanjut, siswa lah yang seharusnya menjadi aktif. Mereka 

mengambil kesempatan untuk berlatih dan menerapkan pengetahuan yang 

mereka terima di awal pelajaran.  

 

Kegiatan Pembelajaran 2 

Kunci Pilihan Ganda 

 

No 1 2 3 4 5 6 7 

Jawaban A D C C B D D 
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Evaluasi 

 

 

1. Mengapa penting bagi guru untuk memahami apa dan bagaimana belajar 

itu berlangsung ?  

2. Jelaskan perbedaan yang mendasar dari ketiga (3) teori belajar 

(Behaviorisme, Kognitivisme, Kontruktivisme). 

3. Jelaskan 3 prinsip belajar yang bersifat umum serta impilkasinya bagi 

tindakan guru dalam mengajar?  

4. Apa esensi pendekatan saintifik dalam pembelajaran? 

5. Apakah yang dimaksud soft skill dan hard skill/ 

6. Jelaskan lima (5) langkah kegiatan yang harus dialami siswa ketika guru 

menerapkan pendekatan saintifik? 

7. Apakah karakteristik model pembelajaran penemuan? 

8. Jelaskan 6 langkah prosedur aplikasi pendekatan pembelajaran 

penemuan? 

9. Apa yang menjadi penekanan pembelajaran dengan menggunakan 

pembelajaran berbasis proyek? 

10. Jelaskan enam (6) langkah pembelajaran berbasis proyek? 

11. Jelaska dua (2) prinsip dasar penerapan pembelajaran berbasisi masalah? 

12. Jelaskan lima(5) tahapan penerapan pembelajaran berbasis masalah? 
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Penutup 

 

odul Teori belajar dan Penerapan Pendekatan Pembelajaran  

membahas kompetensi inti pedagogik kedua, yaitu membahas 

berbagai teori belajar dan prinsip-prinsip pembelajaran, 

pendekatan pembelajaran saintifik, berbagai model pembelajaran yaitu ; 

model pembelajaran penemuan, model pembelajaran berbasis proyek, model 

pembelajaran berbasis masalah. Materi-materi tersebut dijelaskan lebih rinci 

dalam lima (5) kegiatan belajar. 

Teori belajar dan prinsip-prinsip pembelajaran perlu dipahami oleh setiap guru 

mengingat mengajar tidak akan terlepas dari orang yang belajar. Hasil belajar 

siswa akan meningkat  apabila guru memahami prinsip-prinsip belajar dan 

menerapkan implikasi dari prinsip-prinsip tersebut pada proses belajar 

mengajar. 

Pendekatan saintifik merupakan kerangka ilmiah pembelajaran yang diusung 

oleh Kurikulum 2013. Langkah-langkah pada pendekatan saintifik merupakan 

bentuk adaptasi dari langkah-langkah ilmiah pada sains. Langkah-langkah 

pembelajaran saintifik adalah mengamati, menanya, mengumpulkan 

informasi, mengolah informasi, dan mengomunikasikan. Langkah-langkah 

pembelajaran berpendekatan saintifik harus dapat dipadukan secara sinkron 

dengan langkah-langkah kerja (syntax) model pembelajaran.  

Semoga modul ini bermanfaat bagi guru, terutama untuk meningkatkan 

kompetensi pedagogik di dalam  melaksanakan pembelajaran yang mendidik. 

 

M 
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Glosarium 

Teori Belajar 

Teori pada dasarnya merupakan konseptualisasi atau 

penjelasan logis dan empiris tentang suatu fenomena. 

Teori belajar pada dasarnya merupakan 

konseptualisasi atau penjelasan logis tentang 

fenomena peristiwa belajar dalam kehidupan manusia. 

Pembelajaran 

Pembelajaran adalah proses interaksi peserta didik 

dengan pendidik dan sumber belajar pada suatu 

lingkungan belajar. 

Pendekatan 

Pembelajaran   

Pendekatan Pembelajaran  merupakan titik tolak atau 

sudut pandang kita terhadap proses pembelajaran, 

yang merujuk pada pandangan tentang terjadinya suatu 

proses yang sifatnya masih sangat umum. Dilihat dari 

pendekatan, terdapat dua jenis pendekatan, yaitu: (1) 

pendekatan pembelajaran yang berorientasi atau 

berpusat pada peserta didik (student centered 

approach) dan (2) pendekatan pembelajaran yang 

berorientasi atau berpusat pada pendidik (teacher 

centered approach). 

Strategi 

Pembelajaran   

Strategi  Pembelajaran  merupakan kegiatan terencana 

dengan mempertimbangkan dan memanfaatkan 

berbagai sumber daya (termasuk kondisi peserta didik, 

waktu, media dan sumber belajar lainnya) untuk 

mencapai tujuan pembelajaran yang telah ditetapkan 

sebelumnya. Prinsip umum pemilihan dan penggunaan 

strategi pembelajaran adalah bahwa tidak semua 

strategil pembelajaran cocok digunakan untuk 

mencapai semua tujuan dan semua keadaan.  

Ada empat prinsip utama penggunaan strategi 

pembelajaran, yakni; (1) berorientasi pada tujuan, (2) 

aktivitas, (3) individualitas, dan (4) integritas. 
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Metode pembelajaran 

Metode pembelajaran ialah cara yang dipergunakan 

guru dalam mengadakan hubungan dengan siswa 

pada saat berlangsungnya pengajaran”. 

Teknik pembelajaran 

Teknik pembelajaran dapat diatikan sebagai cara yang 

dilakukan seseorang dalam mengimplementasikan 

suatu metode secara spesifik. Misalkan, penggunaan 

metode ceramah pada kelas dengan jumlah peserta 

didik yang relatif banyak membutuhkan teknik 

tersendiri, yang tentunya secara teknis akan berbeda 

dengan penggunaan metode ceramah pada kelas 

yang jumlah peserta didiknya terbatas. 

 

Model Pembelajaran 

model pembelajaran pada dasarnya merupakan 

bentuk pembelajaran yang tergambar dari awal 

sampai akhir yang disajikan secara khas oleh guru. 

Dengan kata lain, model pembelajaran merupakan 

bungkus atau bingkai dari penerapan suatu 

pendekatan, metode, dan teknik pembelajaran. 
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Lampiran- Lampiran 

Lembar Kerja 1 

Petunjuk! 

a. Buat kelompok yang terdiri dari 3 – 5 orang. 

b. Anda diminta untuk mendiskusikan 3 teori belajar 

c. Hasil diskusi kelompok dituliskan pada lembar kerja (LK.1) dan dipaparkan 

di depan kelas. 

 

No Teori Deskripsi 

1. Behaviorisme ………………………………………………….. 

………………………………………………….. 

………………………………………………….. 

2. Kognitivisme ………………………………………………….. 

………………………………………………….. 

………………………………………………….. 

3. Konstruktivisme ………………………………………………….. 

………………………………………………….. 

………………………………………………….. 
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Lembar Kerja 2 

Petunjuk! 

a. Buat kelompok yang terdiri dari 3 – 5 orang  

b. Anda diminta untuk mengkaji prinsip-prinsip belajar dan bagaimana 

implikasinya terhadap peran yang harus dilakukan guru 

c. Hasil kajian ditulis pada LK 2 kemudian presentasikan/paparkan hasil 

diskusi di depan kelas! 

 

No Prinsip Belajar Peran Guru 

1. Perhatian & Motivasi ………………………………………………….. 

………………………………………………….. 

………………………………………………….. 

2. Keaktifan ………………………………………………….. 

………………………………………………….. 

………………………………………………….. 

3. Keterlibatan 

langsung 

………………………………………………….. 

………………………………………………….. 

………………………………………………….. 

4. Pengulangan ………………………………………………….. 

………………………………………………….. 

………………………………………………….. 

5. Perbedaan individu ………………………………………………….. 

………………………………………………….. 

………………………………………………….. 
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Lembar Kerja 3 

Petunjuk! 

a. Buat kelompok yang terdiri dari 3 – 5 orang  

b. Anda diminta untuk mengkaji konsep dasar pendekatan saintifik, 

model pembelajaran penemuan, proyek, dan pembelajaran berbasis 

masalah.  

c. Diskusikan penerapan prinsip-prinsip tersebut dalam proses belajar 

mengajar. 

d. Hasil diskusi ditulis pada lembar jawaban 3 (LK 3) kemudian 

dipresentasikan di depan kelas. 

 

No 
Pendekatan/Model 

Pembelajaran 
Deskripsi 

1. Saintifik ………………………………………………….. 

………………………………………………….. 

………………………………………………….. 

2. Penemuan ………………………………………………….. 

………………………………………………….. 

………………………………………………….. 

3. Proyek ………………………………………………….. 

………………………………………………….. 

………………………………………………….. 

4. Berbasis Masalah ………………………………………………….. 

………………………………………………….. 

………………………………………………….. 
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Lembar Kerja 4 

Permasalahan Penerapan Pendekatan/Model Pembelajaran 

 Petunjuk 

1. Secara berkelompok, tulislah contoh keberhasilan Saudara dalam menerapkan 

pendekatan saintifik, model pembelajaran penemuan,proyek, berbasis 

masalah. 

 

 

2. Secara berkelompok, tulislah contoh kesulitan yang dialami  Saudara dalam 

menerapkan pendekatan saintifik, model pembelajaran penemuan,proyek, 

berbasis masalah. 
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3. Secara berkelompok, pilihlah permasalahan yang paling penting untuk segera 

ditemukan solusinya dalam menerapkan pendekatan saintifik, model 

pembelajaran penemuan,proyek, berbasis masalah 

 

NO. PERMASALAHAN 

 

SOLUSI HASIL DISKUSI 
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Lembar Kerja 5 

Petunjuk! 

a. Buat kelompok yang terdiri dari 3 – 5 orang  

b. Anda diminta untuk melaksanakan pembelajaran sesuai dengan 

pendekatan/model yang dipilih  (saintifik, model pembelajaran penemuan, 

Proyek, dan berbasis masalah) 

c. Laporkan hasil pelaksanaan pembelajaran  yang dituangkan dalam LK 5.  

No Model Pembelajaran 

 

Hasil Pembelajaran 

 

  

 

 

 

 

 

 

 

 

 

 

 

 





 

 

 


